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Chapter 1
Introduction

The CodeWarrior Tracing and Analysis tool set to develop software for Freescale
StarCore DSP processors.

This chapter explains:

» Release Notes
* About this Guide
* Accompanying Documentation

1.1 Release Notes

Release notes include information about new features, last-minute changes, bug fixes,
incompatible elements, or other sections that may not be included in this manual.

You should read release notes before using the CodeWarrior IDE.

NOTE

The release notes for specific components of the CodeWarrior
IDE are located in the release wotes folder in the CodeWarrior
installation directory.

1.2 About this Guide

Each chapter of this manual describes a different area of software development.
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Accumpanying Documentation
The table below lists each chapter in the manual.

Table 1-1. Chapters in this Guide

Chapter Description

Introduction (this chapter)

Getting Started Describes the analysis tool and the trace and profiling data

Collecting Data Describes how to collect the data from simulator SC3900 and
Qonverge targets

Setting Tracepoints Describes how to collect selective data after setting the
tracepoints

Setting Counterpoints Describes how to count events between two points of the
executed code

Performance Analysis for B4 Devices Describes how to configure, collect, and analyze scenarios in
the B4 devices.

Launching Scripts Describes how to collect and export trace data automatically

using remote launch.

Remote Launch API Lists the classes and interface for the remote launch API.

1.3 Accompanying Documentation

The Documentation Roadmap page describes the documentation included in this version
of CodeWarrior Development Studio for StarCore DSP Architectures.

You access Documentation Roadmap by:

* a shortcut link on the Desktop that the installer creates by default, or
» opening START_HERE.html in CWInstallDir\SC\Help.
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Chapter 2
Getting Started

CodeWarrior Tracing and Analysis Tools provide visibility into an application as it runs
on the simulator SC3900 and the Qonverge targets. This visibility can help you
understand how your application runs, as well as identify operational problems.

Tracing and analysis results are accurate for O0 optimization level. For an optimization
level higher than OO0, the results that are provided by this tool can be affected. The
affected results depends on the type of code and its optimization, whereas the results that
are based on asm code, analysis are not affected by optimization level. The results based
on source code and name of symbols can be affected by optimization level. For an
accurate analysis of the libraries linked to your project, make sure to generate debugging
information for them so that all the debug symbols are found and included in the
statistics.

However, it is possible to obtain limited accuracy only for profiling trace(Trace,
Timeline, Performance and Call Tree results) on O3 optimization level independent of
the type of code. The limited accuracy is defined due to the following reasons, when:
 There is no debug information generated for inlined functions
e The compiler has tail call optimization enabled by default, which means that a jsr is
transformed into a jmp (bsr vs. bra). It is possible to disable this optimization using
the compiler option -x11t --tailjsr2jmp=0

This chapter explains:

e About CodeWarrior Interface
¢ About Data Collection

2.1 About CodeWarrior Interface
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The CodeWarrior Development Studio provides a common interface for developing,
debugging, and analyzing your applications. The project-oriented Workbench window
provides numerous perspectives containing views, editors, and controls that appear in
menus and tool bars.

After creating a project, build your application, define a launch configuration, and then
wait for data collection and data display.

¥ Debug - Trace Data for Test_Simulator_Debug_SC3800_Download_cored0 - CodeWarrior Development Studio ol ===
File Edit Mavigate Search Project Run Window Help
it B BRI Fr - B0 P - - F=IR - [ [355 Debug | B@ C/C+
= Test Simulator_Debug SC3900_Download_cored0 2 =08
& &
15 | & Trace - Test_Simulator_Debug_SC3900_Download_core00 - Test_Simulator “ oA r om {2 AE | w
8,
Legend: o
E [§]
Call/Branch 4| | stalls 4| BTB Events ~
&y | Index| Event S... Description Type Timesta... e
Source Target |Chof Stalls | Interloc... | Memory ...| Program... | Rewind ... | BTBable... | COF Taken
0 SCPACC Function main, address = 0x800025¢0. main Linear 12 0 0 0 0 0 0 0 B
1 SCPACC Function main, address = 0x800025¢4. main Linear 13 0 0 0 0 0 0 0
2 SCPACC Function main, address = 0x800025¢8. main Linear 14 [} 0 [} 0 0 [} 0 =
3 SCPACC Function main, address = 0x200025f0. main Linear 15 0 0 0 0 0 0 0 =
4 SCPACC Function main, address = 0x200025f4. main Linear 16 [} 0 [} 0 0 [} 0 =3
5 SCPACC Function main, address = 0x800025fc. main Linear 17 0 0 0 0 0 0 0
Branch frem main to func2. Scurce address =
6 SCPACC ) 20002600, Target address < (-30002000, main func2 Branch B 4 0 0 0 0 1 1
7 SCPACC Function func2, address = 0x20002000. func2 Linear 24 1 0 0 0 0 0 0
8 SCPACC Function func2, address = 0x80002004. func2 Linear 5 0 0 0 0 0 0 0
Branch frem func2 to printf. Source address =
9 SCPACC 1 2000200, Torget adiress - O:B0004HE0. func2 printf Branch 31 4 0 0 0 0 1 1
10 SCPACC Function printf, address = 0x3000df80. printf Linear 32 1 0 0 0 0 0 0
SCPACC Function printf, address = 0x8000cif8e. printf Linear EE] 0 0 0 0 0 0 0
Branch frem printf te fwide. Source address =
12 SCPACC 20008, Target address = (x800De5e. printf fwide Branch 39 4 0 0 0 0 1 1
13 SCPACC Function fwide, address = 0x8000e6e0. fwide Linear 40 1 0 0 0 0 0 0
Branch frem fwide te fwide. Source address =
14 SCPACC | o 00e6e8, Target address = (-B000e734, fwide fwide Branch a1 0 0 0 0 0 0 0
15 SCPACC Function fwide, address = 08000 ee. fwide Linear 45 0 2 0 0 0 1 0
| i ] 3
] Console | ¥ Tasks | 3 Memery | #8 Remote Systems | & Target Tasks | [l Problems {3 Executables | @' Software Analysis 2 =0
Software Analysis ENENE
Name Trace Timeline Critical Code Performance  Call Tree Config Results ~ Ceunter Peints Last Medified
= multicore_trace
= SIM
) Test Simulat = Trace &+ Timeline Critical Code £33 Performan: #5 Call Tree 3 Configure B Counterpoints  2014.11.20 12:19:29 PM
o+ FEER]

Figure 2-1. Workbench Window

The perspective is a collection of views within the Workbench window used by the
Tracing and Analysis tools.

Standard perspective views:

* CodeWarrior Projects view provides a hierarchical view of the project resources in
the Workbench. Right-click context menus provide file-management controls.

* Console view shows the process output including actions, messages, and errors. It
display messages indicating when data collection is enabled, in process, and
complete.

» Software Analysis view provides a hierarchical view of the project's data sources,
data files, and data sets of the simulator.
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2.2 About Data Collection

This section lists the types of data collected for an application when it runs on the
simulator SC3900 and Qonverge targets.

You can collect the following types of data for an application:

e Trace Data

e Timeline Data

e Critical Code Data
e Performance Data
e Call Tree Data
 Counterpoints

2.2.1 Trace Data

The Trace viewer displays the trace data collected by the simulator and the targets. The
features available for the Trace viewer include:

» Export trace data to an Excel file

* Configure Timestamp column of the trace data as absolute or delta values in decimal
or hexadecimal format

» Set CPU frequency and convert the clock cycles into real time in milliseconds,
microseconds, or nanoseconds, displayed in the Timestamp column

» Copy and paste a cell or a line of the trace data

* Auto resize the column width or a row

* Quick navigation through trace using navigation buttons

e Expand the trace lines for more detailed information on the events

» Search capability

2.2.2 Timeline Data

The timeline data displays a graphical view of the functions that are executed in the
application and the number of cycles each function takes when the application is run.

CodeWarrior Development Studio for StarCore SC3900FP DSP Architectures Tracing and Analysis Tools
User Guide, Rev. 10.9.0, 11/2015

Freescale Semiconductor, Inc. 17




Awnout Data Collection

2.2.3 Critical Code Data

The critical code data is generated based on the trace data. The Critical Code Data viewer
displays name, start address, number of times each instruction is executed, and code size
of each function in the program. The Critical Code Data viewer displays the detailed
information of every instruction traced in the data.

The features available for the Critical Code Data viewer include:

e statistics at function level,

e statistics at instruction level,

e code view in source editor, and

 column ordering and sorting at function level.

2.2.4 Performance Data

The performance data includes the metric and invocation information for each function
that executes in the application. The performance data during measurement enables you
to compare the relative efficiencies of various portions of your target program. Both
exclusive and inclusive timing measurements are provided in the performance data. The
parent-child calling relationships between your program's functions are also provided.
Each function pair consists of a caller and a callee with data provided for each.

2.2.5 Call Tree Data

The Call Tree data shows the general application flow in a hierarchical tree in which
statistics are displayed for each function.

2.2.6 Counterpoints

CodeWarrior Development Studio for StarCore SC3900FP DSP Architectures Tracing and Analysis Tools
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Counterpoints allow you to count events between two points of the executed code. The
results are computed based on the collected trace data; the counterpoints are searched in
trace by their addresses. When counterpoints are found in the executed code, the delta
statistics 1s computed between two counterpoints.
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Chapter 3
Collecting Data

This chapter explains how the program runs on the simulator and Qonverge targets to
collect the data.

This chapter describes:

 Process for Collecting Data

* Creating New Project

* Configuring Launcher

* Collecting Trace

* Viewing Data

* Exclude Symbols from Statistics

* Trace on Attach

* Viewing Interrupts

* Preparing Aurora Interface for Collecting Aurora Nexus Trace
* Inline Functions

e Importing Offline SC3900 Trace with Hardware Trace Configuration
e Multicore Tracing

3.1 Process for Collecting Data

This section describes the process for setting up the tools for data collection.
To collect data:

* Create and configure a project for the simulator

 Set up the debugger launch configuration to collect the analysis data from the
simulator

* Run the application on the simulator to collect data
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3.2 Creating New Project

This section explains the process to create new projects for both simulator and hardware
profiling.

You can use the CodeWarrior Bareboard Project Wizard to create new projects.
In this topic:

 Simulator Profiling
* Hardware Profiling

3.2.1 Simulator Profiling

This section describes the process to create a simulator project for collecting trace data.

You can use the CodeWarrior Bareboard Project Wizard to create new projects for
tracing.

The CodeWarrior IDE is a project-oriented interface. You must create a new project or
open an existing project before using the Analysis tools.

To create a new project:
1. Select File > New > CodeWarrior Bareboard Project Wizard.

The CodeWarrior Bareboard Project Wizard page appears.
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2 CodeWarrjor Bareboard Project Wizard

Create a CodeWarrior Bareboard Project

hoose the location far the new project

Project name: | proj-sim

Use default location

@

I Next = H Finish H Cancel ]

s

Figure 3-1. Create a CodeWarrior Bareboard Project Page
2. On the Create a CodeWarrior Bareboard Project page, enter the name of your
project and also specify the location of the project.

The following table describes the StarCore Project settings.

Table 3-1. Create a StarCore Project Page
Settings

Option Description

New Project Name Enter the name of the project in this text box

Use default location * Checked - Project stores the files required to
build the program in the Workbench's current
workspace directory

* Unchecked - Project files are located in the
directory you specify. Use the Location text
box to select the directory

Location Specifies the directory that contains the project files.
Use the Browse button to navigate to the desired
directory. This option is only available when Use
default location is unchecked

3. Click Next.

The Processor page appears.
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¥4 CodeWarrior Bareboard Project Wizard | = '@

Processor

Choose the processor for this project

Processor

type filter text

a StarCore Family
4 Converge
B4060
B4420
B4460
B4860
54860
4 5C3900
SC3900fp

Project Qutput
i@ Application
(7) Component Library
(") Self-Contained Library
(71 Simple Library

@ [ <Back |[ Nea> |[ Enish |[ cancel |

Figure 3-2. Processor Page
4. On the Processor page, choose the target device for your project. Select SC3900fp

from StarCore Family options.
5. Click Next.

The Debug Target Settings page appears.
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P =)

¥ CodeWarrior Bareboard Project Wizard | = '@

Debug Target Settings
Target Settings

Debugger Connection Types:

@ Simulator

Board [5(3900155 -

Launch Connection

m

[¥] Download | ¥ Default il

Connection Type | CCSSIMRISS -

@ | <Back || Net» || Einish || Cancel

Figure 3-3. Debug Target Settings Page
6. Select SC3900PA CC board from the list.
7. Click Next.

The Build Settings page appears.
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P =)

¥ CodeWarrior Bareboard Project Wizard = @

Build Settings
Choose the build settings for the project

Language
@ C
i) Ce+
() ASM

Mote:

If the toolchain you want to use is disabled, please install the corresponding package for
adding the build tools support.

Toolchain
i@ StarCore 3900

Floating Point: ’Hardware -

[7] Fused multiply and accumulate

@

Mext = ’ Einish ] ’ Cancel

Figure 3-4. Build Settings Page
8. Do not change the default settings on the Build Settings page.
9. Click Finish.

The project is created in the CodeWarrior Projects view. In this view, you can see
that the proj-sim project is created.
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1 Codevdarrior Projects 22 =08
B | 1% B &P |~
File Mame Size  Twpe

= Application_File

91::? Binaries

(= Debug_SC3900_PACT

[= Debug_settings

[} Includes

= LCF

Ef readme_SCIF00PACC kxt 1EB Text
[ Referenced Projects

=~ Source

Figure 3-5. CodeWarrior Projects View Page

3.2.2 Hardware Profiling

This section describes the process to create a new project for collecting trace data.

You must create a new project or open an existing project before using the Analysis tools
for hardware profiling.

To create a new project:

1. Select File > New > CodeWarrior Bareboard Project Wizard. The CodeWarrior
Bareboard Project Wizard appears.
2. Enter the name of your project and also specify the location of the project.
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P =)

¥ CodeWarrior Bareboard Project Wizard | = '@
Create a CodeWarrior Bareboard Project
Choose the location for the new project
Project name:  sc-b4860
Uze default location
C:\Users\b34930Mworkspace\5Csc- b4 860 Browse...
@:l < Back [ Mext = ] ’ Einish ] ’ Cancel ]

Figure 3-6. Create a CodeWarrior Bareboard Project Page
3. Click Next.

The Processor page appears.
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-

P

¥4 CodeWarrior Bareboard Project Wizard | = '@

Processor

Choose the processor for this project

Processor

type filter text

a StarCore Family
4 Converge
B4060
B4420
B4460
B4860
54860
4 5C3900
SC3900fp

Project Output
@ Application
(") Component Library
() Self-Contained Library
() Simple Library

@ | <Back |[ Nea> |[ Finish || Cancel |

Figure 3-7. Processor Page
4. For hardware profiling, select the desired target (for example, B4860) from
StarCore Family group.
5. Click Next.

The Debug Target Settings page appears. Do not change the default settings of this
page.
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¥ CodeWarrior Bareboard Project Wizard | = '@

Debug Target Settings
Target Settings

Debugger Connection Types: N
@ Hardware
(7 Sirnulator

() Emulator

Eoard [Emaﬁnqms -

m

Launch Connection

[¥] Download | 5§ Default &7

Connection Type [ECodeWarrior TAP [over USB): o

@ | <Back || Netr || Enish || Cancel

Figure 3-8. Debug Target Settings Page
6. Click Next.

The Build Settings page appears.
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P =)

¥ CodeWarrior Bareboard Project Wizard | = '@

Build Settings
Choose the build settings for the project

Language
@ C
i) Ce+
() ASM

Mote:

If the toolchain you want to use is disabled, please install the corresponding package for
adding the build tools support.

Toolchain
i@ StarCore 3900

Floating Point: ’Hardware -

[7] Fused multiply and accumulate

@ | <Back || Net» || Einish || Cancel

Figure 3-9. Build Settings Page
7. Do not change the default settings on the Build Settings page.
8. Click Next.

The SmartDSP OS page appears.
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¥ CodeWarrior Bareboard Project Wizard | = @
SmartDSP 05

SmartDsP 05
@ Mo
i) Yes

Mext = [ Finizsh l ’ Cancel

Figure 3-10. SmartDSP OS Page
9. Select the SmartDSP OS option you want to use.
* Select No to exclude SmartDSP OS support from your project.
» Select Yes to include SmartDSP OS support in your project.
10. Click Finish.
11. The project is created in the Projects Explorer view. In this view, you can see that
sc-baseo project is created.

L[ Project Explorer &2 =] q:ﬁ,-_ ¥ =0
W= 12C_RGE ~
= £3-proj
=5 st

sc-b48a0

[ Includes
[= Application_File
(= Debug B4860_HW
= Debug_Settings
[ LCF
== Source
& readme_B4860005 bxt
D Referencedr SESystems, xmil w

Figure 3-11. Project Explorer View
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12. Select Project > Build Project to build your project.

3.3 Configuring Launcher

You need to configure the launcher for simulator and hardware profiling, before
debugging your application.

In this topic:

e Simulator Profiling
» Hardware Profiling

3.3.1 Simulator Profiling

Before debugging your application, you need to configure the launcher for simulator
tracing.

To configure the launch configuration:

1. In the CodeWarrior Projects view, right-click on the project and select Debug as >
Debug Configurations from the context menu.

The Debug Configuration dialog box appears.

2. Expand the CodeWarrior group in the tree structure on the left, and select the launch
configuration corresponding to the project you are using from the list to create a
launch configuration, for example, proj-siml_Debug SC3900 Download_ coreo.

3. In the Main tab of the Debug Configurations dialog box, verify that proj-siml is
displayed in the Project field. If it does not appear, browse to the project.

4. If the application is not displayed in the Application field, click Search Project to
select the application image.
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¥ Debug Configurations

Create, manage, and run configurations

Debug or run an application to a target.

< [T T o R
= *| El & Name: proj-siml_Debug_SC3900_Download_corel0

type filter text [£] Main . 69= Arguments| %5 Debugger| = Trace and Profile t, Source | B Environment| = Commaon
[©] CodeWarrior Debug session type
[E] proj-siml_Debug_5C3900_Download_core00 Choose a predefined debug session type or custom type for maximum flexibility
= Launch Group @ Download () Connect

Fﬁ Target Communication Framework ©) Attach () Custom

w /C++ application

Project: proj-sim

Application: Debug/proj-sim.eld SearchProject...” Browse... ” Variables... ]

~ Build (if required) before launching
Build (if required) before launching

Build configuration: ’UseActive v]

[ Select configuration using 'C/C++ Application’
(7 Enable auto build () Disable auto build

@ Use workspace settings Configure Workspace Settings...

« Target settings

Connection: =t= proj-sim_Debug_5C3900_Download v Edit... ] ’ Mew...
Filker matched 4 of 4 items

Execute reset sequence

Filter by Project: Execute initialization script(s)
1= proj-sim
Apply Revert
@j [ Debug ] ’ Close

Figure 3-12. Debug Configurations Dialog Box - Main Page
To configure the launch configuration for measurement of data:

1. Click the Trace and Profile tab. This tab has Overview page, Basic page,
Intermediate page, Advanced and Miscellaneous page.
The Overview page displays the flow diagram for collecting trace.

NOTE
The Advanced tab is not applicable for Simulator profiling.
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Main ((Xl= Arguments r%?« Debugger (f—z Trace and Profile . %~ Sourcej -] Environmenﬂ = Qommon}
Owerview Basia Intermediatej Advancedj Miscellaneouﬂ

TracelP for SC3900 PACC simulator

. Y profiling simapi (.dil):
CodeWarrior This is the Software Analysis library that colle

| post process raw trace data from simulator.
Analysis callbacks:
-/

@ Callbacks are used by Simulator to acknowlec

SA about varicus events (e.g., PC change,
| ccsapl |

one cycle elapsed).

Trace & Profiling
results

Sockets {control}

r

[ ccs.exe ] [ccssimz.exe Tonding profiling simapi (.dll} dumping trace
@ I callbacks T ®‘

execute
.elffile

@ Loading elf in simulator @ Dumping raw trace to file
LEEEI"Id: @ Loading 5a dll @ Post processing raw trace
— Trace flow

e Control {sockets) @ Executing elf in simulator @ Completing analysis and

showing results
@ Callbacks call Sn dil

Figure 3-13. Trace and Profile Tab - Overview Page
2. In the Basic page, specify the Communication Settings.
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¥ Debug Configurations

Create, manage, and run configurations

Debug or run an application to a target.

-y
L1 B b | B 5 MName: proj-siml_Debug_5C3900_Download_cored0

type filter text Main | (9= Arguments | %5 Debugger | = Trace and Profile . Source| g Environment| ==/ Common

[c] CodeWarrior Overview | Basic . Intermediate | Advanced | Miscellanecus

[E] proj-siml_Debug_5C3300_Dv o )
= Launch Group Communication Settings
Fﬁ Target Communication Framew Communication port number: 55555
4 | 1 | }

Filter matched 4 of 5 items

Filter by Project:

= proj-sim ‘ L . .
= proj-siml

’ Apply ] ’ Revert ]
@j [ Debug ] ’ Close ]

Figure 3-14. Trace and Profile Tab - Basic Page

* Choose the free port number from interval 0-65535 for communication settings.
The default port number is 55555. This is used in TCP/IP communication
between software analysis and CCSSIM?2.
3. In the Intermediate page, specify Trace control settings option.
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¥ Debug Configurations | &=

Create, manage, and run configurations

Debug or run an application to a target.

T x' — }:b M Mame:  proj-siml_Debug_SC3900_Download_corel0
proj g

type filter text [] Main [ 9= Arguments [ %% Debugger | = Trace and Profile . Source| g Environment| ==/ Common

[c] CodeWarrior Overview | Basic | Intermediate ~._Advanced | Miscellanecus i

&l
roj-siml_Debug_5C3900_Dc
. Lau:chJ Grou;; 2 - Trace collection Trace control settings
[ﬁ Target Communication Framew: Apply Trace Configuration Settings

_) Automatically (When debug session starts)

@ Manually (Using trace buttons from Trace Cormmander)

m

Upload Trace Configuration Settings
@ Automatically (When debug session is suspended)

_) Manually (Using trace buttons from Trace Commander)

4 T b

Filter matched 4 of 5 items

Filter by Project: -

= proj-sim
= proj-siml

I Apply ‘ I Revert ‘
|@:| [ Debug ] I Close ‘

Figure 3-15. Trace and Profile Tab - Intermediate Page

* Apply Trace Configuration Settings

* Automatically (When debug session starts) - The trace collection process
1s started automatically when the debug session is launched.

* Manually (Using trace buttons from Trace Commander) - This is the
default behavior. This option is used when you want to manually control the
trace collection. The trace collection process will not be started
automatically on debug session launch, but the trace configuration options
are applied, when you click on Trace Start/Stop button.

* Upload Trace Configuration Settings

* Automatically (When debug session is suspended) - This is the default
behavior. This option is used to upload the trace data automatically.

* Manually (Using trace buttons from Trace Commander) - This option is
used when you want to manually upload the trace data using Upload Trace
button available in the Trace Commander view.

NOTE
Trace configuration settings will be disabled during debug
session.

CodeWarrior Development Studio for StarCore SC3900FP DSP Architectures Tracing and Analysis Tools
User Guide, Rev. 10.9.0, 11/2015

Freescale Semiconductor, Inc. 37




vourniiguring Launcher

4. In the Miscellaneous tab, specify the path for storing the trace and profile results.
Click Browse to select the path for the Output Folder.

?ﬁl Debug Configurations

Create, manage, and run configurations

Debug or run an application to a target.

5 —+,
7 EE *| = 5 Mame: proj-siml_Debug_SC3300_Dewnload_core(0
type filter text |=| Main | (2= Arguments %‘;‘F Debugger | = Trace and Profile EVSource P& Environment| = Common
[c] CodeWarrior COwerview | Basic | Intermediate | Advanced | Miscellaneous a

[t proj-siml_Debug_5C3900
= Launch Group
[ﬁ Target Communication Fram Output Folder:  Ci\Users\b34930%warkspace!\StarCorel0.8.2\proj-sim1\.Analysis Data | | Browse...

General Settings

m

< Tl 3

Filter matched 4 of 10 items

Filter by Project: d i

= Test
= proj-siml

@ [ Debug ] [ Close

g

Figure 3-16. Trace and Profile Tab - Miscellaneous Page

NOTE
Before using a simulator to collect trace data, a configuration
must be made. You can create the configuration in the debug
mode. If the project is started without a configuration, a
warning message will appear when trying to start the trace
collection. No trace data will be collected during that session.

3.3.2 Hardware Profiling

You need to configure the launch configuration for hardware profiling.
Perform the following steps to configure the launch configuration:

1. In the CodeWarrior Projects view, right-click on the project and select Debug as >
Debug Configurations from the context-menu.
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The Debug Configurations dialog box appears.

2. Select CodeWarrior Download in the tree structure on the left and select the launch
configuration corresponding to the project you are using from the list to create a
launch configuration, for example, proj-test_Debug_B4860_Download_core0 (0...5).

3. In the Main page, verify that proj-test is displayed in the Project field. If it does not
appear, browse to the project.

4. If the application is not displayed in the C/C++Application field, click Search
Project to select the application image.

ﬁ' Debug Configurations

Create, manage, and run configurations

Debug er run an application to a target.

TE X | = :{::b M MName:  proj-test_Debug_B4860_Download_corell
type filter text [E] Main .6 Arguments| %5 Debugger| = Trace and Profile| & Source| g Environment | & Common
a [t CodeWarrior Debug session type -
[€] proj-test_Debug_B4860_Download_corell Choose a predefined debug session type or custom type for maximum flexibility
E proj-test_Debug_B4860_Download_core0l @ Download () Connect
E proj-test_Debug_B4860_Download_core02 ©) Attach 71 Custom
[E] proj-test_Debug_B4860_Download_corel3 —r
[E] proj-test_Debug_B4860_Download_cored ¥ {/C++ application

[E] proj-test_Debug_B4860_Download_corel5 Project: proj-test

= Launch Group
‘ETargetCommunicationFramework Application: Debug/proj-test.eld SearchProject...H Browse... H Variables... ]

+ Build (if required) before launching

m

Build {if required) before launching

Build configuration: [Debug v]

["] Select configuration using 'C/C++ Application'

() Enable auto build () Disable aute build

@ Use workspace settings Configure Workspace Settings...

~ Target settings

Connection: =8= proj-test_Debug_B4860_Download v Edit... ] [ Mew...

Execute reset sequence
Execute initialization script(s)

Filter matched 9 of 9 items The connection is for a multicore target. Please select a core:

Target
Filter by P t
ilter by Projec B4860
1= proj-test =
1 -
Apply Revert
'@:‘ l Debug ] [ Close

Figure 3-17. Debug Configurations Dialog Box - Main Page
To configure the launch configuration for measurement of data:

1. Click the Trace and Profile tab. This tab has Overview page, Basic page,
Intermediate page, Advanced and Miscellaneous page.

The Overview page displays the flow diagram for collecting trace.
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Main ((Xl= Arguments r%?« Debugger (f—z Trace and Profile . %~ Sourcej -] Environmenﬂ = Qommon}

Owerview Basia Intermediatej Advancedj Miscellaneouﬂ

T T T T T T R e s A T T . TracelP for B4860

N\ = DSP Cluster:
E ! Each D5P Cluster contains 2 StarCere 3900 coi

;?. .ft 'T‘ PPC Cluster:

The PPC Cluster contains 4 PowerPC e6500 cc

PowerPC

PPC Cluster / 11
————— - s

SmallNBE External r
Trace buffer Memory —_—— -
vl (DDR) [

I

| External trace buffer
. N Aurora probe

DPAA, CoreMET, DDR,
other platform events J

e Trace from cores [programy/data trace)
e Trace from Sol (event trace)

e Qutput trace from platform

= == =g (ollect trace to host device

Figure 3-18. Trace and Profile Tab - Overview Page
2. In the Basic page, you need to configure platform configuration, trace module and
trace scenarios.
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MName: Test_Debug_B4860_Download_corel0

= Trace and Profile - % Source| B§ Environment | ] Commen

[Z] Main | 9= Arguments ﬁ‘«Debugger
COwerview | Basic ™. Intermediate | Advanced | Miscellaneous

Platform Configuration

’?‘test_[}ebug_B4860_DownIoad_coreDUE v] [New] [Rename...] [Delete...]

Trace module configured by

() User Code
(2000000
@ CodeWarrior
Trace scenarios
Trace scenarios Bandwidth
() Profiling - L2 cache events D
() Profiling - data loads 3
() Profiling - clock cycles Low 1

() Profiling - advanced
@ Program trace

() Coverage

) None

Extend trace scenario with:

[] Ownership trace
[7] User defined events

Mote: The kind of trace that will be collected with the current selections:
pragram.

Figure 3-19. Trace and Profile Tab - Basic Page
The below table lists the basic trace and profile options required for hardware
profiling.

Table 3-2. Trace and Profile Basic
Settings

Options Description

Platform Configuration allows to select the Platform Configuration file from
the drop-down list. A platform configuration file holds
the settings made in the Trace and Profile tab page
for a project. Changes made in the configuration file
of a project will automatically gets reflected in all the
projects sharing the same configuration file. You can
also perform the following actions on a configuration
file:

* New: Creates a new configuration file with

default settings

Table continues on the next page...
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Table 3-2. Trace and Profile Basic Settings

(continued)

Options

Description

* Rename: Renames the currently selected
configuration file.

¢ Delete: Deletes the currently selected
configuration file.

Trace module configured by

User code allows to perform trace configuration settings from
coderun on target
CodeWarrior allows to do the trace settings using CodeWarrior

configuration windows

Trace Scenarios

Profiling - L2 cache events

trace values of counters of both triad A and B on
subroutine/interrupt call/return instructions

Profiling - data loads

trace values of counters of both triad A and B on
subroutine/interrupt call/return instructions

Profiling - clock cycles

trace values of counters of triad A on subroutine/
interrupt call/return instructions

Profiling - advanced

traces each change of flow instructions

Program trace

allows program trace to be collected

Coverage

for C source lines, displays the percentage of
number of assembly instructions executed from the
total number of assembly instructions corresponding
to the source line. For assembly source lines, it
shows if the instructions were executed or not

None

no trace will be collected

Extend Trace Scenario with:

Ownership Trace

traces information on current task ID. Ownership
trace facilitates tracking the active operating system
task by providing visibility to the special purpose
registers designated for use by the OS for process
ID

User defined events

traces any write to TMDAT and TMTAG core
registers

For B4 targets, the ownership trace messages will be
generated into trace stream only if Program trace or
Coverage trace options available under Trace scenarios
are also selected with Ownership trace option.

3. In the Intermediate tab, you need to configure mode of trace collection and trace

control settings.
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[E] Main [ ©9: Arguments | %5 Debugger | = Trace and Profile . Source| I Environment | = Common

Overview | Basic | Intermediate ~._Advanced | Miscellaneous

Trace collection Trace control settings

Mode: lretian: Apply Trace Configuration Settings
@ One buffer @ MPC buffer () Automatically (When debug session starts)
) Overwrite (©) Gigabit TAP + Trace @ Manually (Using trace buttons from Trace Commander)
) Continuous

0x8000 Upload Trace Configuration Settings

() DDR buffer () Autematically (When debug session is suspended)
@ Manually (Using trace buttons from Trace Commander)
03000000
0x10000

Use settings from LCF file

Figure 3-20. Trace and Profile Tab - Intermediate Page

The following table describes the Intermediate trace and profile options required for
hardware profiling.

Table 3-3. Trace and Profile Intermediate

Settings
Options | Description

Trace Collection - Mode

One Buffer Stops trace collection when trace buffer gets filled.

Overwrite Allows trace buffer to work in wrap mode. When
trace buffer gets full, trace data continues to get
collected overwriting existing data.

Continuous The Continuous mode collects trace continuously till
you suspend the target application. The continuous
trace collection is available only when trace buffer is
placed in DDR.

Trace Collection - Location

NPC buffer Saves trace data in NPC internal buffer.

Gigabit TAP + Trace Probe buffer size (bytes) Saves trace data in probe buffer.

DDR buffer Saves trace data in DDR. Magenta is the bus that
transfers trace data from NPC internal buffer to
DDR.

Buffer start address Specifies the start address of the DDR where the
trace data is saved.

NOTE: The Trace buffer start address
should be aligned to a block
boundary of 128 bytes.

Buffer size Specifies the DDR memory size of the region used
as trace buffer.

Table continues on the next page...
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Table 3-3. Trace and Profile Intermediate Settings
(continued)

Options Description

Use settings from LCF file Uses trace buffer start address and size from linker
files. File common.I3k contains
_TRACE_BUFFER_size and
_TRACE_BUFFER_start variables that allows you to
change the start address and size. File mmu_attr.I3k
contains _ENABLE_TB variable that allows to
enable and disable settings for trace buffer from

linker's files.

NOTE: The Trace buffer start address
should be aligned to a block
boundary of 128 bytes.

Trace control settings - Apply Trace Configuration
Automatically (When debug session starts) The trace collection process is started automatically

when the debug session is launched.

NOTE: To successfully collect
multicore trace, master core
needs to be run into execution
before all other cores at first
resume of the debug session. If
master core is core 0, use
multicore resume from Debug
toolbar. But if master core is not
core 0, master core needs to be
resumed first and then click
multicore resume from Debug
toolbar for all the other cores.

Manually (Using trace buttons from Trace This is the default behavior. This option is used
Commander) when you want to manually control the trace
collection. The trace collection process will not be
started automatically on debug session launch, but
the trace configuration options are applied, when you
click on Trace Start/Stop button available in the
Trace Commander view.

NOTE: To successfully collect
multicore trace, master core
needs to be run into execution
before all other cores at first
resume after trace is being
started from Trace Commander.
If master core is core 0, use
multicore resume from Debug
toolbar. But if master core is not
core 0, master core needs to be
resumed first and then click
multicore resume from Debug
toolbar for all the other cores.

Trace control settings - Upload Trace Configuration Settings

Automatically (When debug session is suspended) This is the default behavior. This option is used to
upload the trace data automatically.

Table continues on the next page...
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Table 3-3. Trace and Profile Intermediate Settings

Description

NOTE:

The automatic upload trace
configuration setting option
works only when every suspend
of the master trace generator/
master core is done after all
other trace generators/cores
have been suspended to
ensure no trace generator
generates trace in trace buffer
while master trace generator is
uploading trace. Otherwise, the
trace uploaded will be
corrupted.

Commander)

Manually (Using trace buttons from Trace

This option is used when you want to manually
upload the trace data using Upload Trace button
available in the Trace Commander view.

Apply Trace Configuration and Upload Trace

NOTE

Configuration settings are disabled during debug session.

NOTE

Trace buffer for B4860 is not per core, but it uses one
single buffer for all cores.

4. In the Advanced tab, you need to configure triad settings if you have selected
Profiling - advanced option available under the Trace scenarios list in Basic tab.
After selecting Profiling - advanced option, the default profiling events are mapped
on Triad A - L1 Icache Access Sorting and Triad B - Program L1-> L2
Cacheable Access Sorting.
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Mame:  Test_Debug_B4860_Download_cored0

[Z] Main [ 69= Arguments | %5 Debugger | = Trace and Profile

E. Source| B Environment | = Common
Cwverview | Basic | Intermediate | Advanced

Miscellaneous
Triad Settings

Triad A | Instruction fetching : L1 Icache access sorting
Triad B

m

Instruction fetching : Program L1->12 cacheable access sorting

m

Figure 3-21. Trace and Profile Tab - Advanced Page

The profiling sampling events can be associated to triad A or triad B or both of them.

For example, if you select Core Events - branch prediction : Branch Prediction 1:

High level events in Triad A and for sampling Instruction Fetching : Program
access holds in Triad B the following trace is displayed.

Legend:
Call/Branch 4| | Triad 4{Instruction fetching ... 4| Triad B{Instruction fetching ;... <|
Off... | Event S... Description Type Timesta..,
Source Target | Program... | Program... | Program... | L2 Progr... | L2 Progr... | L2 Progr... |
1-1 SoC Device id = 0x0192001d (B4) Info 0
81 care 0 pebug status = 0x0, Core entered in Execution state, Source Info 0
isPCU,
10-1 core_0 Function main. Source address = Ox40002600. main Function Call 143 [ 0 1 1 0 1
16-1 care_0 Function funcz. Source address = Dx4000200a. fumcz Function Call 262 6 4 2 1 0 3
22-1 core_0 Function printf, Source address = 0x4000c758, printf Function Call 396 6 6 3 1 il 7
28-1 care_0 Function fwide. Source address = Dx4000d206. Fuide Inkerrupt 575 15 7 3 1 0
341 Diebug status = 080000000, Core entered DEBUG mode.
H care_0
- Reason is executing a debug core instruction,

Info 1,362

Figure 3-22. Trace Data after Configuring Triads A and B

5. In the Miscellaneous tab, specify the path for storing the trace and profile results.
Click Browse to select the path for the Output Folder.

3.4 Collecting Trace

This section explains the trace collection methods for hardware and simulator based
projects.

In this topic:

e Using Simulator
» Using Hardware
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3.4.1 Using Simulator

This section explains the trace collection methods for simulator projects.
To start the trace collection:

In the Debug window, click Debug to launch the project. The application should halt at
the beginning of main in the Debug perspective. If you want to modify the trace
configuration, click Configure Trace button from the Trace commander view. You can
reconfigure the trace during the debug session. You can apply the new settings, all the
data collected before will be deleted and when resuming the session, new trace with be
collected with the new configuration.

X2 Debug - proj-sim1/Sources/sc3900_main.c - CodeWarrior Development Studio E@
File Edit Source Refactor MNavigate Search Project Run  Window Help
g | % & 85 Ffi-B-8 H-0-%-Q@ &~ T T & (%5 Debug 7
%5 Debug % = B ||t= variables 2 . ®g Breakpoints| [ Cache| ¥} Registers =i Modules =08
DI B AP wele T RNEL =N
a [t proj-siml_Debug_SC3900_Download_core00 [CodeWarrior] Name Value Location -
a StarCore DSP, proj-siml.eld, core 0 (Suspended) 9= prod 0 0x819e0218 Data L
4 ¢ Thread [ID: 0x0] (Suspended: Signal 'Halt' received. Description: User halted thread.) 60« prod_ref 0 :Bf9e0214 Data 3
= 2 main() 5c3900_main.c:100 0x800025e0 - my e_rmr 0 08190210 Data
= 1 (AsmSection)() startup_ startup_b4860fp_.asm:585 0:800103fe - nur\;har of error values 0 0x8f9e020¢ Data
s C\Users\b34930\workspace\StarCorel0.8.2\proj-sim1\Debugiproj-siml.eld (11/10/14 6:51 PM) . — = .
|€] 5c3900_main.c &2 = O ||2=" Disassembly &2 5F Outline =8
_ st_srs_2f((Wordl6 *)res, sum_r8, sum_i@); - =
} Enter location here -
int main() . e
& iy (BE)
int number_of_error_values=@, my_error; 168 I n
Word32 prod_ref = @xDAE1135C; 2 368825:0: adda.lin #328,sp
Word32 prod; 8e@@25e4:  adda.lin #38,sp,rt
func2(); 1e1 int number_of_errd
vector_dot_product_16x16((Word32 *)&8X[@], (Word32 *)&¥[e], N, &prod); 30802528 eor.x de,de,de noj
Frintﬂ"checking results.\n"); 3080250 : st.1 de,(sp-$24)
if (prodi-prod ref) - 162 Word32 prod_ref = «
< [ +
g3 Commander = ¥ T 08| E Console ¥ Tasks| 0 Memery 28 Remote Systems TargEtTasks [£: Problems | (2 Executables =8
+ Project Creation ~ Build/Debug ~ ¢ SETETRlER Pkl @l ] | ® @b ‘ #E-ri-
23 Import project & Build (AI)  &E b
% Import example project & Clean (Al %%
& CodeWarrior Bareboard Project %5 Debug e
] (T K r
e =

Figure 3-23. Debug Perspective - Simulator Screen

If you have selected Manual option in the Intermediate page of Trace and Profile tab,
you should first click Start Trace Collection button available in the Trace commander
view and then Resume button to resume the execution and begin measurement. Let the
application run for several seconds before performing the next step. During the debug
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session, the cycle counter value is enabled and non-zero. When the measurement is
stopped, you can view the value of the cycle counter on the status bar as shown below.
This value changes after every second when the application is running.

11489 %)
Figure 3-24. Cycle Counter

If you want to stop the execution of the application while it is running, click Suspend.
When you suspend the application, the cycle counter also stops. When the application has
executed completely, click Terminate to stop the measurement. When the debug session
is terminated, the value of cycle counter becomes zero and disabled.

3.4.2 Using Hardware

This section explains the trace collection methods for hardware projects.

To start the trace collection, in the Debug window, click Debug to launch the project.:

& Debug - D:\CW SC v10.4.1ASC\StarCore_Supporilcompiler_3900\src\rtliblexpandedistartup__startup_b4860_.asm - CodeWarrior Development Studio
Flle Edit Navigste Search Project Run  Window Help

L SR E AR - R I Oy R R [=Rd Y [ <Hw Corfigu... [0 <<Hardware>> [0 <sw Corfigu.., [0 <Hardware> |35 Debug | M3 c/c++
%5 Debug 52 D e o T m- T = Ot varisbles 52 % Breakpoints | 41 Regsters <8 |H- & pv=8
= [£] b4860-praj_Debug_B4860_Hw_QDS_Core: 00 [CodeWartior Dowrload] Walue Location A
& 1738539520 0x4000d220° Program
haled thread.) 1738539520 0x4000d224° Program
1738539520 40000226 Program
i D iiDebug_B4860_Hlb: eld (9§27]12 10:39 AHY) 1738539520 0400 va
e o4
startup_startup_b460_asm 51 = O |22 Disassembly 22 GF Outine Enter location here IR E ¥ =0
__ crto_end A 4000dzbe:  nop -
g __dnalt: 4000dzke:  nop
L stop 396 staop
_ myself: » a000azen: | stop
Jmp _ mysels 398 jmp _ myself
endsec 4000d2¢4 Jmp §4000d2c49 ; [AswSection)+0xad (0Ox2000d2
420 [
section .text 40006Zea:  ufra.l #§3£,r1 tfra corerev,r o
SECFLAGS ALLOC,NOWRITE, EXECINSTR 4z9 anda ri,r0,r0
SECTYPE PROGEITS 40004242 anda r1,r0,r0
426 suba. lin #4,00,10
global ___ start 4000d2d6: suba.lin #§4,r0,r0
global __ crtd starc 427 tfra.l #>_ asm_StackStart_ed,rl
global ___ Framed 4000d2da:  tfra.l #§4000d220,r1
global __ EwpryIntHandler 426 anda ri,ri,r2
alobal EmptyIntHandler MHU ~ ANNNAZeN:  anda r1.r1r? A
< >
B Console 33 ] Tasks| @ temory | 48 Remote Systems | [ Problems | {3 Executables | @ Software analysis x bi|E[E 2 B-5-50
StarCore DSP, b4B6(0- Id, core 0

Hello private tex
Checking reaults.
No wrong results found.

Figure 3-25. Debug Perspective - Hardware Screen

For more information on debugging and collecting trace data, refer to the Using
Simulator topic.
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3.5 Viewing Data

You can view various types of data collected on an application using the Software
Analysis view.

On resuming the application, the measurement starts and the trace, timeline, critical code,
performance, and call tree data is generated.

Profiling data is not available during debug session, it is available only when you
terminate the application. The hyperlinks of profiling results of Software Analysis view
are disabled during debug session. Also, if trace collection is stopped before debug
session gets terminated, the hyperlinks from Software Analysis view for profiling
features will be disabled. Click Refresh button in the Software Analysis view to update
the hyperlinks to view the profiling trace data.

To view a data file that is created while running the application on the simulator or
hardware:

1. From the menu bar, select Window > Show View > Other > Software Analysis >
Software Analysis to open the Software Analysis view.

2. After collecting the data, the data file will be listed in the Software Analysis view as
shown in the figure.
In the Software Analysis view, you can Copy Line or Cell and also Delete Results.
These options are available in the context menu of this view.

NOTE
The Software Analysis view will list the results from the
output path in correspondence with the platform
configuration selected for that respective project.

@& Software Analysis 2

Software Analysis & mE

Mame Trace Timeline Critical Code Performance Call Tree Config Results  Counter Points Last Mot
1= proj-siml_Debug_SC3800_Downle
& SIM
=} proj-siml_Debug_SC3900_ = Trace [* Timeline Critical Code @; Performance #-= Call Tree % Configure W@ Counterpoints 2015111

Ll 1 3

Figure 3-26. Software Analysis View Screen
3. Expand the datafile to view the trace and profiling data.
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The data can be viewed either generated by simulator or hardware.

* Viewing Data Generated by Simulator
* Viewing Data Generated by Hardware

3.5.1 Viewing Data Generated by Simulator

This section describes how to view trace data for a simulator project in Software Analysis
View.

The following data can be viewed:

* Viewing Trace Data

* Viewing Timeline Data

e Viewing Critical Code Data
* Viewing Performance Data
* Viewing Call Tree Data

* Viewing Counterpoints

3.5.1.1 Viewing Trace Data

Click the Trace link to view the trace data generated in Software Analysis view.

The following figure shows the trace data collected for a simulator project.
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Figure 3-27. Trace Data
The below table explains various fields of the trace data.
Table 3-4. Trace Data
Field Description
Index Displays the order number of the instructions.
Event Source Displays program trace messages from PACC simulator.
Description Displays detailed information about the trace line.
Source Displays the source function of the trace line if it is a call or a
branch.
Target Displays the target function of the trace line if it is a call or a
branch.
Type Displays the type of the trace line, which can either be a linear
instruction, a branch, a call, or a custom message.
Timestamp Displays the absolute clock cycles that the instruction takes to

execute.

Stalls shows the number of stalls that occurred on a PC and measured in cycles.

ChoF Stalls

Displays the number of bubble cycles incurred by change of

program flow for each instruction.

Interlock Stalls

Displays the number of bubble cycles incurred by core
resource interlocks for each instruction.

Memory Stalls

Displays the number of bubble cycles incurred by data bus
hold for each instruction.

Program Stalls

Displays the number of bubble cycles incurred by program
starvation for each instruction.

Rewind Stalls

Displays the number of bubble cycles incurred by a rewind on
the core buses for each instruction.

Table continues on the next page...
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Table 3-4. Trace Data (continued)

Field

Description

BTB events shows which BTB event has taken place at the PC. It can be 0 or 1:1 if the event has taken place and 0 if no
event has taken place.

BTBable COF The decoded COF is BTBable.
COF Taken The COF is taken; changes the program flow.
False BTB Hit Indicates False hit.

BTB Prediction

BTB prediction shows the status of the BTB prediction and it

can be any of the following:

e COF predicted correctly: Set of the COF instruction did

not cause a pipe flush.

e COF in BTB: BTBable COF not in the BTB and miss-

predicted. It can be taken or not.

e COF wrongly predicted: BTBable COF, predicted as
taken in the BTB, resolved as not taken (wrongly

predicted).

» Buffered sequential loop wrongly predicted: Buffered
LPEND incorrectly predicted (Non-BTBable LPEND.SQ
with LC>1 and no internal match).

e BTBable loop wrongly predicted: Either BTB hit on
LPEND in last iteration or LPEND taken without BTB

hit.

You can also also count the events by the profiling counters. The events are organized
into groups of 3, each counted by either Triad A or B. In many cases, two events groups
were defined for concurrent profiling, as they belong to the same event category.

The following table summarizes the different counting groups.

Table 3-5. Summary of event groups for profiling

Event Event Group Triad Counter 0 Counter 1 Counter 2 Comments
Category
Core events - Exceptions 1 A Trap Critical interrupts |Non-critical interrupts |-
interrupts instructions
Exceptions 2 B MMU Debug exceptions | Other exceptions -
exceptions
Core events - Branch predication |A Total VLES COF VLES (w/o |COF correctly Includes both
branch 1: High level hardware loops) |predicted (w/o taken and not-
prediction hardware loops) taken COFs.
Branch prediction |B All BTB-able BTB-able COFs, |BTB-able COFs, Includes both
2: BTB COF wrongly wrongly predicted, in  |taken and not-
predicted, notin |the BTB taken COFs.
the BTB
Hardware loop B Total hardware |Incorrectly Other incorrectly Buffered loops:
prediction end-of-loop predicted buffered |predicted end-of-loop |those sequential
COF (not end-of-loop COF [COF (not in the BTB, |loops which fit in
including CONT in the BTB wrongly the buffer
and BREAK) predicted, loop re-
learn)

Table continues on the next page...
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Table 3-5. Summary of event groups for profiling (continued)

Event Event Group Triad Counter 0 Counter 1 Counter 2 Comments
Category
Core cycles Cycle high level A Application - Bubbles App.cycles: not
cycles in debug and
low power
modes
Stall cycles 1 A No bubbles COF (pipe flush) [interlocks (RSU) w/o |-
(once per & dispatch holds
VLES) starvation cycles
Stall cycles 2 B Data memory |&program cache |Rewind cycles (prog & |-
holds and holds data)
freezes
Fetch & Dispatch |B Pipe flush Stalls due to COF |BTB bubbles -
stall cycles cycles: target spread

mispredicted
COF, interdicts,
exit from idle
states

over two fetch
sets

Rewind events B Data rewind Program rewind |DTU rewind events -
events events
Debug events  |Debug Events 1 A IEU QO IEU Q1 Reload counter 0 RZ |-
Debug Events 2 B IEU Q2 IEU Q3 -
Watchpoints 1 A - PCDAO PCDA2 -
Watchpoints 2 B - PCDA4 PCDA6 -
DEBUGEV 1 A DEBUGEV.0 DEBUGEV.2 DEBUGEV.3 -
DEBUGEV 2 B DEBUGEV.4 DEBUGEV.6 DEBUGEV.7
Trace Trace messages |A Total trace Error messages |Messages lost -
performance messages
Trace cycle B Dual trace beats |Freeze cycles Freeze cycles due to |Each increment
overhead leaving the due to main input queues of BO means two
queue queue (if not beats sent in
frozen due to the parallel to the
input queues) NPC
Instruction L1 Icache access |A Program access |Program access |Program access L1 -
fetching sorting L1 hits L1 pre-fetch hits |miss
Program L1->L2 |B L2 Program L2 Program L2 Program access Only cacheable
cacheable access access hits access hits miss accesses,
sorting (shared/ (modified) including CME
exclusive) accesses
L1 Program pre- A CME/granular |- CME granular - L1 Only program
fetch accesses PF accesses - miss CME and cache
L1 hit (including granular
pre-fetch hit) accesses. ctri
does not count
Program access B Program Program non- Program rewind events | The core may

holds

cacheable hold
+ contention
cycles

cacheable holds +
miscellaneous

continue to
execute during
program holds

Table continues on the next page...
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Table 3-5. Summary of event groups for profiling (continued)

Event Event Group Triad Counter 0 Counter 1 Counter 2 Comments
Category
Data channel - |Data access holds |B Data cache Data store freeze |Data rewind events B0 and B1
general -HL holds events may
overlap
Coherency - A L1 data CME/granular L1 data invalidation Only actual
invalidation events invalidate from |invalidation from internal conflicts |invalidation is
L2 accesses counted
Data Loads L1 Dcache load A Data access L1 |Data access L1  |Data access L1 miss |-
access sorting hits pre-fetch hits
Data L1-> L2 B L2 Data access |L2 Data access |L2 Data access miss |Only cacheable
cacheable load hits (shared/ hits (modified) accesses,
access sorting exclusive) including CME
accesses
L1 Data pre-fetch |A CME/granular |CME/granular CME granular - L1 Only data CME
accesses PF accesses - |cache pre-fetch  [miss and cache
L1 hit (including |accesses that granular
pre-fetch hit) were dropped accesses
Data load holds 1 |A Data load Data loads non- |Data cache contention |Holds for
cacheable hold |cacheable hold cycles parallel
cycles cycles accesses
counted once
Data load holds 2 |B Full fetch queue | miscellaneous Address queue load Address queue
hold cycles hold cycles after store hazard holds may
(barriers, special |cycles overlap the data
commands) cache holds
Data load special |A Total memory  |Non-aligned 4K |Load rewind events -
cases loads loads
Data load access |B Total core Total valid Killed accesses with W bus accesses
speculation accesses accesses cache miss
without cache
commands and
barriers
Data stores Store access A Total store SGB merges SGB write out hot No cache
sorting accesses (DLINK to L1) commands and
barriers, after
non-alignm ent
split, merges
may be 4 ata
time
SGB events B SGB freeze SGB read-modify- | SGB accepter rewind | For parallel
cycles write accesses to |events accesses, a
L2 freeze is
counted once
CME Data CME A CME data CME SkyBlue Granular data CME command
commands commands data commands |commands = actual channel

allocation. A2 is
not implemente
d in the CME

Table continues on the next page...
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Table 3-5. Summary of event groups for profiling (continued)

Event Event Group Triad Counter 0 Counter 1 Counter 2 Comments
Category
Program CME B CME program |CME SkyBlue Granular program -
commands commands program commands
commands
CME allocation A Total CME Total successful |Total CME channel Substitution s =
allocation allocations substitutions (program |incomplete pre-
requests (program + data) |+ data) fetch channel
(program +
data)
Bus load L1-L2 bus load A DLINK read DLINK write beats | ILINK beats A single load
beats access (A0,A2)
can be 2 bus
cycles (beats) if
cacheable.
Cache
commands (no-
tag access)
counted as
writes
SkyBlue bus load |B Core access to |SkyBlue access |SkyBlue access from |-
local subsystem |from the SoC or |any source to the local
registers in the |adjacent core in  |subsystem registers in
CCSR space the cluster to local |the DCSR space
subsystem
registers in the
CCSR space
L2 cache L2 demand (Elink) |A Total L2 L2 program L2 data accesses Each counter
statistics accesses - 1 demand accesses counts up to 4
accesses events per cycle
Each counter B Total L2 hit L2 instruction L2 data miss
counts up to 4 miss
events L2 demand
per cycle
L2 AOUT master |A Total L2 AOUT |L2 AOUT L2 AOUT data side -
requests to requests requests sent as |requests (including
CoreNet global (M=1) barriers)
L2 total traffic B Total L2 L2 Snoop Tot. L2 accesses from |Counters 0 and
demand requestsc all sources 2 may count up
(ELINK) to 4 events per
accesses cycle
L2 external A L2 Total L2 Snoop L2 Stash requests KEXT should be
accesses stashes requests degraded to snoop counted with
L2 DIN Ba) |L2 reload L2 Store allocate | - either KDIN or
requests from KSNP
CoreNet
L2 snooping B(b) L2 Snoop hit L2 snoops L2 snoops causing
causing MINT SINT
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To copy the cell that is currently selected, select the Copy Cell option from the context
menu. To copy the complete line of the data source, select the Copy Line option. If you
want to resize the row or column, select the Auto Resize Row or Auto Resize Column
Width option from the context menu.

The Trace viewer displays two types of trace data:

* Partially decoded trace data
* Fully decoded trace data

Full decoded trace is displayed if prior to opening Trace viewer any of the profiling
viewers (Timeline, Critical Code, Performance, Call Tree, Counterpoints) is already
open. If none of the profiling viewers has been opened, then Trace viewer will display the
partial decoded trace or trace decoded on chunks. Once trace is decoded, Trace viewer
will always display full decoded trace.

Partial decoded trace has certain limitations because current chunk of trace to be decoded
might not contain all information needed to decode that chunk, for example, chunk might
lack PC synchronization or RAS stack information in scenerios when trace is collected in
overwrite mode or multicore core. Such limitations happen only on program trace and not
on profiling trace.

The following table list the details of each trace viewer events showing the limitations of
partial decoded trace:

Table 3-6. Trace viewer events

Trace Events Description

Periodic synchronization After periodic synchronization message no trace dropping
should happen.

Trace dropped - no PC synchronization Trace has been dropped because no message with PC
(program counter) has been analyzed.

Trace partially recovered - PC synchronization but no RAS Trace has partially recovered due to a message providing PC.
stack synchronization Message however, does not ensures a synchronization for
RAS stack. Therefore, it is expected that trace to be dropped
once destination address for a RTS instruction from RAS
stack will be needed.

Trace dropped - RTS treated as direct COF but RAS stack is | Trace has been dropped, because RTS instruction analyzed
empty requires its destination from RAS stack but stack is empty.

Trace fully recovered - PC and RAS stack synchronization Trace has fully recovered due to a message that provides
both PC and RAS stack synchronized. This kind of message
is expected to come once with Periodic synchronization
message.

Trace dropped - certain type of instruction incorrectly traced |Trace has been dropped due to an unexpected error in
decoding algorithm.

Call It reports a call instruction from a source function to a
destination function.

Table continues on the next page...
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Table 3-6. Trace viewer events (continued)

Trace Events Description

Return It reports a return instruction from a source function to a
destination function.

Branch It reports a branch instruction from a source function to a
destination function.

Linear It reports a linear instruction.

Debug Status It reports core state.

Device Id It reports device id.

User defined It reports any write made by user to TMDAT and TMTAG core
registers.

Ownership It reports information on current task ID.

Profiling counter overflow It reports an overflow of the profiling counters.

The Trace Data viewer provides a color convention in the form of Legend to highlight
trace events and source changes. The details on the color convention is listed in the table
below:

Table 3-7. Trace Data

Color Description
Red Highlights the error events reported in the trace data.
Orange Highlights interrupt jumps reported in both program and
profiling trace data.
Green Highlights the info events reported in the trace data.
Purple (Light and Dark) Highlights the data events reported in the trace data; light

purple alternates with dark purple for odd and even lines.

Blue (Light and Dark) and White (White and Seashell) Highlights all other trace events. Blues alternate with whites
as source changes. Light blue alternates with dark blue for
odd and even lines. White alternates with seashell for odd
and even lines.

3.5.1.1.1 Exporting Trace Data

In the trace data viewer you can export trace data to a CSV file.
Perform the following steps to export trace data:

1. Click to display the Exporting Trace Data dialog box.
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# Export Trace Data to CSV E'

(%) Export Full Trace
() Export Partial Trace

Mote: Please choose indexes
between 0 and 7492

@:l [ O, H Cancel ]

Figure 3-28. Exporting Trace Data Dialog Box
2. Select the Export Full Trace option to export complete trace data to a CSV file else
select Export Partial Trace.
3. Specify the begin and end index of the trace data if you have selected the Export
Partial Trace option.
Click OK. The Export Trace Data to CSV dialog box appears.
Browse to the location where you want to save the trace data.

Nl

3.5.1.1.2 Configuring Time Unit and Time Format

The Configure Table button allows you to Configure Time Unit and Configure Time
Format actions.

* Configure Time Unit - Lets you set CPU frequency and convert the clock cycles,
displayed in the Timestamp column, into real time in milliseconds, microseconds, or
nanoseconds. Click this button and select the Configure Time Unit option as shown
in the figure. To convert the clock cycles into milliseconds, microseconds, or
nanoseconds, select the corresponding option.

Configure Time Lnik

Miliseconds ] ]
) Configure Time Format  »
Microseconds

® Manaoseconds

Set CPU frequency

Figure 3-29. Configure Time Unit
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The Set CPU Frequency option allows you to set the CPU frequency needed to
convert the clock cycles into real time. Select this option to display the Set CPU
Frequency dialog box. Set the new CPU frequency according to requirements.

Configure Time Format - Enables the Timestamp column of the Trace Data viewer
for time formatting, Radix: Hexadecimal or Decimal and Value: Absolute or Delta
as shown in the figure below. Time radix formatting is available only if time unit is
set to Time in cycles. The default format of time is displayed in Decimal and
Absolute value. Delta is calculated for same source event. The Delta value for a
specific timestamp is the difference between current timestamp and previous
timestamp with same source event as current one. If Delta value is negative, it will be
displayed as zero.

Configure Time Linit b

Radix ¥

Configure Time Formak
& ghsaoluke
Delka

Figure 3-30. Configure Time Format

3.5.1.2 Viewing Timeline Data

To view the timeline data, click the Timeline link.
The following figure shows an example of Timeline data.

startup__startup_b4860fp_.asm r'." proj-siml_Debug_SC3900_Download_cored0.timeline &3

fu= Timeline - proj-siml_Debug_SC3900_Download_core00.timeline - proj-sim1

SCPACC

Selection Mode |Zoom Mode |FuIIView |EditGr0ups Configure Table | g5

"rnain"

Figure 3-31. Timeline Data
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The timeline data displays the functions that are executed in the application and the
number of cycles each function takes when the application is run. The Timeline viewer
shows the function percent of the completion status for each function in the left panel and
timeline graph in the right panel with the functions aligned on y-axis and the number of
cycles on x-axis. The green-colored bars show the time and cycles that the function takes.

The Timeline viewer have the following buttons:

* Selection Mode - Allows you to mark points in the function bars to measure the
difference of cycles between those points. To mark a point in the bar:

* Click Selection Mode.

¢ Click on the bar where you want to mark the point.

* A yellow vertical line appears displaying the number of cycles at that point.

 Right-click on another point in the bar.

» A red vertical line appears displaying the number of cycles at that point along
with the difference of cycles between two marked points as shown in the below
figure.

(s startup__startup_b4860fp_.asm r-.'- proj-siml_Debug_SC3900_Download_core00.timeline i3 =0

f= Timeline - proj-sim1_Debug_SC3900_Download_core00.timeline - proj-sim1

SCPACC

Selection Mede [Zoom Mode | Full View | Edit Groups  Configure Table « | g
E 000 e 2 000 cycles

»

1

m

Figure 3-32. Selection Mode to Measure Difference of Cycles Between Functions
» Zoom Mode - Allows you to zoom-in and zoom-out in the timeline graph. Click
Zoom Mode and then click on the timeline graph to zoom-in. To zoom-out, right-
click on the timeline graph. You can also move the mouse wheel up and down to
zoom-in and zoom-out.
* Full View - Allows you to get back to the original view if you selected the zoom
mode.

NOTE
The Selection Mode is the default mode of the timeline
view.

CodeWarrior Development Studio for StarCore SC3900FP DSP Architectures Tracing and Analysis Tools
User Guide, Rev. 10.9.0, 11/2015

60 Freescale Semiconductor, Inc.



A\ 4
g gl 4
Chapter 3 Collecting Data

* Configure Table - Lets you configure time unit in cycles, milliseconds,
microseconds, and nanoseconds. For example, to display time displayed in the
timeline graph in milliseconds, select Configure Table > Configure Time Unit >
Milliseconds. It also allows you to set CPU frequency. For details, refer to the
Configuring Time Unit and Time Format topic.

* Export timeline graphic to file - Allows you to save the data visible in the timeline
view as an image in .JPG or .PNG format.

» Edit Groups - Lets you customize the timeline according to your requirements. For
example, you can change the default color of the line bars representing the functions
to differentiate between them. You can add/remove a function to/from the timeline.
To perform these functions, select Edit Groups. The Edit Groups dialog box
appears.

= Edit Groups

Mame Addresses Colar
{AsmSection) 03400091 20 - 4000924

main Dx400028e0 - 0x400029d9
funcz 0x40002000 - 0x4000201h
printF Dx40005d70 - Ox40008dd1
Fwide Dx4000860 - 0x40005777

v| _ pformatker 0004230 - 0x40005cdd

¥| strchr 040009520 - 0x4000953d
strlen O:400093420 - O:40009441
__ Filetyrite Ox40008d20 - 0x40008d51
_ Fuarite 030009590 - Dx40009F29
__prep_buffer 40005700 - Oxd0003305
__memrchr Ox4000a570 - Ox4000a5c1
MEmCpy 000990 - Ox 4000932k

__Flush_buffer
__wrrite_console
_subDaubleSigs

[+] weckor_dot_produck_1...
__copy_longs_aligned

040003510 - 0x400033F5
040002020 - O:x4000a07d
400025920 - Dx40003259
040002020 - 0:x400025dd
040009360 - 0:x400095dh

exit Ox40005a10 - 040005275
_d_div 40005420 - Ox000630F
__tlose_all 000970 - Ox4000934h
frlose 40005290 - Q4000851

040002080 - Ox4000a057
Dx4000alef - Dx4000a24F

__tlose_console
_ SRembd

RERHEEEEEEEEREEEEEE

[ ok H Cancel ]

Figure 3-33. Edit Group Dialog Box
You can perform the following operations in the Edit Groups dialog box:
* Add or Remove Function

» Edit Address Range of Function
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e Change Color
* Add or Remove Group
* Merge Groups or Functions

3.5.1.2.1 Add or Remove Function

This section explains how to add or remove a function from the Edit Groups dialog box.

Right-click on the function name in the Name column, and select Insert Function or

press Ctrl+F to add a function. Select Delete Selected from the context menu to delete
the function from the graph. You can disable a function from the graph by clearing the
corresponding checkbox in the Name column. Check it again to include it in the graph.

3.5.1.2.2 Edit Address Range of Function

This section explains how to edit the address range of a function from the Edit Groups
dialog box.

Perform the following steps:

1. Select the function of which you want to change the address range.
2. Double-click on the cell of the Addresses column of the selected function.

The cell becomes editable.

3. Type an address range for the group or function in the cell.
NOTE

You can specify multiple address ranges to a function. The
multiple address ranges are separated by a comma.

3.5.1.2.3 Change Color

This section explains how to change the color of a function in the timeline graph.

The color appears as a horizontal bar in the graph. Click on the Color column of the
corresponding function, and select the color of your choice from the Color window that
appears.

3.5.1.2.4 Add or Remove Group
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This section explains how to add or remove a group from Edit Groups dialog box.

A group is a range of addresses. In case, you want to view trace of a part of a function
only, for example, for loop, you can find the addresses of the loop and create a group for
those addresses. Perform the following steps to add a group:

1. Right-click on the row, in the Edit Groups dialog box, where you want to insert a

W

4.

5.

= Edit Groups

group, and select Insert Group from the context menu. Alternatively, press the Ctrl
+G key.

A row 1s added to the table with new as function name.

Mame Addresses

{AsmSection) 0540009120 - Ox4000924F
main 4000280 - 0x400029d9
funcz Q40002000 - Q40002010
printf 040005470 - 0x40008dd1
v | Fwide Q:x400036F0 - 0x4000877 7
v| _ pfaormatker Q40004230 - Ox<40005cdd
v | skrchr Q40009520 - Ox4000955d
skrlen Ox400094:20 - Ox40009441
__Filettrite Dx40005d20 - 0x40008d51
Frarite Q40009590 - Dx40009F29

400057 - 040005305
40002570 - Ox4000a3c1

v :prep_l:uuFFer
__memrchr

[0 - DxFFFFFFFE
emcpy Q4000990 - Oxd0009az2h

=

3

Q40003510 - Ox400083FS
Q40002020 - Ox4000a07d
040002920 - Ox40003259
Q40002020 - Q4000254
Cx40008210 - 040008273
_d_div Q40005420 - Ox4000696F
__rlose_all Q4000970 - Dxd0009540
frlose Q40003590 - Ox40008c51
Ox4000a030 - Ox4000a087
Dx4000a1e6 - Ox4000a24f

__write_console
_subDoublesigs

m =
]
& o
[m]
g
CL
[w]
=)
Iy
[m]
[
C
(]l
5
_
[y
=
=
[my])

__rlose_console

__Flush_buffer
_ SRem&d

Calar

SRR OT RN R

(] 4 l [ Cancel

Figure 3-34. Adding Group Dialog Box

Double-click on the new group cell.
The cell becomes editable.

Type a name for the group, for example, mycroup.
Double-click on the cell of the corresponding Addresses column, and edit the
address range according to requirements, for example, ox1£££o330-0x1£££035¢f.

Change the color of the group.
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Mame Addresses Calar
{AsmSection) 040009120 - Dx4000924f
main Q4000280 - Ox400029d2
Funcz Q40002000 - Dx40002010
printf 040008470 - Dx40005dd1
Fride Qa0003EF0 - OdD00E7 77
__pformatker Q0004230 - Ox400050dd
strchr Qx<0009520 - Dx4000955d
strlen 0x40009420 - Ox4000944 1

__Filetrite
Muwicroup

Q40008420 - Ox40005d51
¢ 1FFFO330 - D1 FFFO3SF

__fwrite Q40009290 - 0x40009F29
__prep_buffer 4000370 - 0005305
__memrchr 0x4000a570 - Ox4000a3c1
MEMCpY Q000990 - Oxd0009azh
__Flush_buffer Qx<0003510 - Dx400053F5
__wrrite_console Q00023020 - Ox4000a07d
_subDoubleSigs Dx400029e0 - Ox40003259

wector_dot_product_1...  Qx<0002020 - Ox400028dd
__copy_longs_aligned Q40009360 - Dx400093d0

LD LT

REFFEEEEEEREEEEEE

exit 0x40008210 - Ox40008273
__d_div Q0005020 - Dx400069bF
__close_all Q000370 - O 000934h
Felose Dx40003590 - 0x40003c51
__tlose_console Qx=4000a080 - Ox4000a087
__SRemt4 Dx4000alesd - Ox4000a24F

[ O, l Cancel ]

Figure 3-35. After Editing Address Range and Color of Group Screen

To delete a group, select it, right-click on the Edit Groups dialog box, and select the
Delete Selected option from the context menu. You can also remove a group from
the graph by clearing the corresponding checkbox in the Name column. Check it
again to include it in the graph.

3.5.1.2.5 Merge Groups or Functions

This section explains how to merge the groups or functions available.

Merging is useful in case there are many functions and you do not want to view the trace
of each and every function. You cannot undo this operation, that is you cannot separate
the merged functions or groups. To view the original trace data, reopen the Trace Data
viewer. Perform the following steps to merge the group or function:

1. In the Edit Groups dialog box, select the function or group to be merged.
2. Drag and drop it in the function or group with which you want it to get merged with.
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3. Both the functions or groups merge into a single function or group that covers both
address ranges, where the function, nain 1s merged with the group, mycroup.

= Edit Groups

Marne Addresses Zolor
Dx300028e0 - Dx200029d9, Dx1FFFOS30 - Ox1FFF0ESF IEI
funcz 040002000 - 0x4000201b [
printF 040008470 - 0x40005dd1 (e
Fide Ox400086F0 - 0x40008777 ||
__pformatter 04000430 - 0x40005cdd [
strchr 040009520 - Ox4000955d |
strlen Dx40009420 - Dx40009441 |
__Filewrite 0x40005d20 - 0x40005d51 |
_ Fwarite 040009290 - 0x40009f29 [
__prep_buffer 4000870 - Ox40003505 (e
__memrchr Ox4000a870 - 0x4000a8c1 [
memcpy 04000990 - 0x40009a2h [
_ Flush_buffer 0x 40005510 - 0x4000855 ||
__write_console 0x4000a020 - 0x4000a07d [
_subDoubleSigs 04000290 - 0x40003259 |
vector_dot_product 1., 0x40002020 - Ox400025dd [
__copy_longs_aligned Ox40009860 - 0x400098dh [
et 040008210 - 0x40005a73 (e
_d_div 040005420 - Ox4000690F ||
_ clase_al 04000970 - 040009540 ||
felose 040005590 - 0x400058c51 [
__close_console 040004080 - 0x4000a057 [
_ SReméd Ox4000ales - Dx4000a24F |

[ 8] 4 l Cancel ]

Figure 3-36. Merging Functions or Groups Screen
4. Click OK.

3.5.1.3 Viewing Critical Code Data

To view the critical code data, click the Critical Code link.

The following diagram shows an example of Critical Code data.
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18] startup_startup_b4860fp_asm Test_Sim_Debug_SC3900_Download_corel0 &I =0
Critical Code - Test_Sim_Debug_SC3900_Download_core00 - Test_Sim
Summary table | R R = "

File/Function Address Covered % Not Cover.. Total ASM.. ASM Decisi.. Time Size Chof Stalls  Interlock Stalls  Memory Stalls  Program !
5¢3900 main.c M/A 94.41 % 5.59 % 340 5833 % 3,580 1,826 M/A NfA NfA N/A
func2 040002000 100 % 0% 6 0% 22 ES 16 0 0 0
vector dot product 16:16 040002040 100 % 0% 284 625 % 3,460 1434 20 382 68 0
main 0x400025¢0 62 % 38 % 50 50 % 89 356 40 6 0 0
abort exit.c T 7647 % 2353 % 17 30 % 39 196 MN/A N/A N/A N/A
exit 0x4000a660  76.47 % 2353 % 17 50 % 39 196 20 [ 0 0
alloc.c MN/A 0% 100 % 4 0% 0 44 MN/A M/A M/A M/A
o . A oannnsran nons annar . - o n s ~ n n ~ ;
Details table Search: |CLICK ON A FUNCTION ABOVE | il ~ € ~
Line / Addr... Instructicn Coverage ASM Decision ... ASM Count  Time Chof Stalls  Interlock Stalls  Memory Stalls  Program Stalls

I 2

Figure 3-37. Critical Code Viewer

The critical code data displays the summarized data of a function in a tabular form. The
columns are movable; you can drag and drop the columns to move them according to

your requirements.

The below table explains the various fields of Critical Code tab.

Table 3-8. Critical Code Data

Field Description
Address Displays the start address of the function.
Function Displays the name of the function that has executed.

Coverage %

Displays the percentage of number of assembly instructions
executed from the total number of assembly instructions in a
function.

ASM Decision Coverage %

Displays the decision coverage computed for direct and
indirect conditional branches. It is the mean value of the
individual decision coverages. So if a function has two
conditional instructions, one with 100% and another with 50%
decision coverage, the decision coverage would be (100 +
50) /2 =75% . It is calculated only for assembly instructions
and not for C source code.

ASM Count

Displays the number of lines executed in the function.

Time (Microsecond)

Displays the execution time of each function.

Size

Displays the number of bytes required by each function.

Chof Stalls

Displays the number of bubble cycles incurred by change of
program flow for each function.

Interlock Stalls

Displays the number of bubble cycles incurred by core
resource interlocks for each function.

Memory Stalls

Displays the number of bubble cycles incurred by data bus
hold for each function.

Table continues on the next page...
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Table 3-8. Critical Code Data (continued)

Field Description

Program Stalls Displays the number of bubble cycles incurred by program
starvation for each function.

Rewind Stalls Displays the number of bubble cycles incurred by a rewind on
the core buses for each function.

The Critical Code tab displays data into two views; the top view displays the summary
of the functions, and the bottom view displays the statistics for all the instructions
executed in a particular function. Click on a hyperlinked function in the top view of the
Critical Code viewer to view the corresponding statistics for the instructions executed in
that function. For example, the statistics of the main() function is shown below.

startup__startup_b4860fp_asm Test_Sim_Debug_SC3900_Download_cored0 &1 =0

Critical Code - Test_Sim_Debug_SC3900_Download_core00 - Test_Sim

Summary table | (R I = T
File/Function Address Covered % NotCover.. Total ASM .. ASM Decisi.. Time Size Chof Stalls  Interlock Stalls  Memory Stalls  Program !
4 5c3900 main.c MN/A 9441 % 5.59 % 340 53833 % 3,580 1,826 MN/A N/A N/A N/A

func2 (040002000 100 % 0% [ 0% 22 E 16 0 0 0
wector dot product 16x16 0x40002040 100 % 0% 284 62.5 % 3,469 1,434 20 382 68 0
main 0x400025¢0 62 % E: 50 50 % 29 356 40 [ 0 0
4 3bort exit.c MN/A 76.47 % 2353 % 17 50 % 29 19 MNFA N/A N/A N/A
it 040002660 7647 % 2353 % 17 50 % ] 196 20 [ 0 0
a4 gllocc MN/A 0% 100 % 4 0% 0 44 MN/A N/A N/A N/A i

. P A snansran oo ann o . - no n e n n n P .
Details table Search: 2 | il-<l~
Line / Address Instruction Coverage ASM Decision ...  ASM Count  Time (CPU... Chof Stalls Interlock Stalls  Memory Stalls  Prograr ©

66 [ ¥l covered [ 3 1 0 0 0
0x40002040 adda.lin #398,sp ¥ covered 1 1 1 4] 4] a
0x40002044 adda.lin #&0,sp,rd Z covered 1 1 a 1] 1] o
0x40002048 st.1l r0, (sp-54) Yl covered 1 1 1] 0 0 [u]
0x4000204c st.l rl, (sp-%8) U] covered 1 1 1] 1] 1] a
0x40002050 at.l r2, (sp-%c) ¥l covered 1 1 [i] 4] 4] a
0x40002054 st.l r3, (sp-$10) ¥ covered 1 1 i) 4] 4] a il

4 T *

Figure 3-38. Statistics of Critical Code Data

The below table describes the fields of the statistics of the critical code data.

Table 3-9. Description of Statistics of Critical Code Data

Field Description
Line/Address Displays either the line number for each instruction in the
source code or the address for the assembly code.
Instruction Displays all the instructions executed in the selected function.
Coverage % For C source lines, displays the percentage of number of

assembly instructions executed from the total number of
assembly instructions corresponding to the source line. For
assembly source lines, it shows if the instructions were
executed or not.

Table continues on the next page...
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Table 3-9. Description of Statistics of Critical Code Data (continued)

Field

Description

ASM Decision Coverage

Displays the decision coverage computed for direct and
indirect conditional branches. It is the mean value of the
individual decision coverages. So if a function has two
conditional instructions, one with 100% and another with 50%
decision coverage, the decision coverage would be (100 +
50) /2 =75% . Itis calculated only for assembly instructions
and not for C source code.

ASM Count

Displays the number of times each instruction is executed.

Time (CPU Cycles)

Displays the total time taken by each instruction in the
function.

Chof Stalls

Displays the number of bubble cycles incurred by change of
program flow for each function.

Interlock Stalls

Displays the number of bubble cycles incurred by core
resource interlocks for each instruction in the function.

Memory Stalls

Displays the number of bubble cycles incurred by data bus
hold for each function.

Program Stalls

Displays the number of bubble cycles incurred by program
starvation for each function.

Rewind Stalls

Displays the number of bubble cycles incurred by a rewind on
the core buses for each function.

NOTE

In the Critical Code viewer, all functions in all files associated
with the project are displayed irrespective of coverage
percentage. However, the 0% coverage functions do not appear
in the Performance and Call Tree viewers because these
functions are not considered to be computed and are not a part

of caller-called pair.

Click on the column header to sort the critical code data by that column. However, you
can only sort the critical code data available on the top view. The icons available in the
statistics view of the Critical Code tab allow you to perform the following actions:

* Previous function - Lets you navigate to the previous function you selected in the

File/Function column.

* Next function - Lets you navigate to the next function in the File/Function column.

* Export - Lets you export the critical code data of both top and bottom views in a
CSV or HTML file.

* Configure Table - Lets you show and hide column(s) of the critical code data. Click
and select the Configure the table above option to show/hide columns of the top
view or the Configure the table below option to show/hide columns of the bottom
view. The Drag and drop to order columns dialog box appears in which you can
check/uncheck the checkboxes corresponding to the available columns to show/hide
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them in the Critical Code viewer. The option also allows you to set CPU frequency
and set time in cycles, milliseconds, microseconds, and nanoseconds.

* Collapse/Expand all files - Lets you collapse/expand all files in the Summary
Table.

* Filter files - Lets you filter the desired files to display in the Summary Table. Click
this button and select the desired files from the Choose files to be listed dialog.

» Switch to executable source line statistics/Switch to ASM instructions statistics -
Lets you display the executable source line statistics/ASM instructions statistics data
format in the Summary Table.

* Graphics - Lets you display the colored bars for the columns in the bottom view of
the critical code data. For example, click and select the Assembly > ASM Count,
option to display colored bars in the ASM Count. The colors in these columns
differentiate source code with the assembly code.

* Show code - Lets you display the assembly or mixed code in the statistics of the
critical code data. Click and select the Assembly option to display the assembly
code. Similarly, select the Source or the Mixed option to display the source or mixed
code in the statistical details.

3.5.1.3.1 Export Critical Code Data

You can export critical code statistical data into CSV or HTML file format.

To export the data, follow the given procedure:

ey

L.
Click the export button available on the Critical Code view.

The drop-down menu shows Export to CSV or Export to HTML option.

2. Select any one of the following option to export the statistical data in the respective
format:

* Export to CSV: Select the Export summary table statistics option to export
the details of the top view or the Export Details table statistics option to export
the details of the bottom view respectively.

* Export to HTML: Select Export as source option to export the data in function
details table that contains source code lines, Export as asm option to export the
data in function details table that contains address and assembly code of the
function, and Export as mixed option to export the data in function details table
that contains both addresses and line numbers of the instructions with their
corresponding source and assembly code.

The Export to dialog box appears.
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m
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Save as type: | *.html vl

~ Hide Folders | sae || cCancel |

Figure 3-39. Export To Dialog Box
3. Specify the File name and browse the location where you want to save the data.
4. Click Save.

The exported data will be saved in the respective format (.csv Or .htm1).
The data exported on the html page is structured in the given format:

* Files: Lists all the analyzed files

* File Analysis Content: Provides details on Function Coverage table, Each
function detail (including Details table, Code coverage metrics table, and ASM
decision metrics table), Summary table, and ASM decision coverage table of the
selected file.

NOTE
While reading the data from the html page, the content of
Function Details table suggests what option was selected
from Export to HTML menu (Export as source, asm or
mixed). For example, if the first column name of the
Function Details table is Line, the option selected is Export
as source. Similarly, if the first column name is Address,
then the option selected is Export as asm, and if the first
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column name is Line/Address then the option selected is

Export as mixed.

The screens given below shows the data structured in different tables:

Function coverage for sc3900_main.c

| Function | Covered %

| func2 | 100 %

| vector_dot product 16x16 | 100 %

| main | 62 %

Figure 3-40. Function Coverage Table
Source table for func2
Line Instruction Coverage

58 i covered
59 #pragma noinline
60
61 printf("Hello private text\n"); covered
62 return 0; covered
63 1 covered

Code coverage metrics for func2

ASM decision metrics table for func2

| Total ASM decisions |  Taken ASM decisions  Not taken ASM decisions | Both taken ASM decisions
| 0 | 0 | | 0
Figure 3-41. Function Details Table
Summary table for sc3900 main.c

Function Total ASM instructions Covered ASM instructions Coverage %

func2 6 6 100 %

vector_dot_product_16x16 284 284 100 %

main 50 31 62 %

Whole program 340 321 04.41 %

Figure 3-42. Summary Table
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ASM decision coverage table for sc3900_main.c

Figure 3-43. ASM Decision Coverage Table

3.5.1.4 Viewing Performance Data

To view performance data, click on the Performance hyperlink.

The Performance viewer appears as shown below.

18 =08
&3 Performance - Test_ B4860_Debug_B4860_Download_core00 - Test_B4860
Summary Table o0 | e~ G~ B | Metrics  ~ Cycles -
Functien Mame Num Calls Inclusive MinIn.. MaxIncl.. Awglncl.. Percen.. Exclusive MinEx.. MaxExcl.. AwvgExcl.. Percen.. Percent.. Code Size i
func? 1 4,161 4161 4161 4161 38.57 137 137 137 137 127 213 36
vector dot product 16:16 1 4,196 4196 4196 4,196 38.89 4,033 4,033 4,033 4,033 37.38 213 1434 L
main 1 10,788 10,789 10,789 10,789 100.00 205 205 205 205 1.90 213 356 i
FileWrite 3 3,661 585 3,661 1,220 3393 46 14 46 15 043 6.38 52
| printf 3 6,251 1,058 6,251 2,083 5794 205 26 205 68 1.90 638 100
memepy 3 267 47 267 a9 247 267 47 267 89 247 6.38 222
prep buffer 1 11 11 11 11 010 11 1 1 1 010 213 10
flush buffer 3 1303 7 1303 434 1208 138 39 138 a6 1.28 6.38 236
write console 3 1185 278 1,185 388 10.80 Er 21 Er 126 351 6.38 a4
lﬂ\ﬂ; 2 157 in 157 52 14R 157 in 157 52 14A AR N4 4
Details Table Search: 49
Caller Caller Callee MNum Calls ... Inclusi.. Minln.. MaxIncl.. Avglncl.. Percen.. Percen.. CallSite
func2 printf 1 4,024 4,024 4,024 4,024 6437 100 (080002...
main printf 1 1,058 1,058 1,058 1,058 1693 10 0x80002...
main printf 1 1169 1169 1169 1169 187 11.04 0x30002...
printf fwide 3 318 26 318 106 7871 5.26 0x8000e...
Callee printf _ pformatter 3 5728 1,006 5728 1,909 100 9474 0x8000¢...

The Performance viewer is divided into two views:

Figure 3-44. Performance Viewer

» The top view presents function performance data in the Summary table. It displays
the count and invocation information for each function that executes during the
measurement, enabling you to compare the relative data for various portions of your
target program. The information in the Summary table can be sorted by column in
ascending or descending order. Click the column header to sort the corresponding
data.
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The following table explains the fields of the Summary table.
Table 3-10. Field description of Summary

table
Field Description

Function Name Name of the function that has executed.

Num Calls Number of times the function has executed.

Inclusive Cumulative metric count during execution time spent
from function entry to exit.

Min Inclusive Minimum metric count during execution time spent
from function entry to exit.

Max Inclusive Maximum metric count during execution time spent
from function entry to exit.

Avg Inclusive Average metric count during execution time spent
from function entry to exit.

Percent Inclusive Percentage of total metric count spent from function
entry to exit.

Exclusive Cumulative metric count during execution time spent
within function.

Min Exclusive Minimum metric count during execution time spent
within function.

Max Exclusive Maximum metric count during execution time spent
within function.

Avg Exclusive Average metric count during execution time spent
within function.

Percent Exclusive Percentage of total metric count spent within
function.

Percent Total Calls Percentage of the calls to the function compared to
the total calls.

Code Size Number of bytes required by each function.

* The bottom view or the Details table presents call pair data for the function selected
in the Summary table. It displays call pair relationships for the selected function,
that is which function called the another function. Each function pair consists of a
caller and a callee. The percent caller and percent callee data is also displayed
graphically. The functions are represented in different colors in the pie chart, you can
move the mouse cursor over the color to see the corresponding function.

The below table describes the fields of the Details table. You cannot sort the
columns of this table.

Table 3-11. Field description of Details
table

Field Description

Caller Name of the calling function.

Table continues on the next page...
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Table 3-11. Field description of Details table

(continued)
Field Description

Callee Name of the function that is called by the calling
function.

Num Calls Number of times the caller called the callee.

Inclusive Cumulative metric count during execution time spent
from function entry to exit.

Min Inclusive Minimum metric count during execution time spent
from function entry to exit.

Max Inclusive Maximum metric count during execution time spent
from function entry to exit.

Avg Inclusive Average metric count during execution time spent
from function entry to exit.

Percent Callee Percent of total metric count during the time the
selected function is the caller of a specific callee.
The data is also shown in the Caller pie chart.

Percent Caller Percent of total metric count during the time the
selected function is the callee of a specific caller.
The data is also shown in the Callee pie chart.

Call Site Address from where the function was called.

The table below lists the buttons available in the Summary table of the Performance
viewer.

Table 3-12. Buttons Available in Summary Table of Performance Viewer

Name Button Description
Previous Function Lets you view the details of the previous function that was selected in
e the bottom view before the currently selected function. Click it to view
the details of the previous function.
Next Function Lets you view the details of the next function that was selected in the
- bottom view. NOTE: The Previous and Next buttons are contextual and

go to previous/next function according to the history of selections. So if
you select a single line in the view, these buttons will be disabled
because there is no history.

Export A Lets you export the performance data of both top and bottom views in a
=3 CSV file. Click the button and select the Export the statistics above
option to export the details of the top view or the Export the statistics
below option to export the details of the bottom view respectively.
Configure Table - Lets you show and hide column(s) of the performance data. Click the
button and select the Configure the table above option to show/hide

columns of the top view or the Configure the table below option to
show/hide columns of the bottom view. The Drag and drop to order
columns dialog box appears in which you can check/clear the
checkboxes corresponding to the available columns to show/hide them
in the Performance viewer. The Configuring Time Unit option allows
you to set CPU frequency and set time in cycles, milliseconds,

microseconds, and nanoseconds.

Table continues on the next page...
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Table 3-12. Buttons Available in Summary Table of Performance Viewer (continued)

Name Button Description

Exclude Symbols == Lets you exclude statistics libraries or symbols from the performance
data. Click this button to select/specify a function or library you want to
exclude from the performance data. After excluding the selected
function, library, or symbol, the statistics will be recomputed and
reloaded in the Performance data viewer. For details, see Exclude
Symbols from Statistics.

Choose view Metrics |- Lets you to switch between the data available in the Metrics view and

Statistics view of the summary table. Metrics view displays all available
performance statistics details for a specific metric; for example, a
Metrics view for Cycles metric displays all available performance
statistics details for metric Cycles. Statistics view displays all
performance metrics details for a specific statistic; for example, a
Statistics view for Inclusive statistic displays all available performance
metrics details for Inclusive statistic. NOTE: Performance details table is
available only for metrics view. The data in Details table is refreshed
when a user selects a new metric. NOTE: For Statistics view Configure
Columns for Details Table and Export Details table statistics options
are disabled.

Choose metric/statistic Lets you load and list the metrics name (Cycles) or statistics name
(Inclusive) in the summary table of the Performance data. The data
displayed in the Summary table will correspond to the selection made in

the Choose view and Choose metric/statistic fields.

Cycles -

By default, the data collected in the Performance data viewer is based on Cycle metric
and is displayed in the Metrics view. The below figure shows the Statistics view of the
Performance data viewer.

@ Test_Demo_Debug_B4860_Download_corel0 &3 =8

%3 Performance - Test Demo_Debug B4860_ Download_core00 - Test Demo

Summary Table | ey v &~ B | Statistics - Inclusi «

Function Name Mum Calls  Percent.. Code Size Cycles it
(AsmSection) 0x80010000 2 3.23 4780 2119
funcs 1 161 S 3,925
vector dot product 16:16 1 1681 1434 4192
main 1 161 356 10,573

FileWrite 3 484 52 3441 £
printf 3 484 100 6,024
memecpy 3 484 222 357
close all 1 161 196 1,260
prep buffer 1 161 0 12
flush buffer 5 8.06 236 1,363
write console 3 454 a4 1170
close console 3 484 8 102
felose 3 4,54 516 1134
udiv32 3 4,84 204 155
exit 1 161 164 1,768
ExitProcess 1 161 36 6

Figure 3-45. Performance Viewer - Statistics View
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3.5.1.5 Viewing Call Tree Data

To view the call tree data, click the Call Tree link.
The Call Tree viewer appears as shown below.

E Test_Simulator_Debug_5C3900_Download_corel0 &3 =0
#= Call Tree - Test_Simulator_Debug_SC3900 Download_core00 - Test_Simulator

Function Name Num Calls % Total calls of parent % Total times it was called  Inclusive Time (Cycles; 50.0 MHz)
1 100.00 100.00 652

1 25.00 33.33 3,043
1 33.33 100.00 0

Figure 3-46. Call Tree Viewer

In the Call Tree viewer, START is the root of the tree. You can click on "+" to expand
the tree and "-" to collapse the tree. It shows the biggest depth for stack utilization in Call
Tree and the functions on this call path are displayed in green color. The Call Tree nodes
are synchronized with the source code. You can double-click on the node to view the
source code. The columns are movable; you can move the columns to the left or right of
another column depending on your requirements by dragging and dropping.

The following table describe the fields of Call Tree data.
Table 3-13. Call Tree Table

Field Description
Function Name Name of function that has executed.
Num Calls Number of times function has executed.
% Total calls of Parent Percent of number of function calls from total number of calls
in the application.
% Total times it was called Percent of number of times a function was called.
Inclusive Time Cumulative count during execution time spent from function

entry to exit.

You can set CPU frequency and Inclusive Time displayed in the Call Tree viewer in
cycles, milliseconds, microseconds, and nanoseconds. Click Configure Table to
configure time unit and set CPU frequency. For details, refer to the Configuring Time
Unit and Time Format topic.
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The table below lists the toolbar buttons available in the Call Tree view.

Table 3-14. Toolbar Buttons Available in Call Tree View

Name Button Description

Configure Table Lets you to set CPU frequency and set time in cycles, milliseconds,

1

i

microseconds, and nanoseconds using the Configuring Time Unit
option.
Export to dot Lets you export the call tree data to . dot file. Click this button to open
e the Export to dot dialog and save the data as . dot file in the desired
location.
Exclude Symbols = Lets you exclude statistics libraries or symbols from the performance

data. Click this button to select/specify a function or library you want to
exclude from the call tree data. After excluding the selected function,
library, or symbol, the statistics will be recomputed and reloaded in the
Call Tree data viewer. For details, see Exclude Symbols from Statistics.

3.5.1.6 Viewing Counterpoints

To view Counterpoints information, click on the Counterpoints hyperlink.

Counterpoints allow you to count events between two points of the executed code. The
results are computed based on the collected trace data; the counterpoints are searched in
trace by their addresses. For information on counterpoints, refer to the Viewing
Counterpoints in Analysispoints topic.

3.5.2 Viewing Data Generated by Hardware

This section describes how to view trace data for a hardware project.

In the Basic subtab of Trace and Profile tab of Debug window, the following viewers
are available in the Software Analysis view:

* If you have selected either Program Trace or Coverage scenarios, only Trace and
Critical Code viewers are displayed.

* If you have selected any profiling trace scenario, Trace, Performance, Timeline,
Critical Code, and Call Tree viewers are displayed.

* If you have selected User defined events or/and Ownership (used with None
scenario), only Trace viewer is displayed.

* Log and Counterpoints viewers are displayed with any combination of trace
scenarios.
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The following data can be viewed:

Each default trace scenario has a specific bandwidth. This indicates how many messages
* Viewing Trace Data

|
viewing Data
Also, a note has been added in Basic tab of Trace and Profile that informs you about the
kind of trace that will be collected with the chosen configuration. In case Profiling-
advanced scenario is selected, you will have to customize the configuration in Advanced
tab. In case User defined events option is selected, the events can be generated by
writing TMDAT and TMTAG core registers.
selected to collect trace.

Viewing Timeline Data

Viewing Critical Code Data
Viewing Performance Data

are routed in trace stream (on hardware), it depends on the trace scenario that you have
Viewing Counterpoints

3.5.2.1 Viewing Trace Data

Legend:

Click the Trace link to view the trace data.

Trace - Test_HW_Debug_B4860_Download_core0 - Test_HW I = e |
. Call/Branch 4| . | Triad A(Instruction fetching ... ‘l Triad B(Instruction fetching : Pr... 4‘
Offset | Event S... Description Type Timesta...
Source Target | Pragrarm. .. ‘ Program... | Program... |L2 Progr... ‘ L2 Progr... | L2 Pragram... ‘
1-1 SoC Device id = 0x0192001d (B4) Info a
a1 core_0 Debug status = 0x0. Core entered in Execution state, Source Info 0
is PCL.
10-1 core_0 Function main, Source address = 0x40002600, main Function Call 143 6 1] 1
16-1 core_0 Function funcZ. Source address = 0x4000200a. funcz Function Call 262 (3 4 2
2z-1 core_1 Function printf. Source address = 0x4000c753, printF Function Call 396 6 & 3
25-1 core_0 Function Fuide. Source address = Ox4000d206. Fuide Inkerrupk 575 15 7 3
34-1 ore 0 Debug s_tatus = D_xSDDUUDUU. Core entered DEBLUG made. Info 1,382
Reason is executing a debug core instruction.
. .
Figure 3-47. Trace Viewer

Trace Scenario

cache events

o oo o

Table 3-15. Counter Values for each Trace Scenario
Traid A

Counter 0

Total L2

demand

Counter 1
L2 program
accesses

accesses

Counter 2

The below table explains the values of each counter for each trace scenario.
Profiling - L2 L2 data

Counter 0
Total L2 hit

accesses

78

Traid B
Counter 1

L2 instruction
miss

Table continues on the next page...

Counter 2
L2 data miss
CodeWarrior Development Studio for StarCore SC3900FP DSP Architectures Tracing and Analysis Tools

User Guide, Rev. 10.9.0, 11/2015

Freescale Semiconductor, Inc.



g |

Chapter 3 Collecting Data

Table 3-15. Counter Values for each Trace Scenario (continued)

Trace Scenario

Traid A

Traid B

Counter 0

Counter 1

Counter 2

Counter 0

Counter 1

Counter 2

Profiling - data
loads

Data access L1
hits

Data access L1
pre-fetch hits

Data access L1
miss

L2 Data access
hits

L2 Data access
hits

L2 Data access
miss

Profiling - clock
cycles

Application
cycles

Inactive counter

Bubbles

Inactive counter

Inactive counter

Inactive counter

The following table explains fields of trace data.

Table 3-16. Trace Data - Description of Fields

Field

Description

Offset

First number represents trace message offset in raw trace file.
Second number represents trace event index. One trace
message can generate one or more trace events.

Event Source

Displays source of trace event

Description Displays description of trace event
Call/Branch

Source Displays source function of trace event
Target Displays target function of trace event
Type Displays type of trace event

Timestamp (Cycles)

Displays the absolute clock cycles that the instruction takes to
execute

Traid A

Total L2 demand accesses

Displays number of events counted by counter 0O of triad A

L2 program accesses

Displays number of events counted by counter 1 of triad A

L2 data accesses

Displays number of events counted by counter 2 of triad A

Triad B

Total L2 hit

Displays number of events counted by counter 0 of triad B

L2 instruction miss

Displays number of events counted by counter 1 of triad B.

L2 data miss

Displays number of events counted by counter 0 of triad B.

For more information on trace data, refer to the Viewing Trace Data topic.

3.5.2.2 Viewing Timeline Data

For information on Timeline data, refer to the Viewing Timeline Data topic.
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3.5.2.3 Viewing Critical Code Data

For information on Critical Code data, refer to the Viewing Critical Code Data topic.

3.5.2.4 Viewing Performance Data

For information on Performance data, refer to the Viewing Performance Data topic.

3.5.2.5 Viewing Counterpoints

For information on counterpoints, refer to the Viewing Counterpoints in Analysispoints
topic.

3.6 Exclude Symbols from Statistics

Exclude symbols feature allows you to configure the statistics before or after the data is
processed.

The configure results dialog is available from:

* Software Analysis View
e Critical Code View

e Performance View

e Call Tree View

3.6.1 Software Analysis View

In Software Analysis view, the column Config Results provides a hyperlink to the result
configuration view.

The configuration is saved in a .syn file inside the Analysis Data folder available at the
project folder. Perform the following steps to configure the statistics before computing
the results:
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1. From the menu bar, select Window > Show View > Other > Software Analysis >
Software Analysis to open the Software Analysis view.
2. After collecting the data, the data file will be listed in the Software Analysis view.
The exclude symbols option will be available for each set of results.
@& Software Analysis £3
Software Analysis
Mame
& SIM

1= proj-siml_Debug_5C3300_Downle

Trace Timeline Critical Code
%=} proj-siml_Debug_SC3900_ = Trace [o* Timeline
O

Performance

Call Tree

QD(h

=
Config Results  Counter Points
Critical Code @ Performance E Call Tree i Configure
I

Last Mot

Figure 3-48. Software Analysis View
3. Click the Configure hyperlink available under the Config Results column.
The Exclude symbols dialog appears.

B Counterpoints 2015111
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e 1

¥ Configure results = @

{ Exclude symbols || Miscellaneous settings

Filter symbal:

Available items: Selected items:

cpp_rtlib_be-r_x.elb

cpp_rtlib_be_x.elb

cpp_rtlib_Os_be-r_x.elb

cpp_rtlib_Os_be_x.elb

hostio_be-r_x.elb Add

hostio_be_x.elb

hostio_Os_be-r_x.elb
hostio_Cs_be_x.elb
rtlib_be-r_x.elb

rtlib_be_x.elb
rtlib_Os_be-r_x.elb

rtlib_Os_be_x.elb

Add custom item

@:‘ [ QK ] ’ Cancel

Figure 3-49. Exclude Symbols Dialog Box
4. Select the libraries from the Available items list.
5. Click Add.

The selected libraries now appear under the Selected items list.
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P =)

¥ Configure results | = '@

Exclude symbols | Miscellaneous settings

Filter syrmbol:

Available items: Selected items:

cpp_rtlib_be-r_x.elb
cpp_rtlib_be_x.elb
cpp_rtlib_Os_be-r_x.elb

cpp_rtlib_be_x.elb
cpp_rtlib_be-r_x.elb
cpp_rtlib_Os_be-r_x.elb

cpp_rtlib_Os_be x.elb

hostio_be-r_x.elb

hostio_be_x.elb

hostio_Os_be-r_x.elb
hostio_Os_be_x.elb
rtlib_be-r_x.elb

rtlib_be_x.elb
rtlib_Os_be-r_x.elb

rtlib_Os_be_x.elb

Add custom item

@:‘ ’ QK ] [ Cancel

Figure 3-50. Exclude Symbols Dialog Box
6. Click OK.
The configuration is saved with the list of all symbols and libraries that needs to be
excluded from statistics.

NOTE
If the result configurator is opened for a new project, the
latest saved configuration will be loaded into tables as a
default configuration. If the configurator is not used, the
results will be computed with all libraries and symbols.
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You can also perform the following actions using Exclude symbols dialog:

Table 3-17. Exclude Symbols Options

Options Description

Filter symbol Acts as a real time filter that allows to search a symbol in a
library from Available items list. The Available items list
shows all the libraries that contain symbols with the same
name available in the Filter symbol field.

Add custom item Allows to add a customized symbol or an entire library under
the Available items list.

Export item list to a file Exports the configuration in a file. The file is saved in the
Analysis Results folder of the current project location.

Import item list from file Loads an existing configuration.

When scrolling through unprocessed data in the Trace viewer, the timestamp values and
profiling counters values increases from the beginning of the trace, and at some point of
time, the value gets reset. Also, the timestamp value does not increase beyond 16 million
(approximately) and the profiling counters values beyond 256.000 (approximately).You
can use the Configure results dialog to control the overflow of counters in the Trace
viewer. Click the Miscellaneous settings tab, and select the Enable accurate timestamp
and profiling counters values for partially decoded trace checkbox to enable the
feature for handling timestamp overflow. When this checkbox is selected, the timestamps
value count indefinitely, that is the values will not drop or reset while navigating through
unprocessed data in the Trace viewer. If not selected, the behavior remains unchanged
and the counters (timestamp and profiling) value increases till their maximum values and
reset at some point.

Configure results has been enriched with the possibility to not store decoded trace while
processing trace data for profiling viewers: Timeline, Critical Code, Performance, Call
Tree and Counterpoints. By default processing trace data for these viewers is done with
storing decoded trace. Processing trace data without storing decoded trace for profiling
viewers is quicker than processing trace data with storing decoded trace, impact of
storing or not decoded trace can be noticed for higher size of raw trace and executable.
Select Do not store decoded trace option to disable storing of decoded trace.
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¥ Configure results = @

| Exclude symbols || Miscellaneous settings :

[] Enable accurate timestamp and profiling counters values for partially decoded trace

[] Do not store decoded trace

@ [ ok |[ concel |

Ly

Figure 3-51. Configure results dialog - Miscellaneous settings tab

3.6.2 Critical Code View

In Critical Code view, use the Exclude symbols icon to view the Exclude symbols dialog
box.

Perform the following steps to view the configured statistics in Critical Code view:
1. Click the Exclude symbols icon available on the toolbar.
The Exclude symbols dialog appears.

2. Select the existing configuration or modify the configuration by adding or deleting
the libraries or symbols from the Selected items list.
3. Click OK.

The configuration is applied on the Critical Code data. The old statistics will be
deleted and the new statistics will be computed based on the configuration, and
viewer will be repopulated with the new results.

Once the data is computed as per the statistics, the respective view will display the
filtered data. The following figure shows an example that the func2 symbol is excluded
from the computed data:
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proj-siml_Debug_SC3900_Download_cored0 flatprofiler &5 = O
Critical Code - proj-siml_Debug_SC3900_Download_core00
SCPACC
Summary Table L ] | g -BRYT S
File/Function Address  Cowvered ASM %2 Mot Covered A, Total ASM ... ASM Decisi... Tirme nd
Unknown Context L
5c3900_main.c MN/A 94.41 % 5.59 % 340 58.33 % 3,580
func2 080001000 100.00 % 0.00 % 6 0.00 % 22
main (8000150 62.00 % 38.00 % 50 50,00 % 89
vector_dot_product_16:16  0x80001040 100.00 % 0.00 % 284 62.50 % 3,469
abort_exit.c MN/A T76.47 % 23.53 % 17 50.00 % 39
exit (8000 cad0 T76.47 % 2353 % 17 50.00 % 39
alloc.c MN/A 0.00 % 100,00 % 4 0.00 % ]
free (80006000 0.00 % 10000 % 4 0.00 % 0 A
< e . _..Hnl, an [E——. wan R
Details Table Search: P | Wl - QJ A
Line / Addr... Instruction Coverage ASM Decision ... ASM Count  Time Chis
58 { ¥ covered 1 1 p L4
0x230001 adda.lin #50,s5p,20 \Zl covered 1 1 1 A
4 = . . 1 | - 3

Figure 3-52. Critical Code View

3.6.3 Performance View
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In Performance view, click the Exclude symbols icon available on the toolbar to filter
out the symbols from the summary view table.

If the filtered symbol is called from another non filtered functions they will appear grayed
in details table, in caller-callee pairs.

@ Test_Demo_Debug_B4860_Download_cored0 & =4

%} Performance - Test Demo_Debug B42860 Download core00 - Test Demo

Summary Table 4] | ed v G v B | Metrics  « Cycles -
Function Name MNum Calls  Inclusive  MinlIn.. MaxIncl.. Avglncl.. Percen.. Exclusive MinEx.. MaxExcl.. AvgExcl.. Percen.. Percent.. CodeSize it
(AsmSection) 080010000 2 351 223 4,677 223 281 128 128 123 125 1.03 3.23 4,780
func2 1 538 134 538 538 431 134 134 134 134 1.07 1561 36
vector dot product 16:16 1 4192 4192 4192 4192 3362 4,031 4,031 4,031 4031 3233 1.61 1,434 E
main 1 5,495 4,549 5,495 5,495 44.07 223 223 273 223 1.79 1.61 356
udiv32 3 155 10 155 51 1.24 155 10 155 51 1.24 4.54 204 B
rem32 1 161 161 161 161 1.29 161 161 161 161 1.29 161 138
(AsmSection) 0x80013130 3 791 258 791 263 6.34 791 258 791 263 6.34 4.84 22 &2
Details Table Search: ;‘-
Caller Caller Callee Num Calls... Inclusi. Minln.. MaxIncl.. Avglncl.. Percen.. Percen.. CallSite
(AsmSection)_0x80010000 main 1 223 223 4,549 223 4.06 100 0x80010...
main func2 1 538 134 538 538 100 10.2 0:80002...
main vector_dot_product_16:16 1 4,192 4,192 4,192 4192 100 73.51 0:80002...
main printf 1 268 268 268 268 2833 5.08 0;
main printf 1 274 274 274 274 2896 5.2 0

Callee

Figure 3-53. Performance View

3.6.4 Call Tree View

In the Call Tree view, click the Exclude symbols icon to filter out the symbols or
libraries.

Filtered symbols would appear as grayed in the tree hierarchy.
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ETst_SimuI.ator_Debug_SCSQOO_Dawnl.uad_cmem &3 =0

#= Call Tree - Test_Simulator_Debug_SC3900_Download_core00 - Test_Simulator
T v oo

Function Mame MNum Calls % Total calls of parent % Total times it was called  Inclusive Time (Cycles; 50.0 MHz)

E <> I
-:F [SsmEection) OxEl a-j:-j:-j:_
o

a :F func2
T
a :F wvector_dot_product_16x16
:F __nonopt_cw_assert
:F __rem32
:F __nonopt_cw_assert
s :F printf
s :F printf

s :F exit

100.00 100.00 652
25.00 33.33 3,043
100.00 33.33 3,043
50.00 33.33 2,849
33.33 50.00 [v)
33.33 50.00 [v)
33.33 100.00 39
33.33 50.00 [v)
50.00 33.33 2,849
50.00 33.33 2,849
33.33 100.00 [v)

Figure 3-54. Call Tree View
NOTE

Applying the configuration in a result viewer (critical code,
performance or call tree) will reload the new recomputed results
in all opened corresponding viewers.

3.7 Trace on Attach

Use trace on attach feature to help within a debug session of type Attach.
Following are the two main cases where this feature is useful:

* On Application Crash Investigation
* On Changing Trace Configuration

3.7.1 On Application Crash Investigation

Trace on attach launch configuration feature is a very handful way of investigating
application crashes as it provides the retrieving of trace buffer that contains information
on the context of the crash.

To perform this; enable the trace (program trace or profiling trace) and configure the
trace buffer in overwrite mode in the moment of crash. For more information on
configuring trace buffer, refer Hardware Profiling.

NOTE
Trace buffer can be configured in three different modes:
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Overwrite: It provides trace just before the application crashes.
It is considered as the most recommended mode of configuring
trace buffer while investigating an application crash.

One buffer: It provides trace from the first time filled trace
buffer and usually trace buffer gets filled before crash. It is
recommended to use one buffer mode only if size of trace until
the application reaches crash is small enough to fit in trace
buffer or if trace buffer size is increased so that trace until
application reaches crash fits into it.

Continuous: It is not recommended to configure trace buffer in
continuous mode because in this mode every time trace buffer
gets filled; core enters into a freeze state and waits for the trace
buffer to be filled out. So if trace buffer is configured in
continuous mode application will not reach crash section as
core will be freeze waiting for trace buffer to be filled out.

Perform the following steps to investigate application crash using trace on attach feature:

* Create an Attach Launch Configuration
* Upload Trace
* Investigate Crash

3.7.1.1 Create an Attach Launch Configuration

Follow the steps given below to create an attach launch configuration:

1.

(O8]

In the CodeWarrior Projects view, right-click on the project that was crashed and
select Debug as >Debug Configurations option from the context menu.

In the Debug window, select CodeWarrior configuration and select New from the
context menu.

On the Main page, select Attach as the Debug session type.

Specify the project name that crashed in the Project field. If the application is not
displayed in the C/C++ Application field, click Search Project to select the
application image.

Click Debug.

NOTE
By default, the Trace control settings will be set on
Manually (Using trace buttons from Trace
Commander) option while using the Attach mode
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configuration. Hence, the trace collection will not start
automatically. To enable the trace collection, use the trace
control button in the Trace Commander view.

3.7.1.2 Upload Trace

Click on the Upload Trace=£| button available in the Trace Commander view to retrieve
the trace buffer from target hardware to host machine.

The Upload Trace button gets enabled every time whenever the Trace collection is ON,
therefore the trace can be uploaded even when trace has already been collected at a
suspend state (when debug session is not in the attach mode). Following are the effects
while uploading trace data after trace has already been collected:

1. If the trace buffer is configured in One buffer mode or Overwrite mode and the
upload trace button is hit to upload the trace data then the already collected trace data
will be removed. The trace buffer will be read once again and trace data should look
same as before hitting the upload trace button.

2. If trace buffer is configured in Continuous mode and upload trace button is hit then
the trace data already collected is removed, the trace buffer will be read once again
and the trace will become empty (reset the trace buffer in the continuous mode to
unfreeze the core).

3.7.1.3 Investigate Crash

Inspect trace in Trace viewer towards its end.

The following figure displays the trace data in Trace viewer when an application crashes
and when trace mode has been set to Program trace. For more information on how trace
mode can be set to Program trace or Profiling trace, refer Hardware Profiling.
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Legend: . .
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= Trace - hw_Debug_B4860_Download_core0 - hw

Index
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Event 5... |
16375-10

=C
Description
core 0

M 4 F B P oy G
16375-11

core 0

16375-12

Call/Branch
Return from work to doThislob. Source address =

0:40002162. Target address = (400021 e2.

core_0

Branch from doThislob to doThislob. Source address =
16375-13

4
Type
Source | Target L
wiork doThislob
0000221 c. Target address = 0x400021d4.
Call frem doThislob to work. Source address =
0:400021dc. Target address = 040002140,

core 0

Timestamp
Function

Return
16375-14

doThislob

doThislob
core_0

0,841 714
Return from work te doThislob. Source address =

Branch 8.841,714
doThislob work Function Call
work
0:40002162, Target address = 0x400021e2,
16375-15

doThislob

core_0

Branch from doThislob to doThislob. Source address =
16375-16

0:4000221c., Target address = 0:x400021d4.

Call from doThislob to work. Source address =

0:400021dc. Target address = (40002140,
core 0

9841714
Function

Return
16375-17

9841714
doThislob doThisJob
core_0

Return from work to doThislob. Source address =
16375-18

Branch 9.841,714
doThislob work Function Call
0x40002162. Target address = 0x400021e2. work

doThislob

core_

Branch from doThislob to doThisleb. Source address =
16375-19

0:c000221 ¢, Target address = 0x400021d4.

Call from doThislob to work. Source address =

0:400021dc. Target address = 040002140,
core 0

9,841,714
Function

Return
16375-20

doThislob doThislob
core_0

0,841 714
Return from work te doThislob. Source address =

0:40002162, Target address = 0x400021e2,

Branch
doThislob

9,841,714
work Function Call
work

9,841,714
. Function
doThislob Return
doThislob
16379-1 core 0

Call from doThislob to crashFunc. Source address =
0:40002222, Target address = (40002180,

9841714
crashFunc | Function Call 9.841,714
Branch from (AsmSection)_0x40007140 to

Target address = 0:400048 0.
] Function (AsmSection)_0x40004000, address =
16379-2 core 0 0x4000494c.
16379-3 core_0
16381-1

(AsmSection)_0x40004000. Source address = 0x400071c0. (AsmSection

o [AsmSection Branch 8842 237
(AsmSection Linear
Entry into idle mode
core 0 Debug status = 080000000, Core entered DEBUG mode.
- Reason is executing a debug core instruction.

9,842 237
Info

9,842,237

0,842,238
The following figure shows the trace data in Trace viewer when an application crashes
and when trace mode has been set to profiling trace.

+ [

Info
Figure 3-55. Cash Investigation in Trace Viewer using Program Trace
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Legend:
Index| Event S... ‘ Description Call/Branch ! Type Timesta...
Source | Target
16309-1 core_( Function doThis)ob. Source address = 0400021 dc. doThislob Function Call 60,172,986
163131 core0 Function work. Source address = 0:40002162. work Ei:::;”” 60,173,003
16317-1 core 0 Function doThis)ob. Source address = 0400021 dc. daThislob Function Call 60,173,031
163211 core0 Function work. Source address = 0x40002162. work g:::rt;”” 60,173,048
16325-1 core 0 Function doThis)ob. Source address = 0:400021dc. doThislob Function Call 60,173,076
163291 core Function work. Source address = 0x40002162, work E:::f;”” 60,173,003
16333-1 core_ Function doThislob. Source address = 000021 dc. doThislob Function Call 60,173,121
163371 core0 Function work. Source address = 0:40002162. work Ei:::;”” 60,173,138
16341-1 core_) Function doThislob. Source address = 000021 de. doThislob Function Call 60,173,166
163451 core 0 Function work. Source address = 0:40002162. work Eg‘;:;”” 60,173,183
16349-1 core 0 Function doThis)ob. Source address = 0400021 dc. daThislob Function Call 60,173,211
163531 core0 Function work. Source address = 0:40002162. work Ei:::;”” 60,173,228
16357-1 core 0 Function doThis)ob. Source address = 0400021 dc. doThislob Function Call 60,173,256
16361-1  cored Function work. Source address = 0x40002162, work E:::f;”” 60,173,273
16365-1 core 0 Function doThis)ob. Source address = 0:400021dc. doThislob Function Call 60,173,301
16369-1  core 0 Function work. Source address = 040002162, work Eﬁ‘::;”” 60,173,318
16373-1 core_) Function doThislob. Source address = 0x40002222. doThislob Function Call 60173346
16377-1 core 0 Function crashFunc. Source address = 0x400021%9¢. crashFunc Interrupt 50,173,364

Figure 3-56. Cash Investigation in Trace Viewer using Profiling Trace

Tip
Exceptions can be easily recognized in Trace viewer by their
orange color.

3.7.2 On Changing Trace Configuration

Trace on attach feature can also be used to change trace configuration on board when a
process is already running on it.
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For instance you can attach to the running process and enable trace if it was not enabled
before or you can change from program trace to profiling trace. To change the trace
configuration using trace on attach feature, perform the following steps:

 Create an Attach Launch Configuration
* Change Trace Configuration

3.7.2.1 Create an Attach Launch Configuration

To create an Attach launch configuration, refer Create an Attach Launch Configuration.

3.7.2.2 Change Trace Configuration

Perform the following steps after creating the attach launch configuration:

1. Suspend the debug session to configure trace.

2. Click Configure Trace =~

Trace Commander view.

icon available under the Trace configure column in the

The Configure Trace dialog box appears.

3. Select Program trace option from the Trace scenarios list.
4. Click OK.

The new configuration gets applied on the target when debug session is resumed.

3.8 Viewing Interrupts

The interrupts in an application flow can be easily recognized in Trace viewer with their
'Orange’ color and their Type flag.

The following figure shows an example on how interrupts are displayed for Program
trace in Trace viewer:
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viewing Interrupts

(B intvecasm [ [ mainc | [S) startup_startup b48 | [c] b4860_main.c | [] test1793475539665813 | [] swandemo_SC_B4:
£ Trace - swandemo_SC_B4860_Debug_B4860_Download_core0 - swandemo_SC_B4860

Legend: E‘ E‘ A

e Call/Branch 4 .
Index| Event S... Descrniption Type Timesta...
Source | Target
Branch from initTimer to initTimer. Source address = . .
22-1 core 0 0x4000292c. Target add = 0x40002936. initTimer initTimer Branch 1,710
Return from initTimer to main. Source address = P— : Function
2:2 | cored 40002042, Target address = 040003000, nkTimer MAN - peturn I
251 core 0 Call from main to entry. Source address = 0x40003000. e - Function Call 1,949

Target address = 0x40002f40.

Call from entry to interrupt. Source address =
core 0 0,40002f54. Target address = 0x40002ec0). il e

Call frem (AsmSection)_0x40008140 to traplHandler.

28-1 core_0 Source address = 0x40008180. Target address = (AsmSection... traplHandler  Function Call
0x40002180.
28-2 core 0 Call from traplHandler to ___QCbdSave. Source address traplHandler __ QCbdS Function Call 2375

= (h4000218c. Target address = (x40004120.

Return from __QCbdSave to traplHandler. Source
address = (400041 ¢6. Target address = 0xd0002120.

Call from traplHandler to __ QCbdRestore. Source -
28-4 core 0 address = 0x4000210. Target address = 0x400041€0. traplHandler __QCbdRest... Function Call 2,375

Function 2375

28-3 core 0 Return

—QCtdSave traplHandler

Return from __QCtdRestore to traplHandler. Source Function 2375

283 core 0 address = 0x4000427e. Target address = 0x400021 6. —QCudRest... traplHandler Return
Return from traplHandler to interrupt. Source address = Function
B8 coreD  400021ae. Target address = 0x40002¢c8. topliandler| intenupt o LIS

Figure 3-57. Program Trace Interrupts Displayed in Trace Viewer

The below figure shows an example on how interrupts are displayed for Profiling trace in
Trace viewer:

[8 intvec.asm [€) main.c startup_startup_bd8 | TE file_jo.c [€ b4860_main.c [1) test1793475530665813 | [] swandemo_SC_B4860438
% Trace - swandemo_SC_B4860_Debug_B4860_Download_core0 - swandemo_SC_B4860
Legend: I:‘ I:‘ A
| 4 Tri - interrupts : i 4 -
Off...| Event S... Description 2lBeanch: Type Timesta... I E i ‘:‘(core .e.vent_s te = Ex_t:e_p_uon_s 1)
Source | Target | Trap instructi... | Critical interru... | Non-critical interrupts
2069-1 core 0 Function Performancel. Source address = 0:d0002adc. Performancel Function Call 12,709 1 10 0
20731 core 0 Function __Qdiv32_s. Source address = 040003164,  _ Qdi32s ;‘;t“::f" 12,735 1 10 0
2077-1 core 0 Function Performancel. Source address = (:d0002adc. Performancel Function Call 12,787 1 10 0
0811 core® | Function __Qdiv32_s. Source address = 04000310, __Qd32s function 12813 1 10 0
20891 core 0 F“"“"‘"_“:’"""'""“"'""‘" SIS coretimerlrg.. Function Call 12,856 1
0931 cored Function __QCbdSave, Source address = 0:400041c6.  __ QCtdSave ;‘;‘u‘:“’“ 12882 1 1 0
2097-1 core 0 mﬁorunmmnd]m Source address = coretimerlrg... Function Call 12,885 il 1 0
2101-1 core 0 Function getEid. Source address = (40002028, getEid Functien Call 12838 1 11 0 |
2051 core Function getfidrReg. Source address = 0x40002004. getFidrReg m"" 12,890 1 1 0
2091 cored Function getEid. Source address = 0x40002046. getEid ;‘;":"::’“ 12,905 1 1 0
31| corep Funchion coreimerkgHander, Source address = coretimerlrq... Function Call 12,907 1 1 0

Figure 3-58. Profiling Trace Interrupts Displayed in Trace Viewer
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3.9 Preparing Aurora Interface for Collecting Aurora Nexus
Trace

This topic describes how to prepare Aurora interface to extract Nexus trace from the
Aurora port (for processors that support Aurora) using a Gigabit tap with Aurora
daughter card.

If you want to collect Nexus trace from the target using Aurora, you need to first prepare
the Aurora interface to be used by the trace probe. A TCL script or the Aurora training
script is used to train Aurora on the target. This topic contains the following sub-topics:

e Enabling Aurora
» Executing Aurora Training Script

3.9.1 Enabling Aurora

You can enable Aurora on B4860QDS board using Reset Configuration Word (RCW).
For B4860QDS boards, Aurora lanes need to be properly routed to Aurora connector on
the board. This is done automatically from u-boot, when a RCW with Aurora enabled is
detected.

When Aurora is enabled, the Aurora interface needs to be trained so that it can run
properly.

3.9.2 Executing Aurora Training Script

The Aurora training script should be executed before configuring or extracting trace
through the Aurora port. You can execute the training script to train Aurora on B4860
targets as follows.

For B4860QDS target, the TCL script that is used to train Aurora on the target is
available in the CodeWarrior installation folder at:

SC/StarCore_Support/Initialization Files/Aurora/train_aurora_b4.tcl

The routine inside this file which executes the required training is called train_aurora.
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To train Aurora on the B4860QDS target:

1. Ensure that the RCW on board is having Aurora enabled on SERDES#1 and the
speed is set to 2.5 Gbps. You can modify RCW fields for different SERDES protocol
values to have Aurora enabled, for example:

* For bits 128-134 in RCW, configure Serdes#1 protocol. Make sure that protocol
selected is 0x30. It will enable 2 Aurora lanes.

 For bit 176 in RCW, configure Aurora divisor. Make sure this bit has value 1, so
that Aurora operates at 2.5Gbps.

You can write a new RCW to target using the CodeWarrior Flash Programmer
utility.

2. Execute u-boot. A proper u-boot detects that Aurora is enabled in RCW and
initializes cross-points for routing Aurora signals to Aurora connector. If you do not
have an u-boot or you have an u-boot without Aurora routing support, you can write
it using Flash programmer from CodeWarrior.

NOTE
For more information on writing u-boot using Flash
programmer, refer to CodeWarrior Common Features
Gmdepdfm the folder: <CWInstallDir>\SC\Help\PDF, where
<cwInstallpirs 18 the directory where CodeWarrior for
StarCore V10.x is installed.

3. Run the TCL script from the CCS console window or the Debugger Shell window.
e From the CCS console window:
1. Make sure you have a proper Command Converter started and configured.
2. In COHSOIG, type: source {$path}/train_aurora_b4.tcl, where $path 1s a valid
system path to the TCL script.
3. In console, type: train_aurora to call the training procedure.
4. Look for a confirmation message that Aurora interface was successfully
trained. If it was not successfully trained, repeat step c.
* From the Debugger Shell window:
1. In shell, type: source {$path}/train_aurora_b4.tcl, where $path is a valid system
path to the TCL script.
2. In shell: train_aurora_abg to call the training procedure.
3. Look for a confirmation message that Aurora interface was successfully
trained. If it was not successfully trained, repeat step b.

NOTE
A target reset after u-boot initialization for Aurora
will result into a link down. This means that
Aurora interface cannot be used anymore. If you
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use CodeWarrior for downloading the projects on
the target, make sure you have unchecked the
option to reset the target. If you need to reset the
target, ensure after reset that u-boot has a chance to
run and initialize routing signals for using Aurora
(estimated time is 10 seconds). You can use an
initialization script that can handle a target already
initialized by u-boot.

NOTE
If you see HBDP errors in the collected trace, it is
useful to run train_aurora_dbg in the Debugger
Shell window. This helps in eliminating most of
the HBDP errors from trace.

3.10 Inline Functions

Inline functions are used to optimize the source code. It is typically used for functions
that execute frequently.

Perform the following steps to add inline function:

1. Create a Stationary project for SC3900 PACC.

2. Add inline function in source file, sc3900_main.c. The following example is taken: int
inline func(int i) {#pragma inline;i++;1i+=200;return i;}

3. Select the project and right-click on it. From the context menu, select Properties.

The Properties dialog box appears. Select C/C++ Build -> Settings -> Starcore

3900 C/C++ Linker Application -> Linker Settings. Uncheck Strip Dead Code

checkbox.

Build the project.

Open Debug Configurations dialog box and check Enable Trace and Profile

checkbox in the Trace and Profile tab.

Click Apply and debug the application.

Resume debug session and then suspend the debug session after sometime.

8. To open Software Analysis view, click Windows -> Show View -> Software
Analysis.

9. Check for inline function in the Trace, Timeline, Critical Code, Performance, Call
Tree viewers.

i

—
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NOTE
On B4860 SC3900 targets, the only profiling feature
providing support for inline functions is Critical Code.
Timeline, Performance and Call Tree features do not
provide support for inline functions because of hardware
trace limitation. Profiling trace messages used by these
features are being generated only on call and return
instructions. Since body of inline functions is embedded
into parent function that calls inline function, trace profiler
features based on functions calls are not aware of inline
functions.

In Trace data viewer, inlined functions are displayed as <function_name_address>,
for example, inline_func_0x40002bd2.

€] sc3900_main.c = try_Debug_SC3900_PACC_Platform_PACC X =0
£ Trace - try_Debug_SC3900_PACC_Platform_PACC - try M oA b P A &
| | Call/Branch 4 . [ ]
Type Timesta... .
Target Chof Stallsl.
491 SCPACC Function funcz, address = 0x400022d4, funcz Linear 0.0221 1] |
492 SCPACC Function funcz, address = 0x400022d8, funcz Linear 0.0224 10
Linear 0.0224 1
Linear 0.0225 o
Linear 0.0225 o
Linear 0.0225 o
Linear 0.0226 o
Linear 0.0227 o
Linear 0.0227 o
Linear 0.0228 o
Linear 0.0229 o
Linear 0.0230 o
503 SCPACC Function main, address = 0x40002c00, main Linear 0.0230 1]
chA SeEnAce 0 ek imm pnmiem mdde s s P ANOOTATA e i [RENE noneIn n i

[~
%

Figure 3-59. Trace Data with Inline Function

In Timeline data viewer, inlined functions are represented in a different color than
default one. For example, inlined function details are shown in blue.
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Selection Mode | Zoom Mode  Full wiew  Edit Groups  Configure table =

0.1000ms

0.0354

Figure 3-60. Timeline Data with Inline Function

In Critical Code data viewer, inlined functions are suffixed with inline.
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@ startup__startup_b4860_.asm sim_sc3900_Debug_SC3900_Download_cored i3 =0
Critical Code
Address Function Coverage % ASM Decision Coverage % ASM Count  Time (Micros.. Size  Chof Stalls  Interlock Stalls  Memory Stalls | =
0x40002000 inline func 0:x40002000 0% 0% 0 0.0000 62 0 0 0 Cl—l
0:40002040 func2 100 % 0% 6 0.4400 36 16 0 0 (
0x40002080 vector dot product 1616 100 % 62.5 % 2,999 69,7800 1434 28 382 68 C
0x40002620 main 51.67 % 50 % 31 1.7800 388 39 [ 0 C
040002646 inline func 0x40002646 - inling 100 % 0% 10 0.5600 50 1 6 12 1
04000270 __FileWrite 100 % 0% 18 1.3200 50 48 0 0 C
0:40002800 _ StringWrite 0% 0% 0 0.0000 76 0 0 0 (
| 0x40002860 printf 100 % 50 % 30 1.8600 100 63 0 | 0 [
4 I b
Search: 2 © | F > @~ W~ g:l -
Line / Address Instruction Coverage % ASM Decision Coverage  ASM Count  Time (Micro... Chof 5talls  Interlock 5t..  Memory 5t *
99 int inline func(int i){ 100 & 2 0.1200 1 u] 3
0x400026446 eor.x 40,d0,d0 nop.dalu 2, covered 1 0.0200 1 a a
0x4000264e  st.l d0, (3p-518) ¥ covered 1 0.1000 0 0 3 =
100 #pragma inline 0.0000
101 bk H 100 & 3 0.1400 0 1] 4
0x40002652 1d.1 (sp-$18),d0 ¥ covered 1 0.0200 il 0 1
0x40002656 add.x #$1,d0,d0 nop.dalu 2, covered 1 0.0200 a a a
0x4000265e st.l do, (sp-518) ¥ covered 1 0.1000 0 0 3
102 i+=200; 100 = 3 0.2000 o 3 4 P
1 = [0 | 2

Figure 3-61. Critical Code Data with Inline Function

In Performance data viewer, inlined functions are suffixed with iniine.

Mo Timeline @ Performance &5 =0
Function Mame Mum Calls Inclusive | MinInclusive  Max Inclusive | Awg Inclusive | Percent Inclusive | Exclusive  MinEx... MaxExd... AwgExcl.. Percen... Percent...  Code Size [
AsmSechion) 0x40029320 1 0,230z 0.230z 0.2302 0.230z 100 0.0003 0.0001 0.0001 0.0001 015 0.57 4,624
func2 1 0.0z19 0.0z19 0.0z19 0.0z19 9.51 0.0004 0.0004 0.0004 0.0004 0.z 0.57 25
vechor_dob product 16x16 1 01520 0.1520 0.1520 0.1520 66.05 0.0013 0.0100 0.0100 0.0100 0.58 0.57 2,238
Id & 0x400023F6 - inline 16 0.0330 0.0021 0.00z1 0.0021 14.32 0.0330 0.00z1 0.00z1 0.00z1 14.96 9.14 320
Id &l 0x40002544 - inline 16 0.0330 0.0021 0.00z1 0.0021 14.32 0.0330 0.00z1 0.00z1 0.00z1 14.96 9.14 320
macexd cpp Zx 0x40002632 - 16 0.0152 0.0011 0.0011 0.0011 7.9 0.0182 0.0011 0.0011 0.0011 8.28 9.14 196
macexd cpp Zx 0x40002756 - 16 0.0152 0.0011 0.0011 0.0011 7.9 0.0182 0.0011 0.0011 0.0011 8.28 9.14 196
macexd cpp Zx 0x4000281a- 16 0.0152 0.0011 0.0011 0.0011 7.9 0.0182 0.0011 0.0011 0.0011 8.25 9.14 196 hd

Max Inclusive | Avg Inclusive | Percent Callee
0.0021

Caller A | | Caller Callee Kum Calls Indusive | Min Inclusive

. 0.0021

Callee

|<

Figure 3-62. Performance Data with Inline Function

In Call Tree data viewer, inlined functions are suffixed with inline.
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£33 Performance [ e =0
& -

Function Name Murn Calls | 9% Total calls of parent | %% Taokal times it was called | Inclusive Time (Miliseconds; 50,0 MHz)

1 100,00 100.00 1]

1 50.00 100.00 a

1 20,00 100,00 1]

1 20,00 100.00 1]

1 20,00 100.00 a

1 20,00 33.33 1]

1 20,00 33.33 a

:F exit 1 50,00 100,00 1]

Figure 3-63. Call Tree Data with Inline Function

3.11 Importing Offline SC3900 Trace with Hardware Trace
Configuration

This feature allows you to import offline SC3900 trace that is configured with hardware
profiling.

Before importing SC3900 trace, it is important to know that profiling triads were active
on board or not when trace was collected.

There are 2 triads (each triad is a group of 3 profiling counters) that are used when trace
1s imported, triad A and triad B.

The profiling triads should be selected while importing, only if trace contains values for
selected counters. If trace does not contain values for selected counters, there is no need
to select profiling triads while importing the trace.

To import offline SC3900 trace data into your project:

1. Select File > Import to open the Import wizard.
2. Expand the Software Analysis node and select Trace.
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B Import (= oo e
Select \

Import a trace data file. H < 5 i

Select an import source:

type filter text

> = General

s = CfC++

» = CodeWarrior

> = Install

> = Run/Debug

4 [= Software Analysis
= Trace

> = Team

> [ Other

@ < Back Next > Einish

Figure 3-64. Import Wizard
3. Click Next to display the Import Trace page of the Import wizard.
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¥ Import ?@

Import Trace

-

Import a trace data file,

Import From
Trace data file: | is Data\Test_Debug_B4880_Download_core08.dat Browse...
Irnport To

i@ Existing project
() Mew project

Import As
Copy the file to the workspace

View Trace
View the trace data on finish

(?) | <Back || MNet> || Fnish || Cance |

Figure 3-65. Import Wizard - Import Trace Page

4. Click Browse and locate the trace data file of the project that you want to import into
your project. The trace data file is located in the .Analysis Data folder of the project
in the workspace.

5. If you select the View the trace data on finish checkbox, the imported trace data
will automatically open in the Trace Data viewer of your project. If you clear this
option, the imported data will be visible from the Software Analysis view. The
imported trace data is also saved in the .analysis pata folder of your project.

6. Click Next to display the Import Trace to Existing Project page.
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¥ Import = @

Import Trace to Existing Project

Select an existing project as destination of the import.

Trace file will be saved as:

Import_Test\.Analysis Data\ Test_Debug_B4860_Download_coreld.dat

Import trace in project:

Mew trace file name will be;

Test_Debug_B4860_Download_coreld

@ | <Back || Net> || Finisn

Figure 3-66. Import Wizard - Import Trace to Existing Project Page
7. Type or select the project in which you want to import the trace data.
8. Type a new file name for the trace data file in the New trace file name will be text
box. This field is optional.
9. Click Next to display the Import Trace Configuration page. This page allows you
to specify the trace configuration details of the project to display imported trace data
based on the executable file or launch configuration used during trace collection.
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B Import ENERE

Import Trace Configuration

Specify system and application information for the trace,

System:
[B43s0 =

Systemn Trace Settings
B4860

5C3900-0
5C3900-1
5C3900-2
5C3900-3
5C3900-4
5C3900-5

@j MNext = [ FEinish ] ’ Cancel ]

Figure 3-67. Import Wizard - Import Trace Configuration Page
10. Select the target of your project from the System drop-down box.
11. Select the desired core from the System list.
12. Left click In the corresponding Trace Settings group, and click Fu
The Trace Settings dialog appears.

¥ Trace Settings '?'@
Trace Settings
Application Information
@ Mone

() Application:

Copy the file to the workspace

(71 Launch Configuration:

Trace type
@ Program trace
(7 Profiling trace

() Ownership or user defined events

@ [ ok ][ canca |

Figure 3-68. Import Wizard - Trace Settings dialog
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13. Select any of the following options from the Trace Settings group:

* None if you do not want to correlate trace data with the source of your project,
that is when the trace being imported is not program trace. The trace data will
appear without displaying the source lines corresponding to the trace events.

» Application if you want to correlate trace data with the source. Click Browse to
locate the executable file (.abs/.e1£/.ax) of the application used during trace
collection.

* Launch Configuration to select the launch configuration of the application used
during collection to identify the executable file or processor/system of the
application.

14. Check Profiling trace option available under the Trace type list.

¥ Trace Settings = @
Trace Settings
Application Information
@ Mone

) Application:

m
=

Copy the file to the workspace

) Launch Cenfiguration:

Trace type
) Program trace
@ Profiling trace

) Ownership or user defined events

Profiling Triads
[|Triad& [ Triad B

'f?:' [ 0K l [ Cancel J

Figure 3-69. Trace Settings dialog - Trace type

15. Select the Profiling Triads if the trace that you are importing contains the counter
values. The counters of both triads have default name. To change the name of the
counters of a triad, select the triad checkbox and the Edit button is enabled. Click
Edit to rename the counters. Legal characters for counter name are A-Z, a-z, ., _, -
and whitespace. First legal character is A-Z or a-z. Also, names of counters should be
distinct.

16. Click OK.

17. Click Finish.
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If trace data file contains values for Triad A, only Traid A was configured during
trace collection and Profiling - clock cycles scenario was selected. You should select
same counters while importing trace data. The trace viewer displays the 3 counter
values of triad A.

% SC3000HW Debug B4860 Pldm Core 00

% Trace - SC3900HW_Debug_B4860_Pldm_Core 00 - SC3900HW_Debug_B4860_Pldm_Core 00 (0)

Index |Event So...

Description

| Call/Branch 1|
Source

Triad &

10-1 SolC

12-1 SoC
14-1 SoC
18-1 SolC
22-1 SelC
2%-1 S0
30-1 SolC
H-1 SolC
31 SolC
42-1 SolC
46-1 SolC
30-1 Sl
-1 SolC
58-1 SoC
62-1 Sl
65-1 SoC
70-1 Sol
74-1 o
78-1 Sl
82-1 SoC
85-1 SolC
90-1 SolC
-1 SolC

Profiling Counter Overflow
Profiling Counter Overflow
Profiling address in (AsmSection)_(x40004 220,
Address = Tl 0004324,
Profiling address in _target_c_start. Address =
0wd00058d e,
Profiling address in __clear. Address =
Ol 0004216,
Profiling address in _target_c_start. Address =
0005316,

Prefiling sddress in getCorerevReg Dai0005880,

Address = Ixa0005884,
Profiling address in __target_c_start. Address =
4000592,

Profiling address in getCorerevReg_Ded 0005380,

Address = (20005884,
Profiling address in __tanget_c_start. Address =
4000533,

Prefiling address in getCorerevReg (0005380,

Address = InA0005834.
Profiling address in __target_c_start. Address =
A 0005352,

Prefiling address in getCorerevReg Ond 0005380,

Address = 0eA0005834,
Profiling address in __target_c_start. Address =
040005378,

Profiling address in getCorenevReg_(ha 0005380,

Address = 40005884,
Profiling address in _target_c_start. Address =
Dok 0005356,

Prefiling address in getCorerevReg Dnd0005380,

Address = (d00)5834.
Profiling address in __tanget_c_start. Address =
DA D005 kG,
Profiling address in _cmp_gtéd, Address =
Do 00054 ce.
Profiling address in _target_c_start. Address =
nAD005bHE.
Profiling address in _cnnp_gthd. Address =
Ot 00054 e,
Profiling address in __target_c_start. Address =
D D005 kG,
Profiling address in _cmnp_gtSd. Address =
(A00054 e,

{Asmbection..

[AsmSection... _target_c_stariFunction Ret...

_target_c_stat  __clear

—chear

target_c_starigetCorerevB... Function Ret...
getCorerevR... _target_c_startFunction Ret.
__target_c_stamgetCorerevR... Functien Ret..
getCorerevR... _target_c_stariFunction Ret...
_target_c_starigetCorerevf.. Function Ret..

gerCoreravR... _target_c_stanFunction Ret..

getCorerevh...

Linear

getCorerevil... _target_c_startFunction Ret...
_target_c_startgetCorerevR.. Function Ret.
getCorerevR... _target_c_stariFunction Ret...
_target_c_starigetCorerevR... Function Ret...
qgetCorerevi... _target_c_stariFunction Ret...
_target_c_start _cmp_gtBd Function Ret..

_cmp_gttd _ target_c_startFunction Ret...
_target_c_start _cmp_gttd Function Ret...

—cmp_gttd _target_c_stariFunction Ret...

_target_c_start __cmp_gttd Function Ret.

Function Ret...

__target_c_stariFunction Ret...

18145
18166
18298
13485
18635
19114
19284
19468
19507
19653
19737
19953
20002

1730
18144
18165
18297
18485
18634
19113
19283

19457

19652
19736
19958
20001

Figure 3-70. Trace Data with Triad A Counter Values

1] 16681
0 17467
0 17484
0 17614
1] 1rmar
0 17944
0 18405
[ 18573
1] 18752
] 18970
4 19012
0 19229
0 19270
0 21342
0 21532
1] 23015
0 23015
1] 23965
0 26039

The trace data file contains profiling messages for 6 counters (values of triad A and
B) if both triads were configured during trace collection and trace scenario Profiling
- L2 cache events was selected. While importing, if only triad A (3 counters) is
selected, trace viewer will not display any counter value (as shown below). Number
of triad counters within profiling messages from trace data file must match with
number of triad counters selected at the time of importing for trace viewer to display
counter columns.
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NOTE

Trace viewer displays trace containing no counter values if
the trace was collected using Program Trace

configuration.

'S SC3900HW_Debug_B4860_Pldm_Core 00 52
£ Trace - S5C3900HW_Debug_B4860_Pldm_Core 00 - SC3900HW_Debug_B4860_Pldm_Core 00 (0)

Index |Event So... Description EuEREy N Type Timesta...

101 SoC E;:;gg‘sg:;dr“’ in_target_c start. Address =\ oet ¢ start Linear 16127
131 SoC m%:&dm‘ in__clear. Address = | target cstar{ __clear |FunctionCall| 16300
16-1 SeC 3::;2;21593:;”!“ in__target_c_start. Address = _ clear _target_c_startFunction Ret... 17106
19-1 SoC :Lu':il;:?:g:;;;;;nsg;thmmhg_mm. __target_c_startgetCorerevR... Function Call 17113
221 SoC m;g?%;fldress in _target_c_start. Address = getCorerevR... _target_c_startFunction Ret... 17208
251 SoC PronIing a0dress e orerevReg G000 target c startgetCorerevR... Function Call 17412
281 SoC ﬂ";:;gg'%;: dressin _target_c_start. Address = L iCorerevR.. |_target c_starfFunction Ret..| 17528
311 SolC :rdo;irlézsg:mﬁgggaelthumﬂeg_ﬂmm‘ _target_c_startgetCorerevR... Function Call 18040
34-1 Sol E;:;g&sﬂzdm“ in _target_c_start. Address = getCorerevR.., _target_c_startFunction Ret... 13188
371 SoC :;“Ji';:?:m;gﬂfm““maeg—mm' |_target_c_starigetCorerevR... | Function Call | 18372
40-1 SeC Egmmldms in__target_c_start. Address = getCorerevR... _target_c_startFunction Ret... 18410
43-1 SoC ::;Lt:?:g:;%ﬁtcummkg‘mm' _ target_c_startgetCorerevR... Function Call 18592
461 SoC Do g 2ddress in _target ¢ stat AJdIess = getCorerevR... _target_c_startFunction Ret... 18649
49-1 SoC NG s s orerevReg 00003880 yarget_c stangetCorerevR... Function Call 18872

Figure 3-71. Trace Data with No Counters

You should select both triad A and B while importing, if both triads were configured
during trace collection when trace scenario Profiling -L.2 cache events was selected.
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5 5CI900HW_Debug_B4B60_Pldm_Core 00

% Trace - SC3900HW_Debug_B4860_Pldm_Core 00 - SC3900HW_Debug_B4860_Pldm_Core 00 (1)

81 seC

10-1 Sol
16-1 Soll
221 SeC
281 SoC
H-1 SoC
40-1 Sal
d5-1 Sal
521 Sol
58-1 Sol
54-1 Sall
T0-1 Solf
T5-1 SoC
21 ol
-1 SoC
M1 Sol
100-1 SoC
1061 Sol
112-1 Sall
1151 SeC
1241 Soll
13-1 SeC
136.1 Sol
142-1 SoC
148 Sal
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Prciling address in (Asm5ection) o004 220,
Address = el 00434,

Pechiling address in__target_c_start, Address =
Cmd 0005 e,

Profiling address in __chear, Address =
(Chob0004 116,
Pechihrig address in _target_c_start. Address =
QudDO0HLE,
Prefiling address in getContrevifleg CnelOO0SER0.
Address = (AD005EE4,
Prciling address in _target_c_start. Address =
Ced D050 e,

Pecfiling address in getConeredRieg Ce0005380.
Address = (40005584

Prcfiling addrH;anurqELgmd Address =
OmdDO053c.

Prodiling address in getCereredfieg Oel0005830.
Address = (40005854

Prcfiling address in I:un;:l;_q_stlrl Address =
Od 00585,

Peofiling address in getConerefieg Omd0005350.

Address = (ol 0005884

Precilimg address in _target_c_start. Address =
Ol 0005278,

Prefiling address in getCorerevileg Cl(005380.
Address = 5884,

Prcfiling address in _target_c_start. Address =
O D05256.

Profiling address in getCorerevfieg Oub{005380.

Address = (40003884
Pecdilimg address in_target_c_star. Address =
CrebDO0SDAG.
Profiling address in _cmp_gifd. Address =
0005 22,
Pecfiling address in_target_c_start, Address =
CrabD00 S0,
Profiling address in _cmp_gibd. Address =
Ored000 5 .
Pechiling address in_target_e_start, Address =
0000506,

Profiling address in _cmp_gefid, Address =
Ore0005d cc.
Pechihnig address in _target_c_start. Address =
OudD0050dc,

Profiling sddress in _cmpu_geld. Address =
04000550,
Prciling address in _target_c_start. Address =

Figure 3-72.

Info
[AgrSecticn,,, Lingar

{AsmSection... _tanget_c_startFunction Ret_
_terget ¢ steet  _ cless  Funchon Ret
—thear _target_c_statFumction Ret
_target_c_starigetCorerevl. Function Ret..
getCorerevfl... _target_c_statFunction et
taget ¢ _ctatgetCoreren®... Function Ret
_teget_<_staet Linar
target o ctatgetCorerenl.. Function Ret
getCorerefl. _tanget_c_statFunction Ret..
_target_c_startgetCorerevil... Function Ret
getCorerevfl... _tanget_c_statFunction et
_target_c_startgetCorerevil... Fumction Rt
getCorerevfl. _target_c_statFunction Ret.
_target_c_stasigetCorerefl... Function Ret
getCorerevil.
_emp_gtd Linear

—cmp_gttd _target_c_statFumction Ret

target_c_statFunction Ret—

_teiget ¢ ftant _cmp gted  Function Ret
—cmp ot _tanget_c_startFumction Ret_
_terget ¢ start _emp gtid  Function Ret
—cmp_gifid _target_c_statFumction Ret
_target_c_starl _ompu_gefd Function Ret..

crmpu gefd | target ¢ stetFumction Ret.

mmn
17458
17583
1819
1B387
18571
18559
16785
18849
15073
15143
21137

1330

L1986

2125
1
27145

MG

|l1bl-|'-_,n|

4

Ml

H5

7

8

-

443
443
514
53
4
7

514

1] 1] L]
0 Q Q
] o L]
e} Q o
[ a a
1] 1] L]
1] 1] L]
0 a o
1] 1] L]
"] 1] o
1] [1] L]
'] ] o
] a [
1] ] L]
i} 1] L[]
Q o o
1] 1] Li]
0 Q L]
] 1] 0
e} Q a
] a L

Trace Data when both Triads are Selected

3.12 Multicore Tracing

This section explains the various actions performed on the multicore trace data.

Before debugging a multicore project and collecting trace data on the B4 target hardware,

create and build a B4 project with Trace and Profile enabled.

NOTE

To successfully apply multicore trace configuration, specify or
set the platform configuration (default one, a new one or one
already created) for each of the launched configuration using
Debug Configurations window. If launch configuration is not
edited, then the platform configuration is not set. Hence, no
trace data is collected for the core associated with that launch

configuration.
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This section includes the following:

* Debugging Multicore Project

* Collecting Multicore Trace Data
* Viewing multicore trace data

e Importing multicore trace data

e Trace commander view

* Multicore continuous trace

3.12.1 Debugging Multicore Project

This section explains how to debug a multicore trace project.
To debug a multicore project:

1. Right-click the B4860 project in the CodeWarrior Projects view and select Debug As
> Debug Configurations.

The Debug Configurations dialog box appears.
2. Double-click the Launch Group node in the tree structure on the left.

The New_configuration node is added.
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-

33 Debug Configurations

Create, manage, and run configurations

€3 Must have at least one valid enabled launch,

4 [I= . . y .
L1 &= S | = S Mame: Mew_configuration
type filter text 8 | aunches . ] Common
[t] CodeWarrior Name Mode

@ Launch Group
= New_configuration
E Target Communication Frz

4| I | 3
Filter matched 5 of 5 iterns

Filter by Project:

= Test_Multicore_Debug_B4860_[

1 | [} | 3

@

Action

[£=]

Down

Edit...
Add...

Remove

Apply Revert

Figure 3-73. Creating new launch group dialog box
3. Type a name for the new launch group in the Name text box, for example,

Test_Multicore_TraceData_cores.
4. Click Add.

The Add Launch Configuration dialog box appears.

Expand the CodeWarrior Download node, and select the first two cores with snift

key pressed.
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e 1

¥ Add Launch Configuration @

Add one or more launch configurations to the launch group

Launch Mode: ’debug A

type filter text

4 [c| CodeWarrior
E Test_Multicore_Debug_B4860_Download_coreld
E Test_Multicore_Debug_B4860_Download_corell
E Test_Multicore_Debug_B4860_Download_core(2
E Test_Multicore_Debug_B4860_Download_core(3
E Test_Multicore_Debug_B4860_Download_coreld
E Test_Multicore_Debug_B4860_Download_corels

> = Launch Group

[7] Use default mode when launching

Post launch action: | Mone v]

@ [ ok || Ccancl

Figure 3-74. Add launch configuration dialog box
5. Click OK.

The cores get added to the new launch group.
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ﬁ‘ Debug Configurations

Create, manage, and run configurations

& I —+1 "
L1 8= x| El 5 MName: Test_Multicore_TraceData_cores

type filter text Launches . ] Common

[£] CodeWarrior
[£] Test_Multicore_Debug_B4860_Don
E Test_Multicore_Debug_B4860_Don
E Test_Multicore_Debug_B4860_Do
[£] Test_Multicore_Debug_B4860_Don
[£] Test_Multicore_Debug_B4860_Don
E Test_Multicore_Debug_B4860_Don

MName Mode Action

[£] CodeWarrior:Test_Multicore_Debug_B4860_Dow debug
[€] CodeWarrior:Test_Multicore_Debug_B4860_Dow debug

=

= Launch Group e —
[ Test_Multicore_TraceData_cores
Fﬁ Target Communication Framework
4 | 1 r
Filter matched 10 of 10 items
Filter by Project:
1= Test_Multicore
Apply Revert
@j [ Debug ] [ Close

Figure 3-75. Cores Added to New Launch Group

NOTE
The cores selected to be part of the launch group should be
configured before debugging the launch group.

6. Click Apply to save the settings.

Click Debug to start the debug session. The Debug perspective appears and the

execution halts at the first statement of main ().
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¥ Debug - Test_Multicore/Sources/b4860_main.c - CodeWarrior Development Studio ===
File Edit Source Refactor Navigate Search Project Run Window Help

r~- | % & 8T Fr-fu-BW-8 $-0-2-4- &9~ e ey [ [%5 Debug ”
#5 Debug 52 = B |[e9= Variables | ®e Breakpoints | [ Cache | i Registers | = Modules &2 B|&~¥ =0

»

L= I %5 Test_Multicore.ld
stertup_startup_b4860fp_asm
€] b4860_main.c

D e SlxargI| R SR d m-| C:\Freescale\CH_SC_3988FP_vl -

= Test_Multicore_TraceData_cores [Launch Group]
p CiUsers\b34930\workspace\5C10.8.1_396\Test_Multicore\Debugh Test_Multicere.eld (8/20/14 11:14 AM)

m

o Ci\Users\b34930\workspace\ SC10.8.1_306\Test_Multicore\Debug\cl_Test_Multicore.cld (3/20/14 11:16 AM) prototype_sc3900.h
[£] Test Multicore Debug BA860_Download_coredD [Cods\Warrior] cstdio
StarCore DSP, Test_Multicore.eld, core 0 (Suspended) [ printf.c

ewl_misra_types.h

% Thread [ID: 0x0] (Suspendedk Signal ‘Halt' received. Description: User halted thread.)
= 2 main() b4860_main.c:100 0x800025¢0
= 1 (AsmSection)() startup_startup_b4860fp_asm:691 0x80010770
W CA\Users\b34930\workspace\SC10.8.1_396\Test Multicore\Debug\Test Mukticore.eld (8/20/14 11:14 AM)
[£] Test_Multicore Debug_B4850_Download_cored1 [CodeWarriar]
&2 StarCore DSP, cl_Test_Multicore.eld, corel (Suspended)
/B Thread [ID: 0x0] (Suspended: Signal 'Halt' received. Description: User halted thread.)
= 2 main() b4260_main.c:100 (x800025€0
= 1 (AsmSection)() startup_startup_b4860tp_asm:691 00010770

wchar_t.h
stdic_api.h

o Ci\Users\b34930\workspace\ SC10.8.1_306\Test_Multicore\Debug\cl_Test_Multicore.cld (3/20/14 11:16 AM) W“jfi-“ - p
startup_startup_b4860fp_.asm [€] b4860_main.c 2 = O ||z Disassembly 53 5= Outline
__sod_saii_2x(sum_r@,sum_i0,sum_rl,sum_il,&sum_r@,&sum_id); . Enter location here .| &
" sod_saii_2x(sum_r2,sum_i2,sum_r3,sum_i3,&sum_rl,&sum_il); o ;
_ sod_aaii_2x(sum_r@,sum_i@,sum_rl,sum_il,&sum_r@,3sum i@); » 809e25¢0: | adda.lin #328,sp -
__st_srs_2f((Wordl6 *)res, sum re, sum_i@); 80@025e4:  adda.lin #3@,sp,r@ 3
} 101 int number_of_error_values=8, my_error;
80802528 eor.x d@,de,deé nop.dalu
int main() seep25fa:  st.l de,(sp-$24)
182 Word32 pred_ref = @xDAE1135(C;
int number_of_error_values=a, my_error; 80e025f4:  tfr.x #-325leecad,de
word32 prod ref = BXDAE1135C: 2 seee2sfc: . st.l d“»(sﬂ’?ﬂﬂm _ .
i f
£3 Commander &% @ ¥ = O/ B Console| ¥ Tasks | [ Memery | 45 Remote Systems | (&) Target Tasks |[2( Problems £3 . (3 Executables | @' Software Analysis mv =0
+ Project Creation ~ Build/Debug v Settings || =™
Descripti R Path Locat T
2uy Import project ® Build (Al) G Projectse | o Pron ssource 2 ocatien ype
% Import example project # Clean (A) g Build setti
¥8 CodeWarrior Bareboard Project %% Debug R Debug set
4 L ] L3
o =

Figure 3-76. Debug Perspective Window

3.12.2 Collecting Multicore Trace Data

This section explains the ways to collect multicore trace data.
Follow the steps to collect multicore trace data:
L. : . : [®| : .
In the Debug view, click Multicore Resume! " | . The execution begins and data
measurement starts.
Wait for some time.

2. When output starts displaying in the Console view for all the two cores, click

Multicore Terminate

3.12.3 Viewing multicore trace data
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Chapter 3 Collecting Data

The trace data is collected in the Software Analysis view. Click on the respective
hyperlinks to view the collected data.

NOTE
CriticalCode link is available only when all cores that are active
in a debug session are configured with Program Trace scenario.
Whereas, Timeline, Performance, and Call Tree links are

available only when cores are configured with Profiling
scenario.

NOTE
If the launch group contains cores configured with both

Profiling and Program Trace, then only the Trace link will be
available in Software Analysis view.

The following figure shows an example of Software Analysis view:

EJ Console | ¥ Tasks| @ Memory JJE Remote Systems ‘]@TargetTasks E:_\ Problems {3 Executables ”:"Soﬁware)\nalysis by
Software Analysis

5" Trace Commander =08
o El
MName Trace Timeline Critical Code Performance Call Tree

Config Results ~ Counter Points Last Medified
4 1= Test_Hardware_Debug_B4860_Download_corel0

a B CNPC
%5} Test_Hardware_Debug_B4860_Download_r = Trace

Timeline Critical Code Performance Call Tree i Configure

Counterpoints  2014.11.12 03:48:17 PM

n

Figure 3-77. Software Analysis View

Click on the Timeline link to view the timeline data.
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|5 sta rtup__startup_b4860fp_.asm |.c] b4860_main.c r-.'- Test_Multicore_Debug_B4860_Download_coreld timeline X =&

f= Timeline - Test Multicore_Debug B4860 Download_core00.timeline - Test Multicore

corel | corel

Selection Mede | Zoom Mede  Full View Edit Groups  Configure Table ~

Figure 3-78. Timeline View

Click on the Critical Code link to view the critical code data.
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@ startup__startup_b4860fp_.asm ﬂ@ b4860_main.c (f—: Test_Multicore_Debug_B4860_Do ( Test_Multicore_Debug_B4860_Do i =0
Critical Code - Test_Multicore_Debug_B42860_Download_core00
corel corel
Summary Table CC | S-S -BET R
File/Function Address Cowvered ASM % Not Covered A... Total ASM ... ASM Decisi... Time Size
Unknown Context 4
b4880_main.c N/A 89.71 % 1029 % 340 4167 % 5,075 1826
func2 080002000 100.00 % 0.00 % & 0.00 % 14 36
rmain 08000250 30,00 % 70.00 % 50 0.00 % 5061 356
vector_dot_product_16:16  0x80002040 100.00 %% 0.00 2% 284 62.50 % 0 1434
abort_exit.c N/A 0.00 % 100.00 % 17 0.00 % 0 164
exit 0xB000c5e0 0.00 3% 100.00 %% 17 0.00 3% 0 164
alloc.c N/A 0.00 3% 100.00 %% 4 0.00 3% ] 40
free 0heB000abc0 0.00 3% 100.00 %% 4 0.00 3% ] 40
ansi_files.c MN/A 0.00 %% 100.00 %% 14 0.00 3% 0 196
_ close_all 08000 chel 0.00 %% 100.00 %% 14 0.00 3% 0 196 i
Details Table Search: 2 | ] ~ €~
Line / Addr... Instruction Coverage ASM Decision ... ASM Count  Time il
100 { ¥ covered 2 852 ‘E
0x&0002 adda.lin #528,3p Z covered 1 852
0x&0002 adda.lin #%0,sp,r0 Z covered 1 a
101 int number of error_values=0, my_ error; Z covered 2 0]
0x&0002 eor.x d0,d40,d0 nop.dalu z covered 1 a
0x30002 at.l 40, (sp-524) z covered 1 0
102 Word32 prod ref = OxDAE1135C: 2. covered 2 u]
0x20002 tir.x #-5251eecad, d0 2, covered 1 a
0x20002 st.l 40, (ap-5lc) \Z covered 1 0
103 Word32 prod: u]
104 func? () ; ¥ covered 1 0 i

Figure 3-79. Critical Code View

Click on the Performance link to view the Performance data.
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@ startup__startup_b4860fp_.asm (@ b4860_main.c (@ Test_Multicore_Debug_B4860_Download_corel0.perf i =8

@1 Performance - Test_ Multicore_Debug_B4860_Download_core00

core( | corel

Summary Table () ~) | A i B | Metrics « Cycles =
Function Name Mum Calls  Inclusive MinIn.. MaxIncl.. Avglncl.. Percen.. Exclusive MinEx. MaxExcl.. AvgExcl.. Percen.. Percent.. CodeSize
4 Unknown Context
func2 1 4,244 4,244 4,244 4,244 50.20 287 287 287 287 339 5.26 36
( vector_dot_product_16:16 1 4191 4101 4191 4191 1957 3,958 3958 3,058 3,958 16.82 5.26 1434 |
main 1 4,497 8454 8,454 8,454 5319 19 19 19 19 0.22 5.26 356 E
__FileWrite 1 2,091 2,091 2,091 2,031 2473 164 164 164 164 194 5.26 52
printf 1 3,957 3,957 3,957 3,957 46.81 159 159 159 159 1.88 5.26 100
memepy 1 256 256 256 256 303 256 256 256 256 3.03 5.26 218
__prep_buffer 1 140 140 140 140 168 140 140 140 140 166 5.26 70
_ flush_buffer 1 639 639 639 639 7.56 61 61 61 (28 072 5.26 236
__write_console 1 578 578 578 578 6.84 254 254 254 254 3.00 5.26 90
__udiv32 1 122 122 122 122 1.44 122 122 122 122 144 5.26 204
__rem32 1 233 233 233 233 276 233 233 233 233 2.76 5.26 188 i
Details Table Search: 2
Caller Caller Callee Num Calls... Inclusi. Minln. MaxIncl.. Avglncl.. Percen.. Percen.. Call Site
main vector_dot_product_16x16 1 4191 4191 4191 4191 100 9359 OxB000Z..
J vector_dot_product 16:16 _ rem32 1 233 233 233 233 100 100 0x80002...
Callee

Figure 3-80. Performance View

NOTE

The caller-callee pie chart will move according to the function
pressed in details table and exclude symbols will exclude the
selected symbols for all cores.

Click the Call Tree link to view the call tree data.

@ startup__startup_b4860fp_.asm (@ b4860_main.c (E Test_Multicore_Debug_B4860_Download_cored0.calltree &2 =8

%= Call Tree - Test_Multicore_Debug_B4860_Download_core00

core0 | carel

J

@~ - &
Function Mame MNum Calls % Total calls of parent % Total times it was called  Inclusive Time (Cycles; 50.0 MHz)
Unknown Context
1 100.00 100,00 4,497
1 50.00 100,00 4,294
1 100.00 100.00 3,957
I fuide 1 50.00 50.00 730
1 50.00 100,00 3,200
f vector_dot_product_16x16 1 50,00 100,00 4,191
f __rem3z 1 100,00 100,00 233

Figure 3-81. Call Tree View
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3.12.4 Importing multicore trace data

This feature allows you to import the trace data collected for multicore B4 hardware
project.

To import the multicore trace data, perform the following steps:

A e

*®

10.
1.
12.

13.

14.
15.

Collect the multicore trace data.

Switch to a new workspace.

Select File > Import to open the Import wizard.

Expand the Software Analysis node and select Trace option.

Click Next to display the Import Trace page of the Import wizard.

Click Browse and locate the trace data file of the project that you want to import into
your project. The trace data file is located in the .Analysis Data folder of the project
in the workspace.

Select either Existing project or New project from the Import To list, depending
upon the requirements of your project.

Click Next to display the Import Trace to Existing Project page.

Type or select the project in which you want to import the trace data. Type a new file
name for the trace data file in the New trace file name will be text box. This field is
optional.

Click Next to display the Import Trace Configuration page.

Select the System corresponding to the trace that will be imported.

Specify the Source Code Correlation details for the cores on which trace was
generated, for example SC3900-0 and SC3900-1.

Specify the Application or launch configuration and the respective Trace type for
each core in the Source Code Correlation dialog box.

Click Finish.

The trace viewer will display the imported multicore data.
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Test_Multicore_Debug_B4860_Download_core00 &2 =0

Trace - Test_Multicore_Debug_B4860_Download_core00 - Test_Multicore_Debug_B4860_Download_core00 (0) 14 « » w1 [F 2 o3 &

Legend:
- Call/Branch 4 . -
Index| Event S... Description Type Timesta...
Source | Target =
11 SoC Device id = 0x1192001d (B4) Info 0
4-1 SoC Device id = 0x1192001d (B4) Info 0
81 core 0 Debug status = 0x0. Core entered in Execution state, Info 1
10-1 core 0 Function main, address = 0x800025€0. main Linear 141
Call from main to func2, Source address = 0x80002600. . .
13-1 core 0 Target addlress = (x80002000. main func2 Function Call 643
g Call from func2 to printf. Source address = 0x8000200a.
13-2 core 0 Target address = 0xB0004f80. func2 printf Function Call 643
o Call from printf to fwide. Source address = 0x8000df98. - - -
13-3 core 0 Target address = (x8000e6¢0. printf fwide Function Call 643
Branch from fwide to fwide. Source address = - .
B core0 1 8000e74a. Target address = 0x300074e. (i2ns (s Eranch E
Branch from fwide to fwide. Source address = - .
1= core0 1 8000e760. Target address = 0x3000<778. (i2ns (s Eranch e
g Return from fwide to printf. Source address = - - Functien
iz core 18000780, Target address = 0xB000¢fa2. (ins P =
“ Call from printf to _pformatter. Source address = - .
16-3 core 0 (xB000gFc2. Target address = 0xB0005CA0. printf _ pformatter  Function Call 1,485
3 Call from __pformatter to strchr. Source address = .
16-4 core 0 (xB0005¢cD. Target address = xB00036c0. _ pformatter strchr Function Call 1,485
Eranch from strchr to strchr, Source address =
16-5 core 0 (xB0003702, Target address = (xB00036€D. strchr strchr Branch 1,485
Branch from strchr to strchr, Source address =
16-6 core 0 (xB0003702. Target address = 0x800036¢0. strchr strchr Eranch 1485
Branch from strchr to strchr, Source address =
16-7 core 0 (xB0003702. Target address = 0x800036¢0. strchr strchr Branch 1,485
Branch from strchr to strchr, Source address =
16-8 core 0 (xB0003702. Target address - 0:B00036€0. strchr strchr Branch 1,485
169 corey  Bonchitom shehrio frchr. Source sddres = wehe | s Bnch | 145 -

Figure 3-82. Imported multicore trace data

The following image shows the imported multicore trace data with profiling traids.

= Test_Project_Debug_B4860_Download_core00 i3 =8
= Trace - Test_Project_Debug_B4860_Download_core00 - Test_Project_Debug_B4860_Download_core00 (0) C R I = R
Legend:
. Call/Branch l‘ Triad A <| Triad B <| -~
Off...| Event S... Description Type Timesta...
Source Target | Counter... | Counter... | Counter... | Counter... | Counter... | Counter... |
11 SoC Device id = 0x1192001d (B4) Info 0
41 SoC Device id = 0x1192001d (B4) Info 0
8-1 core_ Debug status = 0x0. Core entered in Execution state, Info 1
10-1 core_1 Debug status = 0x0. Core entered in Execution state. Info 1
Call from main to func2. Source address = 0x80002600. 5 5
121 core_1 Target address = 030002000, main func2 Function Call 147 (] [1] 0 1] [1] 0
Call from main to func2. Source address = (x80002600.
18-1 core 0 Target address = 0:x30002000. main func2 Function Call 165 6 0 0 2 0 0
P Call from func2 to printf. Source address = 0x5000200a.
241 core 1 Target address = 0xB0004f80. func2 printf Function Call 256 [ 0 2 0 0 2
g Call from func2 to printf. Source address = 0x8000200a. . .
301 core 0 Target address = 08000420 func2 printf Function Call 277 6 2 2 6 1] 0
e Call frem printf to fwide. Source address = 0x8000df98. = 3
36-1 core_1 Target address = 0300060, printf fwide Function Call 391 [ [ 2 1] [1] 6
Call from printf to fwide. Source address = 0x8000df98.
421 core 0 Target address = 0xB000e5. printf fwide Function Call 410 6 6 2 10 0 0
p Return from fwide to printf. Source address = Function
iy corel 1 8000e780. Target address = 0:8000dfa2. e prntf e etum U & c & u g L
p Call frem printf to _pformatter, Source address = .
54-1 core 1 0+B000cHcZ. Tarqet address - (B0005¢60. printf _ pformatter  Function Call 779 32 6 2 1] 1] 10 i

Figure 3-83. Imported multicore trace data - Traid counter values

3.12.5 Trace commander view
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Trace commander view is used to manage the multi-core trace collection data. The view
1s used to perform actions such as, starting or stopping the tracing on different cores,
manual upload, trace configure or changing the master core of the collected trace data.

Trace commander displays current trace state for each core.

Perform the following steps to manage the multi-core trace data using a trace

commander:

1. Create a multi-core project.

2. Right-click the project and select Debug As > Debug Configurations.
The Debug Configurations dialog box appears.

3. Create a New_Launch group by adding the cores on which trace needs to be
collected, for example core 00 and core O1.

4. Click OK.

The cores get added to the new launch group.

5. Set the Trace control settings for the selected cores on which multi-core debugging
needs to be performed. The trace control settings are available on the Intermediate
page of Trace and Profile tab.

6. Click Apply.

7. Debug the New_configuration group to collect the trace data.

8. Select Window > Show View > Other > Software Analysis > Trace Commander.
The Trace Commander view is displayed.

B Console | ¥ Tasks| @ Memory JﬁRemote Systems TargetTasks [‘_ Problerns | {3 Executables | % Trace Commander i3 ﬁSOWEreAnalysis =B
Trace Commander C]qg:a W=
Platform Configuration Data stream  Trace generator Master trace generator Trace control  Trace status Trace configure
4 Test_Hardware_Debug_B4860_Download_c CMNPC g,cgg(](]m—v i =]
SC380020 E__ Trace is ON
SC380081 = Trace is ON

5C3900=2 MNSA
SC3900%3 NfA
5C3900=4 N/A
5C3900=5 MN/A

Figure 3-84. Trace Commander View

The following table lists the description of each column available in the Trace
commander view:
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Table 3-18. Trace Commander view

Option

Description

Platform Configuration

Shows the platform configuration file used by
projects.

Data stream

Shows the current data stream selected in
configurator.

Trace generator

Displays the current cores that are available for
collecting trace.

Master trace generator

Displays the current core selected as the master
core and allows changing the master core.

Trace control

Allows you to start/stop and upload the trace data.
The Upload button is enabled only when trace is
available for collection.

Trace status

Displays the current trace status. "N/A' is applicable
when cores are not in the debug state. "Trace stop'
or "Trace start' appears when cores are in the debug
state, depending on the trace state for that core.

Trace configure

Allows you to configure the trace settings.

NOTE: If trace configuration settings
are applied manually, then after
reconfiguring the trace using
Trace configure button, Start/
Stop trace button corresponding
to master core will be reset to
the Start — Trace is OFF state
and the Upload button will be
disabled if it was previously
enabled.

9. Click the Trace link available in the Software Analysis view to view the trace

collected on the respective cores.
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startup__startup_b4860fp_.asm @ b4860_main.c = Test_Hardware_Multicore_Debug_B4860_Download_coredd 2 =&
% Trace - Test_ Hardware_Multicore_Debug_B4860_Download_core00 - Test_ Hardware_Multicore I I R e Y |
Legend:
o Call/Branch 4| ) o
Off...| Event 5... Description Type Timesta... 3
Source Target £
11 So0C Device id = 0:1192001d (B4) Info 1]
4-1 SoC Device id = 0:1192001d (B4) Info 0
8-1 core 0 Debug status = 0x0. Core entered in Execution state. Info 1
10-1 core_1 Debug status = 0x0. Core entered in Execution state. Info 1
12-1 core 1 Function main, address = 08000250, main Linear 139
15-1 core 0 Function main, address = 08000250, main Linear 159
Call from main to func2. Source address = 0x80002600.
18-1 core 1 Target address = 0<80002000. main func2 Function Call 749
R Call from func2 to printf, Source address = 0x8000200a. .
18-2 core_1 Target address = 0xB000dEO. func2 printf Functien Call 749
B Call from printf to fwide, Source address = (800098, - . .
18-3 core 1 Target address = (xB000e60. printf fwide Function Call 749
Branch from fwide to fwide. Source address = . .
= corel 1 8000e74a. Target address = (XE000ET4e. e e ezt ek
Call from main to func2. Source address = 0x30002600. - .
21-1 core 0 Target address = 0xB0002000. main func2 Function Call 836
R Call from func? to printf. Source address = 0x8000200a. -
21-2 core 0 Target address = 0x000dfS0. func2 printf Function Call 836
= Call from printf to fwide. Source address = (3000498,
21-3 core 0 Target address = 0x8000e6<0. printf fwide Functien Call 856
Branch from fwide to fwide. Source address = = .
e cored . 8000e74a. Target address = (:B000eT4e. s s e e
Branch from fwide to fwide. Source address = . .
&= corel . 8000€760. Target address = GxE0D0ETTS. s 3 e e
R Return from fwide to printf. Source address = . Function
& orel 1 8000e780. Target address = 0xB000dfa2. s printf letum LrE
R Call from printf to __pfermatter, Source address = . .
24-3 core 1l (xBO00dFC2. Target address = DxB0005¢60. printf _ pformatter  Function Call 1,603
B Call from _pformatter to strchr. Source address = -
24-4 core 1 (:80005¢c0. Target address = (:B00036. _ pformatter strchr Function Call 1,603
Branch from strchr to strchr. Source address = A — 1 e &

Figure 3-85. Trace Data Collected

The trace viewer displays the trace collected for core00 and coreOl.

3.12.6 Multicore continuous trace

Multicore continuous trace stands for trace collected from multiple cores without trace
being lost. For the B4860 targets, trace might be lost for two main reasons:
 Trace buffer size is not enough to accommodate all trace generated by the multicore
trace session.
» Trace messages frequency/rate, even if trace buffer size is enough to accommodate
all trace generated by the multicore trace session.

In order to avoid trace messages lost in any of the above cases trace collection mode
should be set to continuous.

To collect the profiling trace in the multicore continous trace mode, follow the steps
listed below:
1. Create a project using b4860 hardware target.
2. Use source multicoreContinousTrace.c With:
e - undefine ruLL_PROGRAM TRACE
® - Sel TRACE MES FREQ to TRACE MES FREQ HIGH within #ifdest PROFILING_TRACE block.
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16.

Select Profiling — L2 cache events trace scenario for all cores.

Select DDR trace buffer size to 0x60000 and one buffer as trace collection mode for
master core.

Start multicore debug and wait until application reaches its end. Multicore terminate.
Open Performance to fully decode trace and store decoded trace.

Open Trace viewer and press Ctrl+F to find error.

Inspect Performance viewer.

Select DDR trace buffer size to 0x60000 and continuous as trace collection mode for
master core.

Start multicore debug and wait until application reaches its end. Multicore terminate.

. Open Performance to fully decode trace and store decoded trace.
. Open Trace viewer and press Ctrl+F to find error.

. Inspect Performance viewer.

. Redo steps 10 to 13 with:

e DDR trace buffer size set to 0x10000 and continuous as trace collection mode
for master core.

. Redo steps 10 to 13 with:

e DDR trace buffer size set to 0x60000 and one buffer as trace collection mode for
master core.

« TRACE_MES_FREQ set to TRACE_MES_FREQ_MEDIUM within #ifdef
PROFILING_TRACE block. Rebuild the project.

Redo steps 10 to 13 with:

* DDR trace buffer size set to 0x10000 and continuous as trace collection mode
for master core.

e TRACE_MES_FREQ set to TRACE_MES_FREQ_MEDIUM within #ifdef
PROFILING_TRACE block. Rebuild the project.
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Chapter 4
Setting Tracepoints

Tracepoint is a point in the target program where start or stop tracepoints are set at a line
of the source code or the assembly code. The start and stop tracepoints are triggers for
enabling and disabling the trace output. The advantage of setting start and stop
tracepoints is to capture the trace data from the specific part of the program. This solves
the problem of tracing a large application. A full trace would be extremely difficult to
follow and would also require a large amount of target memory to store it. The trace data
displays the trace result based on the tracepoints. If there is a stop tracepoint and no start
tracepoint, the trace automatically starts at the beginning of the application. If there is at
least one start tracepoint, the trace is automatically disabled at the beginning of the
application. This chapter explains how to set start and stop tracepoints and also how to
enable and disable a tracepoint.

This chapter explains:

* Setting Start and Stop Tracepoints

* Enabling and Disabling the Tracepoints
* Limitation of hardware tracepoints

* Multicore hardware tracepoints

4.1 Setting Start and Stop Tracepoints

This section explains how to start and stop tracepoints.

The tracepoint can be set in the Editor area and the Disassembly view. The source line
tracepoint is set in the Editor area and the address tracepoint is set in the Disassembly
view. You can see the tracepoints in the Editor area as well as in the Disassembly view.
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NOTE
It is recommended that start and stop tracepoints should be set
in the same function so that the trace that is collected is
meaningful.

This topic explains how to start and stop tracepoints using the following:

e Simulator
» Target Hardware
* Viewing Tracepoints in Analysispoints

4.1.1 Simulator

This section explains how to set tracepoints in source code of a simulator project.

Before setting the tracepoints, refer to the topic Collecting Data for the procedure on how
to collect the trace and profiling data using SC3900 simulator.

Perform the following steps to set the tracepoints in source code:

1. In the CodeWarrior Projects view, select the Source folder under the project.

2. Double-click on the source file, for example, sc3900_main.c. The contents of the file

can be viewed on the right-side of the pane.

Select the line on which you want to set the start tracepoint.

4. Right-click on the marker bar, and select Toggle Trace Start Point> Hardware
Trace Point option from the context menu as shown below. The same option is also
used to remove the start tracepoint from the marker bar.

W
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@ 5c3900_main.c &3 @ startup__startup_b4860_, asm Critical Code =0
' s
int maini()
{
int nwber of error wvaluss=0, my_error;
Word3iz prod ref = OXDAE1135C;
Mord3Z prod;
funcz ()
wector dot_product 16x16( (TWordiz *) &X[0], (Word3z *)&Y[0], N, &prod):
printf | "Checking results.\n"™);
if (prod!=prod ref)
{
printf|{ "The Output is not bit-exact: prod=0x:%05%X '= D:-:%ElBX=pde_ref‘-.n",prc\d,prnd_ref);
nuwber of error values++;
wmy_error = prod-prod ref;
H
if (number of error_walues==0]
{
printf ("No wrong results found.\n™)

B v

Figure 4-1. Setting Start Tracepoint
5. Select the line on which you want to set the stop tracepoint, right-click on the marker
bar, and select Toggle Trace Stop Point> Hardware Trace Point option from the
context menu. The same option is also used to remove the stop tracepoint from the
marker bar.

NOTE

The mouse pointer over a tracepoint icon displays the
attributes of tracepoints on that line.
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€] sc3900_main.c 2 =0
e ————— = TE=os o

=113, 13100, 10539, 47435, 10419, 5250, -5178, -6890, =521
1526, -1806, 376, 3975, 96681, 14970, w40, 12456, -10°
o, o, o, o, o, o, o, o, o,

o, o, o, o, o, o, o, o, o,

o, o, o, o, o, o, o, o, — G4
-113, 13100, 10539, 47458, 10419, 5250, -5175, -6380, =T

b

int func2 ()

{
#pragma noinline

printf ("Hello private texthn™):
% return 0O;

roid rector dot product 16x16 (Wordiz *px, Wordiz *py, int length,

i
int i: W

Figure 4-2. Setting Stop Tracepoint

NOTE
The start tracepoint is in green color and stop tracepoint is
in red color. Do not set tracepoints on the lines containing
only comments, brackets and variable declaration with no
value.

6. After setting the tracepoints, debug the application and collect the data in the
datafiles. The datafiles are generated by the simulator in which the data has been
collected before setting the tracepoints in the source code. In this datafile, the
Description field shows that the main function is called first and then it calls the
func? function.
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= Test_SimulatorProject_Debug_SC3900_Download_cored 53 || sc3900_main.c =&
£ Trace - Test_SimulatorProject_Debug_SC3900_Download_core0 - Test_SimulatorProject R T I == R SR e
Legend:
- Call/Branch 4 ) Stalls L’
Index | Event S... Description Type Timesta...
Source | Target Chof Stalls | Interloc... |Memoary ... | F
u] SC PACC Function main, address = 0x400025e0, main Linear 12 a u] u]
1 SC PACC Function main, address = 0x400025e4, main Linear 13 a u] u]
2 SC PACC Function main, address = 0x400025&8, main Linear 14 a u] u]
3 SCPACT Function main, address = 0x400025F0, main Linear 15 u] o o
4 SCPACC Function main, address = 0x400025F4, main Linear 16 u] i} i}
5 SCPACT Function main, address = 0x400025fc, main Linear 17 u] o o
Branch from main to func2, Source address = 0x40002600, .
6 SC PACC Target address = 0x40002000, main funcz Branch 23 4 a a
7 SCPACC Function funcz, address = 0x40002000, funcz Linear 24 1
g SCPACC Function funcz, address = 0x40002004, Funcz Linear 25 o
Branch from funcZ ko printf, Source address = 0x4000200a, .
2 SCPACC Target address = Dx4000C740, funcz prinkF Branch 31 4 i} i}
10 SCPACC Function printf, address = 0x4000c740, printf Linear 32 o o
11 SCPACT Function printf, address = 0x4000c74e. printf Linear 33 u] i} i}
Branch From printf to Fwide, Source address = 0x4000c758, . .
12 SCPACC Tarqet address = Dx4000d 120, printf Fride Branch 39 4 o o
13 SCPACC Function fwide, address = 0x4000d1e0, Fwide Linear 40 1 1] 1]
Branch from fwide to fwide, Source address = 0x4000d1e8, q )
14 SCPACT Target address = 0x4000d2ad, Fide Fwide Eranch 41 1} a a
15 SCPACC Function fwide, address = 0x4000d1ee, Fwide Linear 45 o 2 1]
16 SCPACC Function fwide, address = 0x4000d1Fa, Fwide Linear 46 o 1 1] W
hS *
Figure 4-3. Trace Data Page Before Setting Tracepoints
In this datafile, after setting the start and stop tracepoints as displayed in the above
. . . o . .
figures, the Description field shows that the main function calls the func2 and the
tracing starts from func?2.
= Trace - Test_SimulatorProject_Debug_SC3900_Download_core0 - Test_SimulatorProject P RS Y R < I e
Legend:
L Call/Branch 4 X Stalls A
Index | Event S... Description Type Timesta...
Source | Target Chof Stalls | Interloc... | Memary ... | Program...
Branch from main to func2, Source address = 0x40002600, i
1] SCPACC Target address = 0x40002000. main funcz Branch 11 1] 1] 1] 1]
1 SCPACC Function funcz, address = 0x40002000, funcz Linear 12 1 a a a
z SC PACC Function funcz, address = 0x40002004, funcz Linear 13 1} o 1} o
EBranch fram func2 to printf. Source address = Ox4000200a, .
3 SCPACC Target address = 0x4000c740, funcz printf Branch 19 4 1] i} 1]
4 SC PACC Function printf, address = 0x4000c740. printf Linear 20 1 o o o
5 SC PACC Function printf, address = 0x4000c74e. printf Linear 21 i} 1] i} 1]
EBranch fram printf to fwide, Source address = 0x4000c755, . .
[ SCPACC Target address = Ox4000d1 20, printf Fwide EBranch 27 4 o o o
7 SCPACC Function fwide, address = 0x4000d1e0. Fide Linear 28 1 o 1} o
Branch from fwide to fwide, Source address = 0x4000d1e8, . .
g SC PACC Target address — 0x4000d2a4, Fiide Faide Eranch 29 1] 0 1] 0
9 SCPACC Function fwide, address = 0x4000d1es. Fide Linear 33 1} 2 1} o
10 SC PACC Function Fwide, address = 0x4000d1F8, Fide Linear 34 a 1 a a
Branch from fwide to fwide, Source address = 0x4000d200, . .
11 SCPACC Target address — 0x4000d2a+, Fuide: Fwide Branch 35 0 1] 0 1]
12 SC PACC Function fwide, address = 0x4000d206. Fwide Linear 39 1} 2 1} 1]
13 SCPACC Function Fwide, address = 0x4000d210, Fide Lingar 40 i} 1 i} 1]
Branch from fuide to fwide, Source address = 0x4000d220, o .
14 SC PACC Target address — Ox4000d23e. Fwide Fwide Eranch 41 1] 1] 1] 1]
15 SCPACC Function Fwide, address = 0x4000d226, Fide Lingar 45 i} 2 i} 1] "
£ 4

Figure 4-4. Trace Data Page After Setting Tracepoints

In the critical code data, you can see that tracing has started from func2.
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|.€] 5c3900_main.c Test_Simulator_Debug_SC3900_Download_corel0 i3 =

Critical Code - Test_Simulator_Debug_S$C3900_Download_core00 - Test_Simulator

Surnmary table Lol gie R = ol =57
File/Function Address Covered % Not Cover.. Total ASM.. ASM Decisi.. Time Size Chof Stalls  Interlock Stalls  Memory Stalls  Program !
5¢3900 main.c M/A 94.41 % 5.59 % 340 5833 % 3,580 1,826 MN/A MN/A MN/A MN/A
func2 0x40002000 100 % 0% 6 0% 2 36 16 0 0 0
vector dot product 16:16 040002040 100 % 0% 284 625 % 3,460 1434 20 382 68 0
main 0x400025¢0 62 % 38 % 50 50 % 89 356 40 6 0 0
abort exit.c MNiA 7647 % 2353 % 17 30 % 39 196 MN/A N/A N/A N/A
exit 0x4000a660  76.47 % 2353 % 17 50 % 39 196 20 [ 0 0
alloc.c MN/A 0% 100 % 4 0% 0 44 MN/A M/A M/A M/A
free 040004620 0% 100 % 4 0% 0 44 0 0 0 0 i
R i nnna o Anno an - e o ann Ann i pies vies . .
Details table Search: 2 | Wl ~ €~
Line / Address Instruction Coverage ASM Decision ... ASM Count  Time (CPU... ChofStalls  Interlock Stalls  Memory Stalls ~ Prograr *

58 It ] covered 1 1 1 0 0 0
0x40002000 adda.lin #50,sp,z0 U] covered 1 1 1 1] 1] a

59 #pragma noinline 1]

&0 1}

61 printf ("Helle private text\n"): ¥l covered 2 7 L 0 0 o
0x40002004 tira.l #§20000400,x0 ¥l covered 1 1 0 0 0 1]
0x4000200a jsr £4000c720 U] covered 1 [ 4 1] 1] a

2 2 2 1 0 0 0

62 return 0; ‘| covered

4 1 b

Figure 4-5. Critical Code Data After Setting Tracepoints
Similarly, you can view the other datafiles. For details, refer to the Viewing Data topic.

You can also set the tracepoints in the Disassembly view when the debug session is
active. To get the Disassembly view, select Windows > Show View > Disassembly.
(Debug perspective) The Disassembly view displays the C/C++ program in assembly
language. When you set the tracepoints in Disassembly view, the tracepoints are
automatically displayed in the Editor area.

To set the tracepoints in Disassembly view, follow the same steps as you followed for
Editor area.

The tracepoint attributes of Source Code and Disassembly view are displayed in the
Analysispoints view. To get the Analysispoints view, select Windows > Show View >
Other > Software Analysis > Analysispoints.

4.1.2 Target Hardware

This section explains how to start ans stop hardware tracepoints.

For B4 boards, there are 3 start hardware tracepoints and 3 stop hardware tracepoints. If
hardware tracepoints exceed this limit, only 3 start tracepoints and 3 stop tracepoints will
control the trace, the other tracepoints will be ignored.
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If only one stop hardware tracepoint is used then application will be traced from its
beginning until tracepoint. Also, if only one start hardware tracepoint is used then
application will be traced from tracepoint until the end of the application. When more
than one hardware tracepoints are used then they should be used in pair, for each start
hardware tracepoint set, a stop start hardware tracepoint should be set as well. A start
hardware tracepoint marks the start of traced section while a stop hardware tracepoint
marks the end of traced section.

Hardware tracepoints control only program trace and profiling trace, they have no effect
on any other kind of trace, for example, debug messages, or user defined events.

NOTE
Start and stop tracepoints should be set on C/C++ or assembly
linear instructions to ensure all change of flow instructions
between start and stop are traced. If start and stop tracepoints
are set on C/C++ or assembly change of flow instructions then
these instructions are not traced.

NOTE
Hardware or software breakpoints and stepping should not be
used inside the traced section in order to obtain accurate trace
and profile results. The reason of this behavior is that on single
stepped VLES, the events generated in parallel like trace
generation, address detection, and event counting are ignored.
For experts only, trace and profile results can be accurate even
though hardware or software breakpoints or stepping are used
inside the traced section only if they are set such that none of
single stepped VLES-es to interfere with the already mentioned
events.

To set the hardware tracepoints in source code:

1.

2.

In the CodeWarrior Projects view, select the Source folder of b4860 under the

Double-click on the source file, for example, b4860_main.c. The content of the file
can be viewed on the right-side of the pane.

. Select the line on which you want to set the start hardware tracepoint. For example,
set start tracepoint on C linear instruction before func2 call as shown in figure below.
Right-click on the marker bar, and select the Toggle Trace Start Point> Hardware
Trace Point option from the context menu.

Select the line on which you want to set the stop hardware tracepoint. For example,
set stop tracepoint on C linear instruction after runcz call as shown in figure below.
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6. Select the line on which you want to set the stop hardware tracepoint, right-click on
the marker bar, and select Toggle Trace Stop Point > Hardware Trace Point
option from the context menu.

X = proj-test_Debug_B4860_Download_cored

ret, 1i:

=|:|;

(=]
|
=

funcli():
+= i;
funcz ()
+= 1i:
func3d ()
+= 1i:
funecd () ;
+= 1i;
funcs () ;

+= i;

funce () ;
+= 1i:

ret

return ret;

||

>

Figure 4-6. Setting Start and Stop Tracepoints

7. In the Trace and Profile tab of Debug window, select Program trace scenario.

8. Click Debug and wait until application reaches its end.
9. Terminate the application.

10. Inspect trace viewer and available profiling viewers.
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|| b4Ea0_main.c = proj-test_Debug E4860_Download_cored 53 = O

= Trace - proj-test_Debug_B4860_Download_core0 - proj-test

(LI T Y R = |

. cCall/Branch 4 : 5
Off...| Event 5... Description Type Timesta...
Source | Target
13-1 core_0 Debug skatus = 00, Core enkered in Execution skate. Source Info a
is PCL,
15-1 core_0 Function main, address = 0x40002602, main Linear 770
Call From main to Funcz, Source address = Dx40002612. ) '

18-1 core_0 Targer address = 0x40002160, main funcz Funckion Call 1,031

: all from funcz to computestagel, Source address = .
18-2 core_0 (40002212, Target address = 0x40002140, funcz computeStagel  Funckion Call 1,031
18-3 core_0 Branch from computeStage! ko computeStagel. Source computeStagel computeStagel Branch 1,031

- address = 0400021 a2, Target address = 0x40002172, !

~ Branch From computesStagel to computeStagel, Source
18-4 care_0 address = Dx40002142, Target address = Ox40002172, computeStagel computeStagel Branch 1,031

g Branch From computeStagel to computeStagel. Source
18-5 care_0 address = Dx40002142, Target address = Ox40002172, computeStagel computeStagel Branch 1,031

~ Branch from camputestagel to computeStagel. Source
18-6 care_0 address = Dx40002142, Target address — Ox40002172, camputesStagel computeStagel Branch 1,031

L Branch from computestagel to computeStagel. Source
18-7 core_0 address = Dx400021 42, Target address = 040002172, computeStagel computeStagel Branch 1,031 3

Figure 4-7. Trace Data After Setting Hardware Tracepoints

The above figure shows the datafiles generated by the target hardware in which the data

has been collected after setting the tracepoints in the source code. Tracing begins with a
call from main to func2 and ends with return funcz tO main.

If a B4 StarCore project contains a launch configuration with SC3900 simulator set as
target, the hardware tracepoints will have no effect on trace while running the project on
a B4 board. Perform the first two steps if tracepoints are already added on a source file

from a project, otherwise skip to point 3 onwards if tracepoints have never been added on
a source file:

1. Select Window > Show View > Other > Software Analysis > Analysispoints, the
Analysispoints view is displayed. In the Analysispoints view, remove all the
analysispoints.

2. Remove the saanalysispointsManager.apcontig file from the project folder for which the
trace data has been collected.

NOTE

Project files are saved in <workspace location >/< project
> folder.

3. Rename the extension of any *.1aunch file from the project location for which the
target has been selected as SC3900 simulator.

NOTE

The launch files are saved in <workspace location >/<
project >/< Debug_Settings > folder.
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4. Select the existing project from CodeWarrior Projects view.
5. Right-click the project and select Refresh menu.
6. Add tracepoints on the source file of the selected project.

4.1.2.1 Modifying Hardware Tracepoint Configuration

This section explains how to modify the configuration of hardware tracepoints.

You can change the hardware tracepoints configuration during the debug session, such as
adding, removing, enabling, disabling or ignoring a tracepoint. You will be notified when
changes are made to hardware tracepoints configuration, but they are not applied to the
current debug session.

E]

.~ Tracepoints configuration changed

current debug session,

\ir) Tracepoints configuration has been changed but change can not be applied to
Please restart debug session for change ko be applied,

[ ]oon't prompt again

Figure 4-8. Tracepoints Configuration Changed

This message box appears at every resume if tracepoints configuration change is made
and can not be applied to current debug session. If you have selected Don't prompt
again checkbox then you will not be notified.

You can activate tracepoints configuration change notification by not selecting Don't
prompt to notify tracepoints configuration changed during debug session in the
Preferences -> Software Analysis window.
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2 Preferences |Z|@E
-

Software Analysis

General
ClC++ [Joan' prompt ko lacate missing files or edit source lookup paths
Caloring Editor [ autamatically backup sources when trace is saved
Freescale Licenses [ ]oon't automatically update project path in analysispoint configuration File
Help

InstallfLipdate [] oon't prompt to notify tracepoints configuration changed during debug session

Remote Launch
Rermake Systems
RunDebug

Software Analysis

Tearn
Terminal
Trace Configurations
[Restu:ure DeFauIts] [ apply ]
@:‘ [ K, ] [ Cancel ]

Figure 4-9. Preferences - Software Analysis

4.1.3 Viewing Tracepoints in Analysispoints

Use the Analysispoints view to view the the attributes of tracepoints.

This view display the attributes of tracepoints set in source code or/and assembly code.
To view the attributes of tracepoints, (Debug perpective) select Window > Show View >
Other > Software Analysis > Analysispoints, the Analysispoints view is displayed.

The source line tracepoint is set in the Editor area and the address tracepoint is set from
the Disassembly view.

4.1.3.1 Disassembly View

This section lists the address tracepoint attributes set in Disassembly.
Following are the sddress tracepoint attributes set:

* Type of tracepoint (Software or Hardware)
¢ File name
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* Address of the instruction of assembly code
* Action (Start or Stop)

4.1.3.2 Editor Area

Lists the source code tracepoint attributes set in the Editor area.
Following are the source code tracepoint attributes set in the Editor area:

* Type of tracepoint (Software or Hardware)
* File name

* Line number

* Action (Start or Stop)

You can also enable and disable tracepoints from this view. To enable or disable a
particular tracepoint, right-click on the attribute and select EnableTracepoint or Disable
Tracepoint option from the context menu.

FL analysispoinks 7 = K 3& I '5* 7 = - = 8

projltSource|sc3A00_main.c [bype: Address Hardware] [address: 0x40002010] [line: 62] [action: skop] [target: ]
T \projlt3ourcelsc3900_main.c [bvpe: Hardware] [line: 106] [action: start] [target: ]
& \sc3900hSourcelsc3900_main,c [bype: Hardware] [line: 104] [action: stop] [karget: ]
T \sc3900)Sourcelsc3900_main.c [type: Hardware] [line: 112] [action: start] [target: ]

& 53900 Sourcesc3900_main.c [bype: Hardware] [line: 116] [action: stop] [karget: ]
T ec3900S0urcetsc 3900 _main. c [type: Hardware] [line: 133] [action: skart] [target: ]

|
O

Figure 4-10. Analysispoints View

The Analysispoints view shows you where start and stop tracepoints are set in the Editor
area or the Disassembly view. It helps you to navigate to the source code or assembly
code where the tracepoint is set. If you want to go to the specific line of a source file
where the tracepoint is set, click the Go To File for Analysispoints icon. This option
will help you to navigate to that line.

If you want to ignore all the tracepoints at the time of execution, click the Ignore All
Analysispoints icon. To remove a tracepoint or remove all the tracepoints, click Remove
Selected Analysispoint icon or Remove All Analysispoints icon.

To view the complete path of the files of the attribute, click the View Menu of
Analysispoints view and select Show Full Paths option.
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FE Analysispoints 52 -+ R 3* o=

a* D:YProfilesibl 3706 workspace1iprojl | Sourcelsc3900_main.c [type: Address Hardware] [address: 0x40002010] [line: 62] [ackion: stop] [karget: ]
F [\Profiles\bl3706 \workspace 1\projliSourcelsc3200_main.c [bype: Hardware] [line: 106] [action: start] [karget: ]

& D\Profilesibl3708\workspacelsc39001Sourcelsc3900_main. ¢ [type: Hardware] [line: 104] [action: stop] [target: ]

F [\Profiles\bl3706\workspace1sc39004Sourcelsc3900_main.c [type: Hardware] [line: 112] [action: start] [target: ]

[ & DiProfilesibl 3706\ warkspace 145039001 Source|sc3900_main.c [type: Hardware] [line: 116] [action: stop] [target: ]

[ % D:Profiles\bl 3706\ warkspace 115039001 Source|sc3900_main.c [type: Hardware] [line: 133] [action: start] [target: ]

Figure 4-11. Analysispoints View - Show Full Path

You can also group the attributes by files or projects. To group the attributes by files,
click ViewMenu > Group By> Files option. The attributes are grouped by files as shown
below.

= console ﬁ? Software Analysis | T Analysispoinks &3 + i % ﬁ# =l ==
= Xl =c3900_main. c
a* \proj-testhSourcelsc300_main.c [kype: Address Hardware] [address: 0x40002010] [line: 62] [action: stop] [target: ]
a@ \proj-testlSourcelsc3200_main.c [bype: Address Hardware] [address: 0x40002900] [line: 106] [action: start] [karget: ]
T \proj-testtSourcelsc3200_main,c [kype: Hardware] [line: 106] [ackion: skart] [target: ]
% '\proj-test)Source)sc3900_main.c [kype: Hardware] [ine: 62] [ackion: stop] [target: ]

Figure 4-12. Group By Files

To group the attributes by projects, click ViewMenu > Group By > Projects option. The
attributes are grouped by projects as shown below.

B console ﬁ? Software Analysis | F& Analysispoints &3 - 3 8* = I =
=-[#]1=% proj-test
2L \proj-testiSource)sc3900_main.c [kype: Address Hardware] [address: 0x40002010] [line: 62] [action: stop] [target: ]
2F \proj-test|Sourcelsc3900_main.c [type: Address Hardware] [address: 0x40002900] [line: 106] [ackion: start] [target: ]
¥ \proj-test)Sourcelsc3A00_main.c [tvpe: Hardware] [line: 106] [action: skart] [target: ]
& \proj-test\Sourcelsc3900_main.c [kype: Hardware] [line; 62] [action: stop] [kargek: ]
= [#] =% keskl
F test1tSourcelsc3900_main.c [tvpe: Hardware] [line: 109] [action: skart] [target: ]
& ‘rest1YSourcelsc3900_main.c [type: Hardware] [ine: 122] [ackion: skop] [target: ]

Figure 4-13. Group By Projects

To ungroup the attributes, click View Menu > Group By > Analysispoints option as
shown below.
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El conscle gﬁ?Suftware Analysis | T snalysispoints 23 ¥ % ﬁg == =]

a* \proj-testiSourcelsc3900_main.c [bype: Address Hardware] [address: 0:x40002010] [line: 62] [action: stop] [target: ]
a@ ‘\proj-testlSourcelscIA00_main.c [bype: Address Hardware] [address; 0x40002900] [line: 106] [action: skart] [karget: ]
T \proj-test)Sourcelsc3900_main.c [kype: Hardware] [line: 106] [action: start] [target: ]

% '\proj-test Sourcelsc3900_main.c [bype: Hardware] [ine: 62] [action: stop] [karget: ]

F testlhSourcelsc3900_main.c [type: Hardware] [line: 109] [action: skart] [karget: ]

% ‘kest1)Sourcelsc3900_main. o [kyvpe: Hardware] [line: 122] [action; stop] [karget; ]

Figure 4-14. Ungroup the Attributes

4.2 Enabling and Disabling the Tracepoints

You can also enable and disable tracepoints using this Analysispoints view.

If you want to enable the Start or Stop tracepoint, right-click on the marker bar where
Start or Stop tracepoints are already set and in disabled state, select the Enable
Tracepoint option from the context menu.

If you want to disable the Start or Stop tracepoint, right-click on the marker bar where
Start or Stop tracepoint is already set and enabled, select the Disable Tracepoint option
from the context menu. A disabled tracepoint will have no effect during the collection of
trace data. You can also disable the tracepoint from Analysispoints view. Right-click on
the selected attribute and select Disable option. The unchecked attribute indicates the
disabled tracepoint.

4.3 Limitation of hardware tracepoints

This section explains the various limitations of hardware tracepoints.

B4 SC3900 core has limited number of hardware resources allocated for hardware
tracepoints. You can define upto 3 start hardware tracepoints and 3 stop tracepoints, but if
the number of hardware tracepoints defined by user exceeds the number of defined
tracepoints, then a notification is raised. The notification message specifies:

* the core id on which installation has failed
* the hardware tracepoints that are not successfully installed on target are identified
through line, source file pair or address
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* the reason for installation failure
* the total number of start/stop hardware tracepoints tried to be installed and number of

them for which hardware resources were found free, only if install has failed for
start/stop hardware tracepoints category

However, install is performed only on tracepoints that are enabled. The hardware
tracepoints that are reported with install failure doesnot have any effect on trace in the
ongoing debug session.

It is also possible that some of the hardware resources allocated for hardware tracepoints
are already reserved or in use by some other module, for example, debugger is another
module that can use these resources for hardware breakpoints.

Let us consider an example of hardware tracepoints notification failure, where start and
stop hardware line tracepoints exceeds the maximum number of hardware resources
available:

1.
2.
3.

Al

~

Create a b4860 hardware project. For details, refer to Hardware Profiling

Open the source file, basso_main.c.

Set four start and stop tracepoints at the beginning and end of the functions in
b4860 _main.c file.

Build the project.

Open Debug Configurations dialog and select Program trace option available
under the Trace scenarios list on the Basic tab page of Trace and Profile tab.
Click Apply and debug the application.

Resume the debug session and wait until application reaches its end.

The Trace configuration failure dialog gets prompted, while the debug application
keeps running till its end.
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¥ Trace configuration failure @

Analysispoints install failure on core 0 for:

- start hardware tracepoint from line 191, file Sources/b4860_main.c

- stop hardware tracepoint from line 205, file Sources/b4860_main.c

Failure reason:

Mo hardware resources available,

5C3900 core has hardware resources for maximum 3 start tracepoints and 3 stop
tracepoints.

Tried to install 4 start hardware tracepoints, found free hardware resources for 3 of
them.

Tried to install 4 stop hardware tracepoints, found free hardware resocurces for 3 of
them.

Figure 4-15. Trace configuration failure dialog
8. Open Software Analysis view and inspect the trace viewer.

The trace viewer shows the trace collected according to the successful installation of
hardware tracepoints. If there is at least one start tracepoint successfully installed then
trace is considered to be stopped, and will be started when first start tracepoint is hit.

4.4 Multicore hardware tracepoints

This section explains the support of hardware tracepoints for B4 SC 3900 on multicore.
For each core:

* There are up to 3 start hardware tracepoints and 3 stop hardware tracepoints available

* Hardware tracepoints control only program and profiling trace modes and have no
effect on other trace modes

* When number of hardware tracepoints set exceeds above limitation user notification
is raised

When a tracepoint is added, it is by default set (enabled) on all the available cores of the
platform. For example, if the target is B4860 then the tracepoint is set on all the six cores
of SC3900.

4.4.1 Set cores
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The Set cores feature is used to handle hardware tracepoints on multicore.
It 1s available for each hardware tracepoints.
Follow the steps given below to set hardware tracepoints on multicore:

1. Select Window > Show View > Other > Software Analysis > Analysispoints, the
Analysispoints view is displayed.

2. Righ-click on the tracepoints listed in the Analysispoints view and select Set cores
option.

The Select cores dialog box appears.

'ﬁ‘ Select Cores @ﬁ
Core 0
Core 1
e
ore
Core 5
':?:' [ OK l ’ Cancel ]

Figure 4-16. Select cores dialog
3. Select the cores on which hardware tracepoint needs to be enabled or disabled.
4. Click OK.

The list of cores on which tracepoint is enabled gets added in Analysispoints view
along with type and action performed.

&l
TFL Analysispoints &2 - 5& 3* | =

F \Test_Multicore\Sources\b4860_main.c [type: Hardware] [line: 104] [action: start] [target: | [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]

& “\Test_Multicore\Sources\b4860_main.c [type: Hardware] [line: 112] [action: stop] [target: | [cores: Core 0, Core 1, Core 2]

F \Test_Multicore\Sources\b4d860_main.c [type: Hardware] [line: 113] [action: start] [target: ] [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]

[V} & “Test_Multicore\Sources\b4860_main.c [type: Hardware] [line: 117] [action: step] [target: ] [cores: Core 0, Core 1, Core 2, Core 3, Core 4]}

F ‘\Test_Multicore\Sources\b4860_main.c [type: Hardware] [line: 119] [action: start] [target: | [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]

& ‘\Test_Multicore\Sources\b4860_main.c [type: Hardware] [line: 122] [action: stop] [target: | [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]

Figure 4-17. Selected cores displayed in Analysispoints view
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Also when start and stop hardware line tracepoints exceeds the maximum number of
hardware resources available, the hardware tracepoints failure notification message will
be prompted for each individual core.
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Chapter 5
Setting Counterpoints

Counterpoints allow you to count events between two points of the executed code. The
results are computed based on the collected trace data; the counterpoints are searched in
trace by their addresses. When counterpoints are found in the executed code, the delta
statistics 1s computed between two counterpoints. Counterpoints are only supported in
Profiling trace.

This chapter explains:

* Setting Counterpoints
* Viewing Counterpoints in Analysispoints
* Enabling and Disabling the Counterpoints

5.1 Setting Counterpoints

This section explains setting the source line counterpoint in the Editor area and the
address counterpoint in the Disassembly view.

The counterpoints are set similarly as tracepoints.
Both types of counterpoints have associated address:

» For Disassembly counterpoints, it is the address of the assembly code where the
counterpoint is placed in the Disassembly view.

* For source line counterpoints, it is the address of the source line where the
counterpoint is placed. The address is determined at runtime.

You can see the attributes of counterpoints from the Analysispoints view.
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The counterpoints results are computed based on the traced data; you must place the
counterpoints on the code that generates the trace. If the counterpoints are set on the lines
containing only comments, brackets and variable declaration with no value, a Found
invalid counterpoints dialog box gets prompted as shown below.

-

ﬁ' Found invalid counterpoints @

Invalid Counterpoints

Please select a valid location for each counterpoint.
5C3900#0 5OURCE: Sources/b4860_main.c
Invalid counterpoint from line 16 will be disabled.
Invalid counterpoint from line 56 will be disabled.

Invalid counterpeint from line 65 will be disabled.

Invalid counterpoint from line 83 will be moved at line:

Invalid counterpoint from line 64 will be disabled.

Invalid counterpoint from line 98 will be disabled.
Invalid counterpeint from line 19 will be disabled.

Invalid counterpoint from line 100 will be moved at line:

Invalid counterpoint from line 55 will be disabled.

Invalid counterpoint from line 37 will be disabled.

Skipping or closing this dialog will disable all the listed counterpoints.
A blank counterpoint selection will automatically disable the counterpoint.

| Apply || skip |

Figure 5-1. Found invalid counterpoints dialog box

You can either disable the counterpoint or move the counterpoint to location suggested in
the dialog box.

This topic explains how to set counterpoints on the sample code of the simulator also
how to view the counterpoints.

To set the counterpoints in source code:

1. In the CodeWarrior Projects view, expand the Source folder under the project.
2. Double-click on the source file, for example, SC3900_main.c.

The contents of the file appear on the right-side of the pane.
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Chapter 5 Setting Counterpoints

3. Select the line on which you want to set the counterpoint, and right-click on the
Marker bar.

4. Select the Toggle Counter Point option from the context menu. The same option is
used to remove the counterpoint from the Marker bar.

The counterpoint appears in blue color as shown in the figure.

[¢] sc3900_main.c 52 =g

int maini) -
{

int nuber of error wvalues=0, my error;

Word3Z prod ref = OxDAE1135C;

Word3Z prod;

kuncZ();

vector dot product 16x16( (Word3z *)&¥[0], (Word3Z *)&Y[0], N, &prod):

printf ("Checking results.'n"™);

if (prod!=prod ref)

; =
printf( "The Output is not bhit-exact: prod=0x3%08X !'= Dx%DBX=pde_rEf\n";prod,prn
humber of error walues++;
wmy error = prod-prod ref;

H

if (number of error walues==0]

i =]
printf ("Moo wrong results found.in™);

H

else

{ b

Figure 5-2. First Counterpoints Set in Source Code
5. Select the line on which you want to set another counterpoint. You can also set the
counterpoints in the Disassembly view when the application is in debug mode.
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] &4 E Counterpaints =B
o, o, o, i, o, i, o, o, ZE463, 1366,  -11440, .
~113, 13100, 10539, 4748, 10419, 5250, -5178, -6890, _5z04, 1117, 744z,

int func? ()

I«

#pragma noinline

printf("Hello private textin'™):
return 0;
|

void vector dot product 16x16 (Word3iZ *px, Word3Z *py, int length, WordiZ *res)
{
int i;
Word3iz =0, =1, =2, x3, =4, =5, =6, =7:
Wordiz O, v1, w2, ¥3, ¥4, v¥v5, v6, ¥7: b

Figure 5-3. Second Counterpoint Set in Source Code
6. After setting the counterpoints, debug the application and collect the data in the
datafiles.

The datafile is generated after setting the counterpoints. If two different
counterpoints are hit consecutively, the delta statistics will be computed between
these two points as shown below.

(€] sc3900_main.c B Courkerpoints &5 =8

Source Counter Poink Destination Counter Point Chof stalls | Interlock Stalls | Memory Stalls | Pr

CPZ][Sourcefsc3900_main. o] 108][0x40002500] | [CP1]Saurcefsc3900 main,c][6:3][0:40002015 342 | 1

Figure 5-4. Events Collected After Setting Counterpoints

You can match the counterpoint address with the trace address. A counterpoint is
considered hit when its address is found in the collected trace.

The following table describes the fields of the counterpoints datafile.

Table 5-1. Description of Fields - Counter Points Datafile

Field Description

Source Counter Point The counterpoint that marks the beginning of the interval for
which the delta statistics are computed

Destination Counter Point The counterpoint that marks the end of the interval for which
the delta statistics are computed

Table continues on the next page...
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Table 5-1. Description of Fields - Counter Points Datafile (continued)

Field Description

Chof Stalls Displays the number of bubble cycles incurred by change of
program flow for each instruction

Interlock Stalls Stalls introduced by core to resolve resource conflicts

Memory Stalls Displays the number of bubble cycles incurred by data bus
hold for each instruction

Program Stalls Displays the number of bubble cycles incurred by program
starvation for each instruction

Rewind Stalls Displays the number of bubble cycles incurred by a rewind on
the core buses for each instruction

BTBable COF The decoded COF is BTBable

COF Taken The COF is taken; changes the program flow

False BTB Hit Indicates False hit

NOTE

The mouse pointer over a counterpoint icon displays the
attributes of counterpoints on that line.

Few examples are given below to understand how result is computed in different
situations.

* If there is only source counterpoint with no destination, the counterpoint is hit only
once, the statistics will show the events counted till that point.

[ sc3900_maine 3 =04

int maini) ~
{
int nmaber of error wvalues=0, my error;
Word3Z prod ref = OxDAE1135C;

Word3zZ prod;

kuncZ(];

vector dot product 16x16&6( (Word3z *)&¥[0], (Word3Z *)&¥[0], N, &prod):

printf ("Checking results.\n"™):

if (prod!'=prod refj

; =
printf|( "The Output is not bit-exact: prod=0x%(038X '= Dx%DBX=pde_ref\n",prod,prn
nurmber of error values++:
my_error = prod-prod ref;

i

if (number of error wvalues==0]

i =]
printf ("Moo wrong resultz found.'\n");

H

else

{ w

Figure 5-5. Setting Only Source Counterpoint Page
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[£] sc3900_main.c [E Counterpoints 25 =B

Source Counter Poink Destination Counter Poink | Chaf Stalls | Inkerlock Stalls | Memory Stalls | Program Stalls | R

Source/sc3300_main,c]l 106 [ T N I I

Figure 5-6. Result Computed for Source Counterpoint Page
* If there is a counterpoint set in trace loop as shown in the below figure. The same
counterpoint is found in trace consecutively and the delta statistics will be computed
each time when that counterpoint is hit.

[] sc3900_main.c &3 =B
DLrI.LI.I_L-\J = _J._L‘-U_A [ LU ) A
swo_i3 = 1 to_x (0]

cw_azsert (length>d && length¥&==0):

for (i=0;i<length;i+=5)

{

| _1d Blipx, &x0, E&x1, &xZ, &x3, &xd, &x53, &x6, £x7); px+=§;

_1d Blipvy, &vO0, &vl, &vZ, &v3, &vd, &v5, &vo, &¥7): py+=8&;
_ macexd _cpp @x (¥0,¥1,x0, %1, &sum_r0, &swm_i0) ; S =0 % yO' 4+ x1 F owl!
_ maccexd cpp 2X (¥, ¥3,X2, %3, &5um rl, &sum i1);
_ maccxd cpp 22X (ve, ¥5, x4, K5, &3 ra, s3um i)
_ maceoxd cpp 2X(¥6, Y7, M6, X7, £3um r3, £Sum 13)

}

__Zod aaii Zx({swn rd,suwm i0,swo rl,swn i1, £5wn r0, £5um 10) ;

mm 1 e e 22 Man dmemeis emTl e ST memme am Tl s 2T mmeemns am A mmeae 2 AL o

Figure 5-7. Counterpoint Set after Loop Statement Page
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|.E] sc3900_main.c [ Counterpaoints &3 -0

Source Counker Poink Destination Counter Poink Chof Stalls | Inkerlock Stalls | Memory Skal

&7 76] | [CP2][Source/sc3900 main.c][87 ] 0x40002276

CP2][Sourcefsc3900_main.c][3

-

[CPEI[Source/sc3900_main.c[87][0x40002276]  [CP2][Source/sc3900_mainc[37][0x40002275] 460 1 11z
[CPZ][Fource/sc3900_main.cl[87][0x40002276]  [CPZ][Source/sc3200_main.c[37][0x40002276] 460 1 11z
[CP2][9ource/sc3900_main.c][87][0x40002276]  [CP2][Source/sc3900_main.c[87][0x40002276] 460 1 11z
[CP2][Source/sc3900_main.c][87][0x40002276]  [CP2][Source/sc3900_main.c][a7][0x40002276] 460 1 1z
[CPz][Sourcefsc3900_main.c][S7[0x40002276]  [CP2][Source/sc3900_main.c][37][0x40002276] 460 1 11z
[CPz][Sourcefsc3900_main.c][S7[0x40002276]  [CP2][Source/sc3900_main.c][37][0x40002276] 460 1 11z
[CPEI[Source/sc3900_main.c[87][0x40002276]  [CP2][Source/sc3900_mainc[37][0x40002275] 460 1 11z
[CPZ][Fource/sc3900_main.cl[87][0x40002276]  [CPZ][Source/sc3200_main.c[37][0x40002276] 460 1 11z
[CPZ][Source/sc3900_main.c)[87][0x40002276]  [CPZ][Source/sc3900_main.c[a7[0x40002276] 460 1 11z
[CP2][Source/sc3900_main.c)[87][0x40002276]  [CP2][Source/sc3900_main.c][87][0x40002276] 460 1 11z
[CPE][Source/sc3900_main.c][87][0=40002276]  [CP2][Source/sc3900_mainc][87][0x40002276] 460 1 11z
[CPz][Sourcefsc3900_main.c][S7[0x40002276]  [CP2][Source/sc3900_main.c][37][0x40002276] 460 1 11z
[CPEI[Source/sc3900_main.c[87][0x40002276]  [CP2][Source/sc3900_mainc[37][0x40002275] 460 1 11z
[CPZ][Fource/sc3900_main.cl[87][0x40002276]  [CPZ][Source/sc3200_main.c[37][0x40002276] 460 1 11z
< >

Figure 5-8. Result Page

5.2 Viewing Counterpoints in Analysispoints

You can view the attributes of counterpoints using Analysispoints view.

Analysis points view display the attributes of counterpoints set in source code or/and
assembly code. To view the attributes of counterpoints, select Window > Show View >
Other > Analysis > Analysispoints, the Analysispoints view is displayed in the below
figure.

The source line counterpoints will have associated source file name and the line number,
and the disassembly counterpoints will have associated source file name and the address.

& Analysispoints &2 ¥
7] B [address: 0x8000fe38] [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]
V| B [address: 0:B0010238] [line: 402] [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]
7| [address: 0x800105d4] [line: 615] [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]
V| B \Test_Project\Sources\b4860_main.c [line: 116] [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]
V| B \Test_Project\Sources\b4860_main.c [line: 97] [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]

AW BB~ "0

Figure 5-9. Analysispoints View

You can also enable and disable counterpoints from this view. To enable or disable a
particular counterpoint, right-click on the attribute and select Enable or Disable option
from the menu.
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5.3 Enabling and Disabling the Counterpoints

This section explains the procedure to enable or disable counterpoints.

If you want to enable the counterpoint, right-click on the Marker bar where counterpoint
is already set and in disabled state, select the Enable Counterpoint option from the
context menu.

If you want to disable the counterpoint, right-click on the Marker bar where counterpoint
is already set and enabled, select the Disable Counterpoint option from the context
menu. A disabled counterpoint will have no effect and will not compute the delta
statistics. You can also disable the counterpoint from Analysispoints view. Right-click
on the selected attribute and select Disable option. The unchecked attribute indicates the
disabled counterpoint.

T Analysispoints 27 R 3% 8* | e =
# [address: 0xB000fe38] [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]
B [address: 0x80010238] [line: 402] [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]
P [address: 0x800105d4] [line: 615] [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]
B \Test_Project)\Sources\bdB860_main.c [line: 116] [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]
P \Test Project)Sources\b4860_main.c [line: 97] [cores: Core 0, Core 1, Core 2, Core 3, Core 4, Core 5]

Figure 5-10. Disable the Counterpoint Page
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Chapter 6
Performance Analysis for B4 Devices

The Performance Analysis tool enables you to configure, collect, and analyze scenarios in
the B4 devices. The tool helps you optimize your bareboard application by using core and
platform counters to provide enhanced levels of visibility to the application. This tool is
integrated in the CodeWarrior IDE to handle configuration and communication with the
target system.

NOTE
The Software Analysis and Performance Analysis tool cannot
be used together as they use the same hardware resources.
Currently, there is no mechanism for synchronization. You can
either use Software Analysis or Performance Analysis.

This chapter explains:

» Performance Analysis Perspective
 Creating New Configuration

* Connecting to Board

* Selecting Scenarios

* Running Scenarios

* Viewing Results

e Custom scenarios

6.1 Performance Analysis Perspective

The Performance Analysis perspective provides a user-friendly interface to perform the
scenario measurement activities, such as adding a configuration, configuring connection,
defining scenarios, and collecting data.

The Performance Analysis perspective contains the following views:
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* Performance Analysis View

* Configuration View

* Performance Analysis Session View
* Progress View

6.1.1 Performance Analysis View

The Performance Analysis view organizes measurement activities in terms of projects.

A project contains configuration information and the data that is collected as shown in the
following figure.

(%) Performance Analysis &2 - “/“}é; ¥ =0

=I-1=F MainProject
Config
0-Data Cache
1-Branch Miss Ratio
Z-Interrupt Counk
3-CPU Usage in Supervisor and User Mode
4-CPU Usage and IPC
5-Daka Cache
6-Daka L1 Cache Miss
7-Instruction L1 Cache Miss
g-Backside LZ Cache Data Miss
9-Backside LZ Cache Instruction Hit Ratio
10-Daka MM TLE4K, Reloads, YSP reloads and L2M
11-Inskruction TLE4K Reloads, WSP Reloads and L2
12-Diaka MMU Miss Cycles
13-Daka MMU TLE4K, Reloads with Data side L2ZMML
14-Care Camplex Traffic
15-Core Complex Traffic - Cache ops and cache ink
16-Data Line Fill Buffer {OLFE) Miss with Threshold
=I-l=F MainProjectz
B Configz

ooooooooooooooosg

Figure 6-1. Performance Analysis View

You can import or export your project using the Performance Analysis view. To import
a Performance Analysis configuration or project into your workspace, right-click the
project and select the Import option from the context menu. In the Import wizard that

appears, select the archived file or the root directory at which the project to be imported
is located. Click Finish.
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To export a Performance Analysis project, right-click the project and select the Export
option from the context menu. In the Export wizard that appears, select the destination

type and the directory where you want to export the project. Click Finish.

6.1.2 Configuration View

The Configuration view lets you configure connections and scenarios for measurement.

The following figure shows the Configuration view.

=3 *Config &3

Configuration

€3 Mo Scenarios are selected. Select at least one scenario from the list,

« Connection

USB TAP: 0 R A B
Processor:  B4880

Status: unknown (try scanning probe)

acan Probe

» Scenarios

b Sampling

¢ Filter Core Events
b Target Information

b Session

¢ Realtime Visualization

Configuration | Motes

Figure 6-2. Configuration View

The Configuration view contains the following panes:

e Connection Pane

e Scenarios Pane

e Sampling Pane

* Filter Core Events pane
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» Target Information Pane
* Session pane
* Realtime Visualization

6.1.2.1 Connection Pane

The Connection pane allows you to define the connection method that is used to
communicate to the target hardware when a probe is being used in bareboard
applications.

The following figure shows the Connection Pane.

« Connection

Ethernet TAP : 10.171.77.199 év] SR

Processor:  B4860
Status: unknown (try scanning probe)
Scan Probe

Figure 6-3. Configuration View - Connection Pane

The following table lists the options available in the Connection pane.

Table 6-1. Configuration View - Connection Pane Options

Option Name Description

Drop-down menu Lists the previously selected connections
and displays the currently selected
connection on top. Appears blank if
there is no selected connection.

o New Connection Lets you add/configure a connection

manually to a bareboard application.
Refer Adding Connection Manually for
more details.

Y. Edit Connection Lets you modify an existing connection.
The connection could be either
automatically selected or manually

added.

% Remove Connection Removes an existing connection from
the list. Select the connection you want
to remove and click this button.

- Menu Allows you to select an option to display

the selected connection by IP address,
host name or alias.

Table continues on the next page...
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Table 6-1. Configuration View - Connection Pane Options (continued)

Option Name Description

Processor Displays the target processor. This
determines what metrics and scenarios
will be available to measure.

6.1.2.2 Scenarios Pane

The Scenarios pane lets you define the scenarios that will be measured.
A scenario contains the following:

* Events - Hardware occurrences that can be counted to any event in the B4 processor,
including the output of other counters in a feedback loop.

» Counters - Counters that can be connected to any event in the B4 processor,
including the output of other counters in a feedback loop.

* Metrics - A mathematical combination of counters (which count events) to provide
an additional answer.

« Scenarios

Check Scenarios to be measured. °¢ ¥ 4
MName Description it
]
DDR Traffic DDR 1,2 statistics including read/write cycles and page collision counts
DDR1 Traffic DDR1 statistics including read/write cycles and page collision counts =
DDR2 Traffic DDR2 statistics including read/write cycles and page collision counts
DDR 1,2 Bandwidth Measured with Ndb DDRCL,2 Bandwidth Measured with NDB
DDR 1,2 Traffic with Page Miss and Collision Analysis (System-Wide] DDR statistics including read/write cycles, page collision counts and page miss analysis
DDR 1,2 Traffic with Page Miss and Collision Analysis (Core) DDR statistics including read,/write cycles, page collision counts and page riss analysis
DDR 1,2 Traffic with Page Miss and Collision Analysis (SEC) DDR statistics including read/write cycles, page collision counts and page miss analysis
DDR 1,2 Traffic with Page Miss and Collision Analysis (FMan) DDR statistics including read,/write cycles, page collision counts and page miss analysis
DDR 1,2 Traffic with Page Miss and Collision Analysis (QMan) DDR statistics including read/write cycles, page collision counts and page miss analysis
DDR 1,2 Traffic with Page Miss and Collision Analysis (DMA) DDR statistics including read,/write cycles, page collision counts and page miss analysis
DDR 1,2 Traffic with Command Queue Full (System-Wide) DDR statistics including read/write cycles page collision counts, and command queue full counts
DDR 1,2 Traffic with Command Queue Full (Core) DDR statistics including read/write cycles page collision counts, and command queue full counts il
[ AND A1 D Teadfim cible T mmmmm e A Mmis ol FCETY MOD rdadickior imclidime rmad firidbe moclor mame calliciam cmimde amd cmceeemamd ccims £l cm e

Figure 6-4. Configuration View - Scenarios Pane

NOTE
For B4 devices, 2 DDR Controllers are supported to measure
DDR bandwidth with NDB (NXC Data Beats) counter.
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The following table lists the options available in the Scenarios pane.

Table 6-2. Configuration View - Scenarios Pane Options

Option Name Description

o Add a Stock Scenario Lets you select different stock scenarios.
A stock scenario is the standard

scenario available on the tools. Refer

Selecting Scenarios for more details.

Delete a Stock Scenario Removes the selected scenario from the
list.
Move Scenarios Up Moves scenarios up in the order of

execution. This option is only available
when multiple scenarios are added. The
scenarios run in the order they appear in
the Scenarios view. All scenarios are
independent of each other.

n Move Scenarios Down Moves scenarios down in the order of

execution. This option is only available
when multiple scenarios are added. The
scenarios run in the order they appear in
the Scenarios view. All scenarios are
independent of each other.

Show/Hide Advanced Options When clicked to show advanced options,

adds the Configure Counters column to
the right of the Description column. The
Configure Counters column displays
the checkboxes against each scenario. If
checked, the hardware is configured to
measure the selected scenario when the
profiling session starts. If unchecked, no
hardware configuration happens, that is
the previous hardware settings remain
active and the current values of the
counters are read.

6.1.2.3 Sampling Pane

The Sampling pane is used to configure the events sampling or collection settings.

The following figure shows an example of Sampling pane.
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= Sampling

Start Sampling Events

Stop Sampling Events

i@ Automatically after launchi

@ After 100

(7) When [ press the 'Go' toolbar button

Sample Values
@ Deltas
) Absolute

Keep the last 100

[ Halt Core Counters When Sampling

samples

(7) When [ press the 'Stop' toolbar button

samples

Figure 6-5. Configuration View - Sampling Pane

The table below lists the options available in the Sampling pane of the Configuration

view.

Table 6-3. Options Available in Sampling Pane

Group

Option

Description

Start Sampling Events

Lets you specify the settings for starting
the event collection.

Automatically after launch

If selected, starts collecting events

automatically when Profile button g
is clicked. This button is used to launch
profiling to measure scenarios. For
details, refer Running Scenarios.

When | press the "Go' toolbar button

If selected, waits for you to click the Go

button after Profile button Q- is
clicked. The Go button is present in the
Performance Analysis Session View.

Stop Sampling Events

Lets you specify the settings for stopping
the event collection.

After <number> samples

Stops event collection or scenario
measurement after collecting a specified
number of samples.

When | press the “Stop' toolbar button.
Keep the last <number> samples

Stops event collection after you click the
Stop button in the Performance Analysis
Session View. The number of last
collected samples that will be displayed
need to be specified in the textbox.

Sample Values

Lets you collect delta or absolute values
from the target.

6.1.2.4 Filter Core Events pane
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The Filter Core Events pane is used to limit the data collection between two addresses.

For example, if you want the branch miss ration event generated only for a specific part
of the code.

+ Filter Core Events

@ iCount events unconditionally;
() Count events if PC isin Address 0. Address1 Range
() Start counting at Address 0, stop at Address 1

]
]

Filter reference clock event

Figure 6-6. Configuration view - Filter Core Events pane

The table below lists the options available in the Filter Core Events pane of the
Configuration view.

Table 6-4. Options available in Filter Core Events pane

Option Description

Count events unconditionally Collects events without specifying any range in the code.

Count events if PC is in Address 0..Address 1 Range Counts events within a specified address range only.

Start counting at Address 0, stop at Address 1 Starts counting when address 0 is hit and stops at address 1.

Filter reference clock event Allows you to filter the measurements on reference clock.
This option becomes active only when you define a filter using
any one of the above options, and if selected, applies that
filter to the reference clock measurement.

6.1.2.5 Target Information Pane

The Target Information pane allows you to set the clock frequencies and multipliers on
the target board.

These frequencies are used to compute complex metrics that imply reporting the number
of events to a certain time frame, for example, computing the DDR traffic. The accuracy
of the results depends on the correctness of the frequency values you specify.

The default values are displayed in the respective textboxes, you can modify them
according to the speed on a particular target board.
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Platform Reference clock (Hz)

Reference clock (Hz)

System clock to Core cluster 1 cleck multiplier, Usually used for the CPUD to 3 clock select
System clock to Core cluster 2 cleck multiplier

System clock to Core cluster 3 cleck multiplier. This is usually used in the FMan and PME clock select.
System clock to Core cluster 4 cleck multiplier

System clock to FMan 1 clock multiplier,

System clock to FMan 2 clock multiplier,

System clock to DDR clock multiplier. DDR data rate is twice of this value,

System clock to platform cleck multiplier,

5¥52 PME clock.

System clock (Hz)

Figure 6-7. Configuration View - Target Information Pane

6.1.2.6 Session pane

The Session pane lets you select the settings to be applied while running the scenario
measurement session.

+ Session

Automatically display results

Stop session on first failure

[] Create log file with all target accesses
[C] Enable CSV write during capture

CSY output directory:

[7] Reset counters on launch

Figure 6-8. Configuration view - Session pane

The table below lists the options available in the Session pane of the Configuration

view.
Table 6-5. Options available in Session pane
Option Description
Automatically display all results If selected, displays the generated data automatically after data measurement or

when collection stops.

Stop session on first failure

If selected, stops collection of data when a failure is detected, for example, the
application unable to configure some counters for measurement.

Table continues on the next page...
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Table 6-5. Options available in Session pane (continued)

Option Description

Create log file with all target accesses |If selected, creates a log file which might be useful in case of a debug failure. You
can view the log file in the Target Access Log tab, which appears (at the bottom of
the results screen) after running a collection.

Enable CSV write during capture If selected, allows you to save the data in CSV output file. You can select the CSV
output directory using the Browse button.

Reset counters on launch If selected, resets counters on the target when launching a new measurement
session.

6.1.2.7 Realtime Visualization

The Realtime Visualization pane allows you to view the real time data of specified
number of samples.

The following figure shown an example of Realtime Visualization pane.

« Realtime Visualization

[] Enable Realtime Data Yisualization

300

Figure 6-9. Configuration View - Realtime Visualization Pane

Check Enable Realtime Data Visualization checkbox to edit the number of samples to
be displayed.

6.1.3 Performance Analysis Session View

The Performance Analysis Session view displays the status of all the events that are
being generated when collection starts.

Once an event is generated successfully, the status is shown as Done. For pending events,
the status is shown as Running.
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o m =8

L,w.} Data Cache Operations (Done) -
[+ Branch Miss Ratio (Done) R |
& | Interrupt Count (Running)

["] CPU Usage in Supervisor and User Mode
["] CPU Usage and IPC

B e .~

1| 1] b

Figure 6-10. Performance Analysis Session View
The buttons available in the Performance Analysis Session view are:

* Go - Click this button to start data collection if you have selected the When I press
the “Go' toolbar button option in the Sampling Pane, else the data collection starts
automatically after pressing the Profile button.

(2 Performance Analysis Session 5% L'IET\ = O

& | Data Cache Operations (Waiting...Press 'Go' to c::n.)

Figure 6-11. Go Button to Start Data Collection
* Pause - Click this button to pause data collection.

* Stop - Click this button to stop data collection.

6.1.4 Progress View

CodeWarrior Development Studio for StarCore SC3900FP DSP Architectures Tracing and Analysis Tools
User Guide, Rev. 10.9.0, 11/2015

Freescale Semiconductor, Inc. 161




ureating New Configuration

The Progress view of the Performance Analysis perspective displays the progress of the
launching configuration.

The progress bar continues as events generate one by one. After complete generation, it
displays the status as "No operations to display at this time'.

B Progress L L S Progress [T ]

Lsunchung Conlig o cperstions to dupley o this tme

— o — ™
Launching : Tnterrupt Count’...coliecting sample 71,

Figure 6-12. Progress View

6.2 Creating New Configuration

This section explains how to create a new configuration for Performance Analysis.
Perform the following steps to create a new configuration:

1. Select Window > Open Perspective > Other > Performance Analysis from the
CodeWarrior IDE menu bar to open the Performance Analysis perspective.
2. Select File > New > Other to open the New wizard.
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5 New = e

Select a wizard

-

-\.'.L‘l_:'.-

Create a new configuration for measuring target performance, [

Wizards:
type filter text

ﬁi CodeWarrior Bareboard Project Wizard
» = General
s CfC++
¢ = CodeWarrior
4 [= Performance Analysis
%! Configuration
| Custom Scenario
» = Peripheral Configurators
: == Remote Systemn Explorer

[T Show All Wizards,

.7,"\ -
- = back il Finis ance
@ oo (et [ o

Figure 6-13. New Wizard
3. Select Performance Analysis > Configuration to open the New Configuration

screen. Alternatively, click the @ icon from the main menu bar to get the New
Configuration screen directly.
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Nl

¥ Create a new configuration = @
Mew configuration

Create a new configuration

Configuration name  Config

Measure

@) Bareboard Performance events

) Linux application performance

) Use existing project
Test_B4860
@ Create a new project

Project name:  MainProject

|(H_?H'I

Next > | Ensh || Concel |

Figure 6-14. New Configuration Screen
Type a name for the configuration in the Configuration name textbox.
Select Bareboard Performance events or Linux application performance
depending upon the requirements.
Type a name for the project in the Project name textbox. This is the project in which
your Performance Analysis configuration is defined. You can create the Performance
Analysis configuration either in the existing project or in the new project. If you are
creating the Performance Analysis project for the first time, the Use existing project
option is disabled.
Click Finish.

The Performance Analysis project along with its configuration is created and appears
in the Performance Analysis view.
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6.3 Connecting to Board

You need to select a connection to the board after creating a Performance Analysis
project.

You can select a connection to the board by manually configuring the connection.

* Adding Connection Manually

6.3.1 Adding Connection Manually

This section explains the steps required to manually configure the connection with the
board.

Follow the steps to manually add a connection to the board:

I Click the New Connection icon © to open the Add a New Connection screen.
2. Select the processor and connection type in the respective fields.
3. Provide hostname or IP address depending on the connection type selected.
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vounnecting to Board

¥ Mew Connection @
Add a New Connection

Set the connection properties and press OK,

Processor ’84860 vl

Connection Type: ’EthernetTAP

Hostname/IP:  10.172.77.199

Alias (optional):

ok || Cancel |

Figure 6-15. Add a New Connection Screen
4. Specify an alias for the connection in the Alias textbox. This field is optional.

5. Click OK to save the settings.

The connection is set and selected in the Configuration view.

B3 *Config 2

Configuration
€3 Mo Scenarios are selected. Select at least one scenario from the list.

m

’EthernetTAP:lU.l?l.??.lQQ v] CERE A S 4

Processor:  B4860R2 (rev 2.0)
Status: O available

Scan Probe

1| i

Configuration | Motes

Figure 6-16. Connection Added
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NOTE
If the connection displays unknown status, click the Scan
Probe hyperlink to scan the probe connected to the
processor.

6. Click File > Save to save your configuration.

6.4 Selecting Scenarios

This section explains the steps required to select and add a scenario to the Performance
Analysis configuration.

Perform the following steps to select and add a scenario:

1. Click Add a Scenario in the Scenarios section of the Configuration view.

+ Scenarios

Check Scenarios to be measured. |57 | ¥
Data Cache Qperations Measures Several Data Cache Operations

Figure 6-17. Add a Scenario

The Add <Processor> Scenarios screen appears in which only those scenarios that
are applicable to the selected processor are displayed.

2. Select the subsystem that you want to analyze.
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¥ Scenarios = '@

Add B4860R2 Scenarios

Select the Scenarios to be added to the configuration.,

e

(* = any string, T = any character)
Mame Descripticn il
4 CPU Core Related Scenarios
« [] Utilization
4 Cache
Data Cache Operaticns Measures Several Data Cache Operations
Data L1 Cache Miss Measures Data L1 Cache Miss related statistics

Instruction L1 Cache Miss  Measures Instructions L1 Cache miss related statistics
Backside L2 Cache Data Mi: Counts L2 Backside Cache Misses per L2 Data Cache Access
Backside L2 Cache Instructi Counts L2 Backside Cache Misses per L2 Instruction Cache Acc...

m

» ] MRU
» [7] Core Complex
- [ SC3900 5C3900 Core Related Scenarios
P DDR DDR Related Scenarios
4 DDR Traffic Measures whole system
DDR 1,2 Traffic with Hitgen DDR 1,2 statistics including read/write traffic, measured with hi... i
DDA 1,2 Q0 Utilization DDR1,2 g0 utilization
» ] CoreMet CoreMet Coherency Fabric Scenarios
- [] DPAA QMan Data Path Scenarios for the Queue Manager
. [F1 NDAA SEF Mats Dath Sranarine far the Sarurihe Ennins i

Group Stock Scenarios by: ISystem Component v]

[ ok || Concel |

Figure 6-18. Add <Processor> Scenarios Screen
3. Click OK to add the selected scenarios to the configuration.
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Check Scenarios to be measured. =%° 3 i &

Mame

[] CPU Usage and IPC

Data Cache Operations

[7] Data L1 Cache Miss

[ Instruction L1 Cache Miss
Backside L2 Cache Data Miss

Description

Counts percent of total cycles spent in a PMM marked range of ...
Measures Several Data Cache Operations

Measures Data L1 Cache Miss related statistics

Measures Instructions L1 Cache miss related statistics

Counts L2 Backside Cache Misses per L2 Data Cache Access

m

Backside L2 Cache Instruction Hit Rat Counts L2 Backside Cache Misses per L2 Instruction Cache Access
Data MMU TLB4K Reloads, YSP reloac Measures Data TLB4K Reloads, VSP Reloads, and L2 MMU Misses
Instruction TLB4K Reloads, VSP Reloar Measures Instruction TLB4K Reloads, V5P Reloads, and L2 MMU ...

] Data MMU Miss Cycles

Measures Average Stall Cycles per Data MMU Misses and L2 MM...

] Nata bARALL TI BAK Relnads with Nata « beacirec Nata bARALL T BAK relnade and | 2 BARALL miccec

Figure 6-19. Scenarios Added to Configuration
4. Click File > Save to save your configuration.

You can also modify your configuration settings such as configuring board connection or
adding scenarios using the Profile Configurations dialog box. The Profile
Configurations dialog box appears on selecting Run > Profile Configurations from the

CodeWarrior IDE menu bar.

Select your configuration on left side, specify the required settings, and click Apply to

save the settings.

ﬁ' Profile Configurations
Create, manage, and run configurations

Select the Connection that will be used to measure the data,

ME R s

TE X | SiE Mame: Config
type filker text Configuration ~. = Common
= Launch Group — G =T
Perf
@& Performance Analysis
g:r Config Ethernet TAP :10.171.77.199
Processor.  B4860R2 (rev 2.0)
Status: available
Scan Probe

~ Scenarios

Name
[] Data Cache Operations
[ Branch Miss Ratio
[ Interrupt Count
[ Interrupt Count2
Filter matched 4 of 4 items [ CPU Usage and IPC
Data Cache Operations

Filter by Project:
[7] Data L1 Cache Miss

1= MainProject

Check Scenarios to be measured. &°

[ CPU Usage in Supervisor and User Mc

1 Tactrurtian 11 Carha Mice

Description

Measures Several Data Cache Operations

Measures Branch misprediction ratio for any reason

Counts interrupt occurrences, cores 0-15

Counts interrupt occurrences, cores 16-23

CPU loading that indicates Supervisor/User Privilege and IPC Me...
Counts percent of total cycles spent in 2 PMM marked range of ...
Measures Several Data Cache Operations

Measures Data L1 Cache Miss related statistics
Mezcurar Tnctruetinne 11 Carhe mice ralatarl chatickies

Profile

Revert

Close

Figure 6-20. Profile Configuration Dialog Box
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6.5 Running Scenarios

This section explains about running the scenerios and veiwing the result in the
Performance Analysis view.

To run the selected scenarios, select Run > Profile from the CodeWarrior IDE menu bar

to launch profiling. You can also click the Profile button “:/in the main toolbar of the
CodeWarrior IDE. Alternatively, you can click Profile in the Profile Configurations
dialog box, which appears on selecting Run > Profile Configurations from the
CodeWarrior IDE menu bar.

¥ Performance Analysis - MainProject/2013_02_21-10_06_27/pfa.launch - CodeWarrior Development Studio EI@
File Edit MNavigate S5earch Project Run  Window Help
g~ §Q -~ - ~H e e & @ Peformance..] 7
(2 Performance & &2 = 0 |[(2 Performance Analysis Session &3 00 ®m = B | =g Progress 2 % v — 0
- = [¥ Data Cache Operations (Done) o Launching Config
= MainProject L,\} Branch Miss Ratic (Done) e | =
¥ Config E,} Interrupt Count (Done) Launching : 'Data Cache Operations'...collecting sample 82.
[@ 0-Data Cache L,\} CPU Usage in Supervisor and User Mode (Done)
D 1-Branch Miss Ratio ‘E/Z EPU Usage and IPC (Done) =
@ 2-Interrupt Count ] B - S [
@ 3-CPU Usage in Supervist
[ 4-CPU Usage and IPC D 1-Branch Miss Ratio D 2-Interrupt Count D 3-CPU Usage in Super D 4-CPU Usage and IPC i e =0
[ 5-Data Cache
Corel Corel Core2 Core3 Cored Coreb i
INSTR_COMPLETED | INSTR_COMPLETED | INSTR_COMPLETED | INSTR_COMPLETED | INSTR_COMPLETED | INSTR_COMPLETED | IM?
UPMCD UPMCD UPMCD UPMCD UPMCD UPMCO E
Average 0 14267929 1426792.8 14267929 14267928 1426792.8
0 0 14267923 1426800.2 1426800.2 1426800.2 1426800.2
1 0 1426804.2 1426804.2 14267967 1426796.7 1426796.7
2 0 1426798.7 14267907 14267987 14267987 1426798.7
3 0 1426797 .9 14268017 14267979 14268017 14267979
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7 0 1426801 .4 1426801.4 14268014 14268088 14268014
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9 0 14267910 1426797.5 14267910 14267910 14267910
10 0 1426792.5 1426792.5 14267925 14267994 1426792.5
1 0 14267921 1426792.1 14267921 14267841 14267921
12 0 14267951 1426795.1 14267951 1426801.2 14267951
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Figure 6-21. Profiling/Measurement in Progress

The Progress View provides a summary of the operations being carried out. Once the
measurements are complete, the results are collected as part of the project and appear in
the project folder in the Performance Analysis view.
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@ Performance Analysis &3 - O
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Figure 6-22. Measurement Results

6.6 Viewing Results

You can view the scenario measurement results either in tabular or graphical format.

To view the results, double-click the collections associated with your project in the
Performance Analysis view. The generated data appears displaying a summary of the
metrics and scenarios collected in a tabular format as shown in the following figure.

NOTE
If you have kept the Automatically display all results
checkbox checked in the Session pane of the Configuration
view, the results will get open automatically while data is
collecting.
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Figure 6-23. Data Collection Results

At the bottom of the table view, there are four tabs:

* Results - Displays the default view showing the event data generated from the
Performance Analysis tool. For details, refer Tabular Format.

Graphs - Displays a graphical view of the data. For details, refer Graphical Format.
Configuration - Displays a summary of the connection to the target.

Notes - Allows you to write your own notes corresponding to the data results. The
notes that you write get automatically saved which can be viewed later when you
open the corresponding data results.

Delete - Deletes the selected result.

Rename - Lets you rename the selected result.

Import - Lets you import the selected result into another project.

Export - Lets you export results from another project.

6.6.1 Tabular Format

CodeWarrior Development Studio for StarCore SC3900FP DSP Architectures Tracing and Analysis Tools
User Guide, Rev. 10.9.0, 11/2015

172 Freescale Semiconductor, Inc.



Chapter 6 Performance Analysis for B4 Devices

The tabular format of the results generated from the Performance Analysis tool displays
the number of samples in rows and the number of events in columns.

There is one event per core generated in each column.

If you want to view event data of a particular column only, you can hide other columns.
The columns hidden in the Results view are visible in the Graphs view.

B53 Configz [1 1-Branch Miss Ratia 53 [ z-Interrupt Count B3 Config =g

Carel Cored Caorel Corez Care3 Cared Cores ™

PROC_CYCLES BRAMCHES FIRMISHED L RDARCHES ETRTSHER | BRANCHES _FINISHED | BRAMCHES_FIMISHED | BRAMCHES _FINISHED | BRAMCHES _FINI
UPMC3 LIF Export ko C5Y 1 LIPMCO LIPMCO LIPMCO LIPMCO

fAverage 1000000000 5~ Hide column 475601.5 475601.9 475602.0 475601.9
0 100000000, =4 Show all columns | 4755992 4755992 4755992 475604.4
1 100000000, 0 @ Ak rasize column | 475597.6 475602.7 475602.7 475597.6
2 100000000,0 Rename colurnn | 4756025 4756025 4756025 4756025
&) 1000000000 o T 475600.4 ’ 475602.5 475602.5 475602.5 475602.5
4 1000000000 o 475606.0 475606.0 475600.7 475606.0 475606.0
5 100000000,0 u} 475601.7 475601.7 475601.7 475599.2 475601.7
-] 1000000000 o 475596.3 475596.3 4756009 475600.9 475596.3
7 1000000000 Ju] 475603.6 475603.6 475598.6 475603.6 475603.6
3 1000000000 o 4756029 4756029 475602.9 475593.6 475602.9
9 100000000.0 u} 475605, 7 475600.5 475605, 7 4756057 475600.5
10 1000000000 Ju] 475595.2 475595.2 475595.2 475595.2 475595.2
11 1000000000 o 4756026 475607.5 475607.5 475607.5 475607.5
12 100000000,0 u} 475599.9 475599.9 475596.4 475596.4 475596.4

13 1000000000 o 475602.3 475602.3 475602.3 475602.3 475602.3 W
< >

Resulks | Graphs | Configuration | Motes

Figure 6-24. Data Collection Results in Tabular Form

Right-click a column header to view the various options available:

* Export to CSV - Allows you to export the selected column into a CSV file. Click
this option to open the Export to CSV dialog box. Specify the location and name of
the file and click Save.

Hide column - Allows you to hide the selected column. To hide multiple columns,
hold the control key and click through the columns.

Show all columns - Displays all columns in the table.

Auto resize column - Resizes all displayed columns according to table width.

* Rename column - Allows you to rename the selected column.

6.6.2 Graphical Format
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viewing Results

The graphical format allows you to view the graphical representation of the results
generated from the Performance Analysis tool.

Click the Graphs tab to view the graphical form of the collected data.

1 Performance Analysis - MainProject/2013_02_21-10_08_09/pfa.launch - CodeWarrior Development Studio EI@
File Edit Mavigate Search Project Run  Window Help
© @ B Ur P B e o (@ P
(2 Performance & 52 = O|[(2 Performance Analysis Session 57 =0 } Progress &4 ¥ =0
b 2,
—| = La‘} Data Cache Operations (Done) - MNo operations to display at this time.
= MainProject L,\} Branch Miss Ratio (Done)

3 Config [% Interrupt Count (Done)

@ 0-Data Cache [ CPU Usage in Supervisor and User Mode (Done)

@ 1-Branch Miss Ratio [ CPU Usage and IPC (Done) -

P e L -~ . —~ .- - £
2-Interrupt Count 4 i b

0 P

@ 3-CPU Usage in Supervist = =

{0 4-CPU Usage and IPC (0 13-Data MMU TLB4K Re 0 14-Core Complex Traf @ 15-Core Complex Traf [J 16-Data Line Fill Bu &2 14 8

[ 5-Data Cache

[ 6-Data L1 Cache Miss Display measurements: | Apply | [C] Regular Expression

@ 7-Instruction L1 Cache M

0 st cnenn]| 3] 4] 5 | 2 ) 4] 2 ) ) 4] 2] @[ | o)

0 9-Backside L2 Cache Insti

@ 10-Data MMU TLB4K Relc

0 11-Instruction TLB4K Rele ]
@ 12-Data MMU Miss Cycle
[ 13-Data MMU TLB4K Relc
0 14-Core Complex Traffic
@ 15-Core Complex Traffic
[J 16-Data Line Fill Buffer (C

sesen -
1 1

0 5 0 15 20 25 30 35 40 45 50 55 60 65 70 7% &80 &85 90 95 100

-01 -

Results | Graphs | Configuration | Notes

ak3

Figure 6-25. Data Collection Results in Graphical Format

A graph is generated for each event per core. You can use the scroll bar to view all the
generated graphs for a particular collection. You can perform various tasks on the graphs,
such as auto scaling, zooming-in/out, and panning. The table below lists the description
of each option available on the graph.

Table 6-6. Options Available in Graphical Format of Collected Results

Option Name Description

Display Measurements Allows you to specify strings to filter
graphs according to their titles. For
example, to display graphs with title
BTB_MISS_RATIO (of Branch Miss
Ratio event), specify the string
BTB_MISS_RATIO in the text box, and
click Apply. Only the graphs with

Table continues on the next page...
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Table 6-6. Options Available in Graphical Format of Collected Results (continued)

Option

Name

Description

BTB_MISS_RATIO as title will be
displayed. If you want a specific string to
be matched, uncheck the Regular
Expression checkbox. If you want to
match a particular string, anchor the
string with * on both sides. For example,
*core6* (with Regular Expressions
unchecked) will display all results
corresponding to core6 only. If you want
to match a single character, anchor it
with ? on both sides. For example, ?z?.

2

Configure Settings

Allows you to configure the settings of a
selected graph. Click to display the
Configure Graph Settings dialog box,
and specify the graph settings (such as
title color, legend, title font), axes
settings (such as title, color, grid format),
and traces settings (such as name, trace
type, color, line width).

i

Add Annotation

Allows you to add annotations to a
selected graph. Click to display the Add
Annotation dialog box and specify the
settings according to requirements.

i

Remove Annotation

Lets you remove the added annotations
from a selected graph.

|

Perform Auto scale

Lets you adjust the x-axis and y-axis
according to the range of the data in the
selected graph.

=

Rubberband Zoom

Lets you select a rectangular area in the
graph to zoom in.

e
-

Horizontal Zoom

Lets you specify the exact range
horizontally in the graph to zoom in.

Vertical Zoom

Lets you specify the exact range
vertically in the graph to zoom in.

Zoom In Horizontally

Zooms in horizontally in the area you
clicked.

Zoom Out Horizontally

Zooms out horizontally in the area you
clicked.

Zoom In Vertically

Zooms in vertically in the area you
clicked.

Zoom Qut Vertically

Zooms out vertically in the area you
clicked.

Panning

Lets you move the selected graph to
view a specific area of the graph.

Undo Panning

Lets you undo the panning action on the
graph.

€9 ||le||&||le| |22

Redo Panning

Lets you redo the panning action on the
graph.

Table continues on the next page...
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Table 6-6. Options Available in Graphical Format of Collected Results (continued)

Option Name Description
ic Save Snapshot to PNG Flle Allows you to capture image of the
nel | selected graphs in the PNG format.

6.7 Custom scenarios

The Performance Analysis tool allows you to select predefined analysis configurations
called Stock Scenarios.

A stock scenario configures events that are to be measured and predefined metrics to be
calculated on the collected data.

As you become more familiar with the system that you are measuring, the ability to
create you own scenarios becomes crucial. The Performance Analysis tool lets you create
a custom scenario in order to minutely narrow or extend the analysis.

This topic contains the following sub-topics.

 Defining custom scenarios
» Editing custom scenarios

6.7.1 Defining custom scenarios

This section explains the steps to define a custom scenerios.
Perform the following steps to define a custom scenerio.

1. Choose File > New > Other to open the New wizard.
2. Choose Performance Analysis > Custom Scenario and click Next.

The New Custom Scenario screen appears.

3. Specify the Processor, Name, and Description for the scenario in the respective
fields.

4. Click Next and select an existing scenario to be used as a starting point. By default,
scenarios are grouped by system component; you can choose to group the scenarios
by measurement type using the Group By pop-up menu.

5. Click Finish to complete the creation of a custom scenario.
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The New wizard closes.

6.7.2 Editing custom scenarios

After defining a custom scenario using the New wizard, a node appears for Custom
Scenarios in the Performance Analysis view. Expand this node and select the custom
scenario. Double-click the scenario to open the Custom Scenario Editor.The Custom
Scenario Editor allows you to modify the custom scenarios that you have defined
according to your requirements.

You can add events, counters and metrics to the custom scenario using Custom Scenario
Editor.

To modify a custom scenario, use the following tabs of the Custom Scenario Editor.
* Overview
* Events
* Metrics
* Initialization
* Reports

6.7.2.1 Overview

The Overview tab of the Custom Scenario Editor provides a brief summary of the
scenario you are editing.

It replicates the information that was entered during the creation of the custom scenario.
You can edit the processor to be used for the scenario, provide an alias name to the
scenario, or modify the description of the custom scenario using the respective fields.
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| *CustomScenariol 52 = B8

Custom Scenario Editor

Describe the scenario

Processor: | B4&60 -

Alias: B45cenarnio

Scenario for measuring core events]

Description:

Owerview | Events | Metrics | Initialization | Reports

Figure 6-26. Custom Scenario Editor - Overview tab

6.7.2.2 Events

The Events tab of the Custom Scenario Editor lists all of the device's components that
have events available for configuration, in the Available Events pane.

There can be hundred of these events, so to make it easier to locate an event of interest,
this tab provides a search text box where you can enter a search string. For example, in
the figure below, as the word thread is entered, the tool has displayed all events that
include the word thread in their description.

Once you locate an event of interest, select it and click the Add button. The selected
event will be added to the list of Selected Events pane on the right side. The
Performance Analysis tool automatically handles the allocation of the event to a given
counter and manages the available counters as well. As soon as all counters have been
assigned, any other events listed will be grayed out. If you try to add an event from the
grayed out list, the tool displays an error message indicating that there are no more
counters available to assign.
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|1 *CustomScenariod 52 =0

Custom Scenario Editor

Choose the events that will be measured

Available Events: Selected Events:
thread type filter text
Event Id Description * Event Counter Id Description
Corel £ a Corel
ExtendedlLoadStoreEr a LoadStoreDCacheDIifbEvel
CYCLES_THREAD Com:274 Cycles threa INTER-THREAD_DOUE UPMCOD Com:253 MNumber of inter-thi
Load5StoreDCacheDIf LOAD_THREAD_MISS_ UPMCL Com:225 MNumber of times th

INTER-THREAD_[ Com:253 Mumber of i
INTERTHREAD_S Com:226 Mumber of 1
LOAD_THREAD_P Com:225 Mumber of 1
SharedL2Events
L2_DATA_ACCES Com:d70 MNumber of 1 Rerove <-
L2_DATA_MISSES Com:d72 Mumber of 1
L2_DEMAND_AC Com:da7 Mumber of 1
L2 HITS_PER_THI Com:db5 Mumber of 1
L2 IMSTRUCTION Com:dod Mumber of 1
L2 IMSTRUCTION Com:d71 Mumber of 1
L2 MISSES_PER_T Com:dod Mumber of 1
L2 STORE_ALLOC Com:dos Mumber of 1
ThreadEvents
1

4 3 4 m 2

Overview | Events | Metrics | Initialization | Reports

Figure 6-27. Custom Scenario Editor - Events tab

6.7.2.3 Metrics

The Metrics tab of the Custom Scenario Editor lets you define (optionally) metrics
(mathematical operations) of the measured events.

The Metrics tab provides a toolbar, which allows you:

e Add a metric
 Edit an existing metric that is selected in the table
* Remove an existing metric that is selected in the table
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|| *CustomScenariol 32

Custom Scenario Editor

Opticnally define metrics to calculate based on measured events

& v R

Metric Mame Expression Qualifier
{ BIU_MASTER DATA SID... (Corel/TacDacEvent.. Corel
BRAMCHES_FIMISHED_P... (Corel/TacDacEvent... Corel
CORE_COMPLEX_DATA_... (Corel/Biulnterface.. Corel

Owerview | Events | Metrics | Initialization | Reports
Figure 6-28. Custom Scenario Editor - Metrics tab

To add a metric to a custom scenario, click the Add Metric button in the toolbar to open
the New Metric dialog. The Add Metric button provides a pop-up menu containing two
options: Add New Metric and Add Stock Metrics.

P

B New Metric @
Define the metric
Specify the Metric Mame and Expression. Qualifier is optional.
MName: CoreEventMetric
Corel/BranchPredictionfAndExecutionEvents/BRAMCHES_FIMISE »
Expressicn:
] 1 3
Qualifier:
@:l Ok ] ’ Cancel

Figure 6-29. Add new metric
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Specify the Name, Expression, and Qualifier for the metric using the respective fields.
The Expression represents a combination of event names and mathematical operands.
The Events button allows you to select the necessary events for a metric. You can also
select a constant to be used within the metric expression using the Constants button. As
metrics are operations on events, you will also need to choose an appropriate operator.
Click the Operators button to view the list of C language operator supported on the
metric expressions. Click OK to complete the definition of the metric. The Qualifier
represents a tag or a label. It helps to define filters based on an attribute/property.

Click the Add Stock Metrics option to open the Stock Metrics dialog, which allows you
to select a metric from a list of predefined metrics to be added to a custom scenario. You
can add a stock metric by selecting the checkbox corresponding to the metric. To enable a
stock metric, right-click it and choose the Add Events to Enable Metric option.

Some of the metrics in the Stock Metrics dialog are disabled due to missing events. The
Performance Analysis tool automatically handles the allocation of the event to a given
counter and manages the available counters as well. As soon as all counters have been
assigned, any other events listed will be grayed out. If you try to add an event from the
grayed out list, the tool displays an error message indicating that there are no more
counters available to assign.

6.7.2.4 Initialization

Use the Initialization tab in situations where you may require advanced target
initialization beyond the configuration that enables the event-counter pairs.

The Initialization tab of the Custom Scenario Editor allows you to enter a python code
or specify a python script directly. Select the Enter Python Code option to directly write
the python code in the available text editor. Select the Specify Python Script File option
to search the workspace or file system for previously saved python scripts.
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| | *CustomScenariol 2 =08

Custom Scenario Editor

Optionally provide pythen code to run after event-counter configuration

@ Enter Python code

4 I

(") Specify Python script file

Workspace... | | File System...
Overview | Events | Metrics | Initialization | Reports

Figure 6-30. Custom Scenario Editor - Initialization tab

6.7.2.5 Reports

The Reports tab of the Custom Scenario Editor displays the reports of the event and
metric measurements that you have added to the custom scenario.
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|| *CustomScenariol &3 =g

Custom Scenario Editor

Define reports for showing collection results

Reports == 7 3 4L Measurements =4

Table Results
Graph Results
Summary

Mame Description

{ CorelINTER-THREAD_D... Mumber of inter-thread double-word bank collisions ... |
Corel:LOAD THREAD M... Mumber of times that this threads load hits a line that...
Core:BIU_MASTER_DAT... Master data-side tranzaction starts (Mumber of D-sid...
Corel:IAC1S DETECTED:.. Every valid [ACL detection
Corel:BRAMCHES_FIMIS...  Includes all branch instructions
Corel:IAC1S DETECTED:.. Every valid [ACL detection
BIU_MASTER_DATA_SID... (Corel/TacDacEvents/TAC1S DETECTED)/(Corel/Biuln...
CORE_COMPLEX_DATA_ ... (Cored/Biulnterfacellsage/BIU_MASTER_DATA_SIDE_...
BRAMCHES_FIMISHED_P... (Corel/TacDacEvents/TAC1S DETECTED)/(Corel/Bran...

Cwerview | Events | Metrics | Initialization | Reports
Figure 6-31. Custom Scenario Editor - Reports tab

The toolbar next to the Reports pane provides the following buttons.

* New Report - Click to open the New Report dialog and create a new report. Specify
the report Type, Name, and Description in the respective fields. Select the
Automatically add new events and metrics checkbox to automatically include in
the report the new measurements that you add to the custom scenario.

Edit Report - Click to open the Edit Report dialog to modify the selected report.
Delete Report - Click to delete the selected report.

Move Report Up - Click to move the selected report up in the list.

Move Report Down - Click to move the selected report down in the list.

The toolbar next to the Measurements pane provides the following buttons.

* Add Measurement - Click to open the Add Measurement dialog. This dialog lets
you select the events and metrics that you want to add to the report. This dialog
displays only those events and metrics that have not been added yet to the report.

* Remove Measurement - Click to delete the selected measurement.

* Move Measurement Up - Click to move the selected measurement up in the list.

* Move Measurement Down - Click to move the selected measurement down in the
list.
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Chapter 7
Launching Scripts

The Profiling and Analysis tools help you launch scripts written in Python language.
These scripts allow you to collect and export trace data automatically using remote
launch. This feature is integrated with CodeWarrior IDE scripting. The scripts are
launched in remote launch using the Jython console. The remote launch feature of
CodeWarrior allows launch configurations to be executed remotely. For more details on
API of remote launch, refer to the Remote Launch API Appendix.

In this chapter:

e Run Sample Python Script
* Collect Trace Using Jython

7.1 Run Sample Python Script

The steps in this topic demonstrate the procedure of running a sample Python script from
Jython console, that is running the script that you might have written for collecting trace
data.

Perform the following steps:

1. Create a new B4860 project with the name remote-launch.

2. Replace the source code of vz860_main.c With your own code.

3. Save and build your project.

4. Update the project name, launch config name and start/stop tracepoints line numbers
in the TestrwTracepointsprogTrace.py SCript according to your project that is created,
TestHwTracepointsProgTrace.py file 1s located at: <cw installation directory>\eclipse
\plugins\com.freescale.sa.sc.scripting *\remote\scripting sa sc.

5. Select Window > Show View > Other > Debug > Remote Launch to open the
Remote Launch view.
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6. Click the Enable Remote Launch button displayed on the top right of the view to
enable remote launching.

The color of the button changes to red.

7. Select Window > Show View > Other > Debug > Jython Consoles to open the
Jython Consoles view.

8. Open the View menu in the Jython Consoles view, and select the New Interpreter
option.

]

.= Input Name

Mew Interpreter Mame

Interpret|

[ (4 H Cancel ]

Figure 7-1. Select New Interpreter Option in Jython Consoles View

The Input Name dialog box appears.

9. Specify a name for the new interpreter and click OK.

10. In the Jython console command prompt (">>>"), input code in Python syntax. You
may access any classes in your test scripts, for example, restawrracepointsprogTrace.py,
by inputting the following commands in the Jython command prompt: >>> from
scripting sa sc import TestHwTracepointsProgTraces>>>

RemoteLaunchUtils.executeLaunchScript (TestHwTracepointsProgTrace () )

NOTE
The advantage of using Jython is that besides Python
modules, it can also access Java modules in the similar
manner.

This is how you run a sample Python script from Jython console.

7.2 Collect Trace Using Jython

This section demonstrates the procedure of launching configuration and collecting both
manual and automatic trace on the B4860 target.
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To collect trace using remote launch through Jython console, perform the following steps.

P Jython Consoles &3 ¥ =0

Main | Interpret 57

execfile( "C:/Program Files/Freescale/CW SC vi0.6.0/eclipse/plugins/com.freescale.sa.sc.scripting 2.0.0.131153-201303141405 %
from scripting sa sc import TestHwTracepointsProgTrace
TestHuTracepointsProgTrace. runTraceDemo ()

In onBeforeLaunch ...

Project directory = D:/Profiles/bl13706/workspace/remote—launch

Trace results directory = D:/Profiles/bl3706/workspace/remote—launch/ . Analysis Data
launch config: O-remote-launch Debug B4860_ Download cored

Adding HW tracepoints...

411 previous tracepoints have been successfully removed.

start tracepoint

line 176

stop tracepoint

line 175
Adding HW tracepoints is completed.

['Context suspended for context', u' rDDt..-"’D—remote—launch_Debug_B‘lSSD_DDwnlDad_coreD.-"StarCore ISP, remote-launch.eld, core 0/ID:
CALLING onProgramEntry3top ... Resuming

['Context suspended for context', u' rDDt..-"’D—remote—launch_Debug_B‘lSSD_DDwnlDad_coreD.-"StarCore ISP, remote-launch.eld, core 0/ID:
CALLING onProgramExitStop|

In onifterLaunchExit ... b
£ >

i

Figure 7-2. Running Commands at Jython Command Prompt for Collecting Trace

The trace collection starts and the Software Analysis view appears with the trace results.
Open the Software Analysis view and check the collected results.

RE' Remote Launch ﬂﬁ Remote Systems g’? Software Analysis &3 =0
Software Analysis o=

Mame Trace Timeline Critical Code Performance Call Tree Log Counter Points Last Modified

1= proj-test 2013.03.20 11:14:13 &M

[=1-1=F remate-launch 2013.03.21 11:35:23 AM

=B 0-remate-launch_Debug_B4860_Download_cored
4= 0-remate-launch_Debug_B4860_Download_cf Trace Critical Code #) Log M Counterpoinks  2013.03.21 11:35:23 AM
B remoke-launch_Debug_B4860_Download_cored
= test 2013.03.20 09:52:05 AM

Figure 7-3. Software Analysis View Containing Trace Results Collected Using Remote
Launch

Click Trace and check the collected results.
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= 0O-temote-launch_Debug_B4860_Download_coren &3

= Trace - 0-remote-launch_Debug_B4860_Download_core0 -
remote-launch

4 4+ » 5 2
. Call/Branch 1 .
Off...| Event S.., Description Type Timesta, ..
Source | Target
2-1 SoC Device id = 0x0192001d (B4) Info ]
11-1 care 0 Dehug skatus = 0x0, Core entered in Execution state, Source Infa a
- Is PCU,
13-1 core_0 Function main, address = 0x40002520, mair Linear 136
Zall Fram main ko Funcl, Source address = 0x400025F4, ] .
16-1 core_0 Target address = Ox400020a0, main funcl Function Call 409
~ Zall From Funcl ko computestagel. Source address = .
16-2 core 0 Ox400020ex, Target address = 0340002140, funcl computeStagel  Function Call 409
101 core O Branch From computeStagel to computeStagel . Source computestagel computestagel Branch 1,205
- address = 0x400021 a2, Target address = 0x40002172, !
~ Branch From computeStagel to computeStagel . Source
19-2 core_0 address = Dx400021 22, Target address = 0x40002172, computeStagel computeStagel Branch 1,205
~ Branch From computeStagel to computeStagel . Source
19-3 core_0 address = Dx400021 22, Target address = 0x40002172, computeStagel computeStagel Branch 1,205
~ Branch From computeStagel to computeStagel . Source
19-4 core_0 address = Dx400021 22, Target address = 0x40002172, computeStagel computeStagel Branch 1,205
g Return From computeStagel to Funcl, Source address = .
19-5 core_0 04000210, Target address = Dx40002070, computesStagel funci Function Return 1,205

Figure 7-4. Trace Results Collected Using Remote Launch

NOTE

The sample scripts used for collecting continuous and
automatic trace on the B4860 targets are located at: <cw

Installation Directory>\eclipse\plugins

\com. freescale.sa.sc.scripting *\remote\scripting sa sc.

This is how you collect trace using the Jython console.
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Remote Launch API

This appendix documents following classes and interface for the remote launch API.

Classes
e com::freescale::sa::scripting::api::AnalysisActions
» com::freescale::sa::scripting::api:: AnalysisConfig
» com::freescale::sa::scripting::api::AnalysisErrors
e com::freescale::sa::scripting::api::AnalysisFactory
» com::freescale::sa::scripting::api::AnalysisResults
e com::freescale::sa::sc::scripting::api::ScAnalysisConfig
» com::freescale::sa::sc::scripting::api::ScHwAnalysisActions
» com::freescale::sa::sc::scripting::api::ScHwAnalysisConfig
e com::freescale::sa::sc::scripting::api::ScSimAnalysisConfig
e com::freescale::sa::scripting::api:: TracePoint

Interface
» com.freescale.sa.scripting.IAnalysisConfigFactory

8.1 com::freescale::sa::scripting::api::AnalysisActions

Refer below.

8.1.1 Public Member Functions

Lists the public member functions of the
com::freescale::sa::scripting::api::AnalysisActions class.

Following public members are available:

* AnalysisActions
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e startTrace
 stopTrace

Comprehensive description of each of the above listed functions is as follows:

8.1.1.1 AnalysisActions

Constructor.

com.freescale.sa.scripting.api.AnalysisActions.AnalysisActions (AnalysisConfig config)

Parameters
config

The AnalysisConfig-inherited instance, which carries the information needed to identify
the running launch.

8.1.1.2 startTrace

Start trace collection.

synchronized void com.freescale.sa.scripting.api.AnalysisActions.startTrace ()

8.1.1.3 stopTrace

Stop trace collection.

synchronized void com.freescale.sa.scripting.api.AnalysisActions.stopTrace ()

8.1.2 Public Static Member Functions

List the public static member functions of the
com::freescale::sa::scripting::api::AnalysisActions class.

Following public static members are available:
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e startTrace
 stopTrace

Comprehensive description of each of the above listed functions is as follows:

8.1.2.1 startTrace

Starts trace collection.

This method is intended for a static use, where an analysis configuration is not available.

static synchronized void com.freescale.sa.scripting.api.AnalysisActions.startTrace (String
launchConfigName)

Parameters
launchConfigName

The name of the running launch configuration, on which the action is triggered.

8.1.2.2 stopTrace

Stop trace collection.

This method is intended for a static use, where an analysis configuration is not available.

static synchronized void com.freescale.sa.scripting.api.AnalysisActions.stopTrace (String
launchConfigName)

Parameters
launchConfigName

The name of the running launch configuration, on which the action is triggered.

8.2 com::freescale::sa::scripting::api::AnalysisConfig

Refer below.

8.2.1 Protected Member Functions
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Lists the protected member functions of the
com::freescale::sa::scripting::api::AnalysisConfig class.

Following protected members are available:

AnalysisConfig
setProject

load

* save

getWorkingCopy
getLaunchConfiguration

Comprehensive description of each of the above listed functions is as follows:

8.2.1.1 AnalysisConfig

com.freescale.sa.scripting.api.AnalysisConfig.AnalysisConfig(String projectName)

8.2.1.2 setProject

void com.freescale.sa.scripting.api.AnalysisConfig.setProject (ILaunchConfiguration
launchConfig)

8.2.1.3 load

void com.freescale.sa.scripting.api.AnalysisConfig.load()

8.2.1.4 save

Saves current configuration.

void com.freescale.sa.scripting.api.AnalysisConfig.save ()

8.2.1.5 getWorkingCopy

CodeWarrior Development Studio for StarCore SC3900FP DSP Architectures Tracing and Analysis Tools
User Guide, Rev. 10.9.0, 11/2015

192 Freescale Semiconductor, Inc.




g |

Y
Chapter 8 Remote Launch API

Get the working copy of the active launch configuration.

ILaunchConfigurationWorkingCopy
com.freescale.sa.scripting.api.AnalysisConfig.getWorkingCopy ()

Returns

The current launch configuration working copy.

8.2.1.6 getLaunchConfiguration

ILaunchConfiguration com.freescale.sa.scripting.api.AnalysisConfig.getLaunchConfiguration ()

8.2.2 Public Member Functions

Lists the public member functions of the
com::freescale::sa::scripting::api::AnalysisConfig class.

Following public member functions are available:

» getOutputFolder
 addSrcLineTracePoint

* addAddressTracePoint

* removeTracePoint
 getTracePoints

* setlgnoreAllTracePoints

» getlgnoreAllTracePoints

» removeAllTracePoints

e removeLineCounterpoint

* removeAddrCounterpoint

* setLineCounterpointEnabled
 setAddrCounterpointEnabled
» getAttribute

* setAttribute

8.2.2.1 getOutputFolder

Returns the SA output folder attribute.
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String com.freescale.sa.scripting.api.AnalysisConfig.getOutputFolder ()

Returns

The output folder path.

8.2.2.2 addSrcLineTracePoint

Adds a tracepoint identified by a source file and a line number to a project.

TracePoint com.freescale.sa.scripting.api.AnalysisConfig.addSrcLineTracePoint (String
sourceFilePath, int lineNo, TracePoint.Action action, TracePoint.Type type)

Parameters

sourceFilePath

Path towards source file of tracepoint.

lineNo

Line Number of tracepoint.

action

Action of tracepoint, see for possible values. TracePoint.Action
type

Type of tracepoint, see for possible values. TracePoint.Action
Returns

Return the resulted . TracePoint

8.2.2.3 addAddressTracePoint

Adds an tracepoint idenfified by an address to a project.

TracePoint com.freescale.sa.scripting.api.AnalysisConfig.addAddressTracePoint (String
sourceFilePath, String address, TracePoint.Action action, TracePoint.Type type, int lineNo)

Parameters
sourceFilePath

Path towards source file where marker for tracepoint should be displayed. Set it to empty
string and no marker will be displayed for this tracepoint in source file.
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address

Address of tracepoint.

action

Action of tracepoint, see for possible values. TracePoint.Action
type

Type of tracepoint, see for possible values. TracePoint.Action
lineNo

Line number from source file where marker for tracepoint should be displayed. Set it to O
and no marker will be displayed for this tracepoint in source file.

coreException
Returns

Return the resulted . TracePoint

8.2.2.4 removeTracePoint

Remove tp tracepoint from the current project.

int com.freescale.sa.scripting.api.AnalysisConfig.removeTracePoint (TracePoint tp)
Parameters

tp

Tracepoint to be removed.

Returns

AnalysisErrors. STATUS_OK if the operation was successful, or
AnalysisErrors. STATUS_ERROR if it fails.

8.2.2.5 getTracePoints

Get all tracepoints from the current project.
Vector com.freescale.sa.scripting.api.AnalysisConfig.getTracePoints ()

Returns
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All tracepoints from the current project

8.2.2.6 setlgnoreAliTracePoints

Set all tracepoints to be ignored or not.
void com.freescale.sa.scripting.api.AnalysisConfig.setIgnoreAllTracePoints (boolean ignoreAll)

Parameters
ignoreAll

True for ignore all tracepoints, false otherwise.

8.2.2.7 getignoreAllTracePoints

Get ignore all tracepoints status.
boolean com.freescale.sa.scripting.api.AnalysisConfig.getIgnoreAllTracePoints ()

Returns

True if all tracepoints are currently ignored, false otherwise.

8.2.2.8 removeAllTracePoints

Remove all tracepoints from the current project.
int com.freescale.sa.scripting.api.AnalysisConfig.removeAllTracePoints ()

Returns

AnalysisErrors. STATUS_OK if the operation was successful, or
AnalysisErrors. STATUS_ERROR if it fails.

8.2.2.9 removeLineCounterpoint

Remove a counterpoint from a C source file line number.
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void com.freescale.sa.scripting.api.AnalysisConfig.removeLineCounterpoint (int lineNumber,
String sourceFilePath)

Parameters

lineNumber

The line number the counterpoint to be added to.

sourceFilePath

The path to the source file, where the counterpoint will be added.

CoreException

8.2.2.10 removeAddrCounterpoint

Remove an address counterpoint.
void com.freescale.sa.scripting.api.AnalysisConfig.removeAddrCounterpoint (String hexAddr)

Parameters
hexAddr
The hex address at which this counterpoint is set.

CoreException

8.2.2.11 setLineCounterpointEnabled

Enable or disable a line counterpoint.

void com.freescale.sa.scripting.api.AnalysisConfig.setLineCounterpointEnabled (int
lineNumber, String sourceFilePath, boolean enabled)

Parameters

lineNumber

The line number the counterpoint needs to be set up at.
sourceFilePath

The path to the C source file.

enabled
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Set counterpoint enabled or disabled.

CoreException

8.2.2.12 setAddrCounterpointEnabled

Enable or disable an address counterpoint.

void com.freescale.sa.scripting.api.AnalysisConfig.setAddrCounterpointEnabled (boolean
enabled, String hexAddr)

Parameters

enabled

Set counterpoint enabled or disabled.

hexAddr

The HEX address the counterpoint needs to be set up at.

CoreException

8.2.2.13 getAttribute

Get the value of a SA general configuration attribute.
Object com.freescale.sa.scripting.api.AnalysisConfig.getAttribute (Object attributeType)

Parameters
attributeType

The attribute from which the value will be retrieved. The attributes are exposed by the
AnalysisConfigAttributes enum.

Returns

The specific attribute value.

8.2.2.14 setAttribute

Set one of the SA general config attributes.
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void com.freescale.sa.scripting.api.AnalysisConfig.setAttribute (ObjectattributeType, Object
arg)

Parameters
attributeType

One of the AnalysisConfigAttributes enum attributes
(SET_AUTO_TRACE_COLLECTION).

arg

The value the attribute will take.

8.2.3 Public Static Member Functions

Lists the public static member functions of the
com::freescale::sa::scripting::api::AnalysisConfig cl;ass.

Following public static member functions are available:

* removeAllTracepointsByType

8.2.3.1 removeAllTracepointsByType

Remove all tracepoints of the same kind.

static void
com. freescale.sa.scripting.api.AnalysisConfig.removeAllTracepointsByType (TracePoint.Type
tpType)

Parameters

tpType
Tracepoint type.

CoreException

8.3 com::freescale::sa::scripting::api::AnalysisErrors

Refer below.
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8.3.1 Public Static Member Functions

Lists the public static member functions of the
com::freescale::sa::scripting::api::AnalysisErrors class.

Following public static member functions are available:

* log

8.3.1.1 log

Log error.

static void com.freescale.sa.scripting.api.AnalysisErrors.log(Throwable e)
Parameters

e

A throwable object.

8.4 com::freescale::sa::scripting::api::AnalysisFactory

Refer below.

8.4.1 Public Static Member Functions

Lists the public static member functions of the
com::freescale::sa::scripting::api::AnalysisFactory class.

Following public static members are available:

 getAnalysisConfig
» getAnalysisConfigFromLaunch
» getAnalysisResults
» getAnalysisResults
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» getAnalysisResults
» getAnalysisResults

8.4.1.1 getAnalysisConfig

Get which configures the SA configuration attributes. AnalysisConfig

static AnalysisConfig
com. freescale.sa.scripting.api.AnalysisFactory.getAnalysisConfig(String projectName)

Parameters
projectName

The project name.
Returns

An object. AnalysisConfig

8.4.1.2 getAnalysisConfigFromLaunch

Get which configures the SA configuration attributes. AnalysisConfig

This method has a more focused use case, where the user has more than one launch
configuration and he needs to specifically select one for the launch script.

static AnalysisConfig
com. freescale.sa.scripting.api.AnalysisFactory.getAnalysisConfigFromLaunch (String
launchConfigName)

Parameters
launchConfigName

The launch configuration name, as it is described only by the base name without the file's
extension.

Returns

An object. AnalysisConfig

8.4.1.3 getAnalysisResults
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Get which helps in exporting trace information. AnalysisResults

static AnalysisResults
com.freescale.sa.scripting.api.AnalysisFactory.getAnalysisResults (String projectName, int
timeout)

Parameters

projectName

The name of the project.

timeout

Maximum allowed time for the results to become available.
Returns

An instance. AnalysisResults

8.4.1.4 getAnalysisResults

Get which helps in exporting trace information. AnalysisResults

This method returns an AnalysisResult instance with a default 10 second wait for results
availability.

static AnalysisResults
com.freescale.sa.scripting.api.AnalysisFactory.getAnalysisResults (String projectName)

Parameters

projectName

The name of the project.
Returns

An instance. AnalysisResults

8.4.1.5 getAnalysisResults

Get which helps in exporting trace information. AnalysisResults

static AnalysisResults
com. freescale.sa.scripting.api.AnalysisFactory.getAnalysisResults (String projectName, String
baseFileName, int timeout)
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Parameters

projectName

The name of the project.

baseFileName

Base name, without extension, of the result set
timeout

Base name, without extension, of the result set
Returns

An instance. AnalysisResults

8.4.1.6 getAnalysisResults

Get which helps in exporting trace information. AnalysisResults

This method returns an AnalysisResult instance with a default 10 second wait for results
availability.

static AnalysisResults
com. freescale.sa.scripting.api.AnalysisFactory.getAnalysisResults (String projectName, String
baseFileName)

Parameters

projectName

The name of the project.

baseFileName

Base name, without extension, of the result set
Returns

An instance. AnalysisResults

8.5 com::freescale::sa::scripting::api::AnalysisResults

Refer below.
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8.5.1 Protected Member Functions

Lists the protected member functions of the
com::freescale::sa::scripting::api::AnalysisResults class.

Following protected members are available:

 AnalysisResults
* AnalysisResults
» exportTraceData

Comprehensive description of each of the above listed functions is as follows:

8.5.1.1 AnalysisResults

com.freescale.sa.scripting.api.AnalysisResults.AnalysisResults (String projectName, String
baseName, int timeoutSeconds)

Parameters

projectName

The name of the current project.

baseName

Base name, without extension, of the result set

stimeoutSeconds

Maximum allowed time for the results to become available, in seconds.

8.5.1.2 AnalysisResults

Overloaded constructor which uses the default waiting time for the target file (i.e.config
file) file.

com.freescale.sa.scripting.api.AnalysisResults.AnalysisResults (String projectName, String
baseFileName)

Parameters
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projectName
The name of the current project.
baseName

Base name, without extension, of the result set

8.5.1.3 exportTraceData

void com.freescale.sa.scripting.api.AnalysisResults.exportTraceData (String filePath)

8.5.2 Public Member Functions

Lists the public member functions of the
com::freescale::sa::scripting::api:: AnalysisResults class.

Following public members are available:

» getTraceRecordsNo
 exportResults
* exportFunctionResults

Comprehensive description of each of the above listed functions is as follows:

8.5.2.1 getTraceRecordsNo

long com.freescale.sa.scripting.api.AnalysisResults.getTraceRecordsNo ()

8.5.2.2 exportResults

Export to a data format one of the available data types.

The data types that can be exported with this method can take only one argument.

com. freescale.sa.scripting.api.AnalysisResults.exportResults (ExportDataType dataType, String
filePath)

Parameters
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dataType

the data type as one of the attributes from ExportDataType enum.
filePath

the path to the desired .csv output file.

8.5.2.3 exportFunctionResults

Export to a data format one of the available data types.

The data types that can be exported with this method should take two arguments.

com.freescale.sa.scripting.api.AnalysisResults.exportFunctionResults (ExportDataType
dataType, String filePath, Object arg)

Parameters

dataType

the data type as one of the attributes from ExportDataType enum.
filePath

the path to the desired .csv output file.

arg

Defines the SHOW_CODE_TYPE for the CRITICAL_CODE_HTML attribute or the
name of the analysed C function (one of the source file's functions) for
CRITICAL_CODE_FUNCTION_CSV and HIERARCHICAL_FUNCTION_CSV.

8.5.3 Public Static Member Functions

Lists the public static member functions of the
com::freescale::sa::scripting::api::AnalysisResults class.

Following public ststic members are available:

* logMessages

Comprehensive description of each of the above listed functions is as follows:
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8.5.3.1 logMessages

Method used for temporary logging.
Afterwards, the logging will be done by the RemoteLaunch API.

static void com.freescale.sa.scripting.api.AnalysisResults.logMessages (String message)

Parameters
message

The message to be logged.

8.6 com::freescale::sa::sc::scripting::api::ScAnalysisConfig

Refer below.

8.6.1 Protected Member Functions

Lists the protected member functions of the
com::freescale::sa::sc::scripting::api::ScAnalysisConfig class.

Following protected members are available:

* ScAnalysisConfig
* ScAnalysisConfig

8.6.1.1 ScAnalysisConfig

com. freescale.sa.sc.scripting.api.ScAnalysisConfig.ScAnalysisConfig(ILaunchConfiguration
launchConfig)

8.6.1.2 ScAnalysisConfig

CodeWarrior Development Studio for StarCore SC3900FP DSP Architectures Tracing and Analysis Tools
User Guide, Rev. 10.9.0, 11/2015

Freescale Semiconductor, Inc. 207




vum::freescale::sa::sc::scripting::api::ScAnalysisConfig

com.freescale.sa.sc.scripting.api.ScAnalysisConfig.ScAnalysisConfig (St
ring projectName)

8.6.2 Public Member Functions

Lists the public member functions of the
com::freescale::sa::sc::scripting::api::ScAnalysisConfig class.

Following public members are available:

» getAttribute
* setAttribute

Comprehensive description of each of the above listed functions is as follows:

8.6.2.1 getAttribute

Get the value of a specific SA StarCore configuration attribute.
Object com.freescale.sa.sc.scripting.api.ScAnalysisConfig.getAttribute (Object attributeType)

Parameters
attributeType

The attribute from which the value will be retrieved. The list of attributes are exposed by
the ScAnalysisConfigAttributes enum.

Returns

The specific attribute value or null in case of attribute not found.

8.6.2.2 setAttribute

Set one of the SA StarCore general config attributes.
void
com.freescale.sa.sc.scripting.api.ScAnalysisConfig.setAttribute (Object attributeType, Object

arg)

Parameters

attributeType
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One of the AnalysisConfigAttributes enum attributes.
arg

The value the attribute will take.

8.7 com::freescale::sa::sc::scripting::api::ScHwAnalysisActions

Refer below.

8.7.1 Public Member Functions

Lists the public member functions of the
com::freescale::sa::sc::scripting::api::ScHwAnalysisA ctions class.

Following public member functions are available:

* ScHwAnalysisActions
* uploadTrace

Comprehensive description of each of the above listed functions is as follows:

8.7.1.1 ScHwAnalysisActions

It enables user defined events trace.

com. freescale.sa.sc.scripting.api.ScHwAnalysisActions.ScHwAnalysisActions (AnalysisConfig
config)

8.7.1.2 uploadTrace

Trigger trace upload.

This should be triggered only in attach mode or user code, when a suspend is hit, after
tracing was enabled.

synchronized void com.freescale.sa.sc.scripting.api.ScHwAnalysisActions.uploadTrace ()
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8.7.2 Public Static Member Functions

Lists the public static member functions of the
com::freescale::sa::sc::scripting::api::ScHwAnalysisActions class.

Following public static members are available:

* uploadTrace

Comprehensive description of each of the above listed functions is as follows:

8.7.2.1 uploadTrace

This method is intended for a static use, where an analysis configuration is not available.
This should be triggered only in attach mode or user code, when a suspend is hit, after
tracing was enabled.

static synchronized void
com.freescale.sa.sc.scripting.api.ScHwAnalysisActions.uploadTrace (String launchConfigName)

Parameters
launchConfigName

The name of the running launch configuration, on which the action is triggered.

8.8 com::freescale::sa::sc::scripting::api::ScHwAnalysisConfig

Refer below.

8.8.1 Public Member Functions

Lists the public member functions of the
com::freescale::sa::sc::scripting::api::ScHwAnalysisConfig class.

Following public member functions are available:

* ScHwAnalysisConfig
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e ScHwAnalysisConfig
* setAttribute
 getAttribute

8.8.1.1 ScHwAnalysisConfig

com. freescale.sa.sc.scripting.api.ScHwAnalysisConfig.ScHwAnalysisConfig(ILaunchConfiguration
launchConfig)

8.8.1.2 ScHwAnalysisConfig

com.freescale.sa.sc.scripting.api.ScHwAnalysisConfig.ScHwAnalysisConfig(String projectName)

8.8.1.3 setAttribute

Set one of the SA StarCore hardware config attributes. If called from python interpreter,
there's no need to mention the enum name (e.g.

ScHwAnalysisConfigAttributes. USER_CODE, just USER_CODE). The enum objects
are automatically added as they are to the namespace of the running project, via a
config.py file, found in com.freescale.sa.sc.scripting/remote.

void com.freescale.sa.sc.scripting.api.ScHwAnalysisConfig.setAttribute (Object attributeType,
Object arg)

Parameters

attributeType

One of the ScHwAnalysisConfigAttributes enum attributes (TRACE_SCENARIO,
OWNERSHIP_TRACE, USER_DEFINED_EVENTS,
TRACE_BUFFER_START_ADDRESS, DATA_ADDR_TRACE,
PROBE_BUFFER_SIZE, TRIAD_A_EVENT, TRIAD_B_EVENT,
TRACE_COLLECTION_MODE, USER_CODE, DDR_BUFFER_START_ADDRESS,
DDR_BUFFER_SIZE, SET_LCF_SETTINGS_FROM_FILE, BANDWIDTH,
COLLECTION_PORT_TYPE).

Parameters

arg
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The value the attribute will take. In case, the attribute to be set is ambigous, consult
com.freescale.sa.sc.scripting/remote/config.py, where the scripting namespace is set.
There can be found possible values for multiple-choice arguments(e.g. setTriadAEvent(..)
or setTraceCollectionMode(..) ).

8.8.1.4 getAttribute

Get the value of a specific SA StarCore hardware config attribute. If called from python
interpreter, there's no need to mention the enum name (e.g.
ScHwAnalysisConfigAttributes. USER_CODE, just USER_CODE). The enum objects
are automatically added as they are to the namespace of the running project, via a
config.py file, found in com.freescale.sa.sc.scripting/remote.

Object com.freescale.sa.sc.scripting.api.ScHwAnalysisConfig.getAttribute (Object
attributeType)

Parameters

attributeType

One of the ScHwAnalysisConfigAttributes enum attributes (TRACE_SCENARIO,
OWNERSHIP_TRACE, USER_DEFINED_EVENTS,
TRACE_BUFFER_START_ADDRESS, DATA_ADDR_TRACE,
PROBE_BUFFER_SIZE, TRIAD_A_EVENT, TRIAD_B_EVENT,
TRACE_COLLECTION_MODE, USER_CODE, DDR_BUFFER_START_ADDRESS,
DDR_BUFFER_SIZE, SET_LCF_SETTINGS_FROM_FILE, BANDWIDTH,
COLLECTION_PORT_TYPE).

Returns

the specific attribute value.

8.8.2 Protected Member Functions

Lists the protected member functions of the
com::freescale::sa::sc::scripting::api::ScHwAnalysisConfig class.

Following protected members are available:

e setUserDefinedEventsTrace
¢ isUserDefinedEventsTrace
* setOwnershipTrace
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1sOwnershipTrace
setTraceScenario
getTraceScenario
load

Comprehensive description of each of the above listed functions is as follows:

8.8.2.1 setUserDefinedEventsTrace

It enables user defined events trace.

void com.freescale.sa.sc.scripting.api.ScHwAnalysisConfig.setUserDefinedEventsTrace (boolean
userDefinedEvents)

Parameters
userDefinedEvents

Option to enable or not user defined events trace.

8.8.2.2 isUserDefinedEventsTrace

It returns the enable state of user defined events trace.

boolean com.freescale.sa.sc.scripting.api.ScHwAnalysisConfig.isUserDefinedEventsTrace ()

8.8.2.3 setOwnershipTrace

It enables ownership trace.

void com.freescale.sa.sc.scripting.api.ScHwAnalysisConfig.setOwnershipTrace (boolean
ownershipTrace)

Parameters
ownershipTrace

Option to enable or not ownership trace.
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8.8.2.4 isOwnershipTrace

It returns the enable state of ownership trace.

boolean com.freescale.sa.sc.scripting.api.ScHwAnalysisConfig.isOwnershipTrace ()

8.8.2.5 setTraceScenario

It sets the trace scenario by index.

void com.freescale.sa.sc.scripting.api.ScHwAnalysisConfig.setTraceScenario (TraceScenarioCode
scenarioCode)

Parameters
scenarioCode

The TraceScenarioCode used to identify the trace scenario. It is based on one of the
scenario codes provided by the com.freescale.sa.sc.launch.ui#
ScHwTargetSettingsManager# TraceScenarioCode enum. The members of this enum are:
PROFILING_CACHE_EVENTS, PROFILING_DATA_TRACE,
PROFILING_CLOCK_CYCLES, PROFILING_ADVANCED, PROGRAM_TRACE,
COVERAGE, NONE

8.8.2.6 getTraceScenario

It gets index of trace scenario set as default.
TraceScenarioCode com.freescale.sa.sc.scripting.api.ScHwAnalysisConfig.getTraceScenario()

Returns

The trace scenario based on one of the scenario codes provided by the
com.freescale.sa.sc.launch.ui# ScHwTargetSettingsManager# TraceScenarioCode enum.
The members of this enum are: PROFILING_CACHE_EVENTS,
PROFILING_DATA_TRACE, PROFILING_CLOCK_CYCLES,
PROFILING_ADVANCED, PROGRAM_TRACE, COVERAGE, NONE

8.8.2.7 load
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Loads configuration using a launch config.

Creates a trace config file in the process (if required).

void com.freescale.sa.sc.scripting.api.ScHwAnalysisConfig.load (ILaunchConfiguration
launchConfig)

Parameters
launchConfig
name of the launch configuration.

CoreException

8.9 com::freescale::sa::sc::scripting::api::ScSimAnalysisConfig

Refer below.

8.9.1 Public Member Functions

Lists the public member functions of the
com::freescale::sa::sc::scripting::api::ScSimAnalysisConfig class.

Following public members are available:

* ScSimAnalysisConfig
e ScSimAnalysisConfig
* setAttribute
 getAttribute

Comprehensive description of each of the above listed functions is as follows:

8.9.1.1 ScSimAnalysisConfig

com.freescale.sa.sc.scripting.api.ScSimAnalysisConfig.ScSimAnalysisConfig(ILaunchConfiguratio
n launchConfig)

8.9.1.2 ScSimAnalysisConfig
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com. freescale.sa.sc.scripting.api.ScSimAnalysisConfig.ScSimAnalysisConfig(String projectName)

8.9.1.3 setAttribute

Set one of the SA StarCore simulator config attributes.

void com.freescale.sa.sc.scripting.api.ScSimAnalysisConfig.setAttribute (Object
attributeType, Object arg)

Parameters

attributeType

One of the ScSimAnalysisConfigAttributes enum attributes (COM_PORT_NUMBER,
LOGGING, OUTPUT_FOLDER).

arg

The value the attribute will take.

8.9.1.4 getAttribute

Get the value of a specific SA StarCore simulator config attribute.

Object com.freescale.sa.sc.scripting.api.ScSimAnalysisConfig.getAttribute (Object
attributeType)

Parameters

attributeType

The attribute from which the value will be retrieved.
Returns

the specific attribute value.

8.9.2 Protected Member Functions

Lists the protected member functions of the
com::freescale::sa::sc::scripting::api::ScSimAnalysisConfig class.

Following protected members are available:
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load
setCommPortNumber
getCommPortNumber
setOutputFolder
enableLogging
isLoggingEnabled

Comprehensive description of each of the above listed functions is as follows:

8.9.2.1 load

Loads configuration using a launch config.

Creates a trace config file in the process (if required).

void com.freescale.sa.sc.scripting.api.ScSimAnalysisConfig.load (ILaunchConfiguration
launchConfig)

Parameters
launchConfig
name of the launch configuration.

CoreException

8.9.2.2 setCommPortNumber

Sets the communication port.

void com.freescale.sa.sc.scripting.api.ScSimAnalysisConfig.setCommPortNumber (int
commPortNumber)

Parameters

commPortNumber

8.9.2.3 getCommPortNumber

int com.freescale.sa.sc.scripting.api.ScSimAnalysisConfig.getCommPortNumber ()

Returns
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The stored communication port number

8.9.2.4 setOutputFolder

Sets the results output folder.

void com.freescale.sa.sc.scripting.api.ScSimAnalysisConfig.setOutputFolder (String
outputFolder)

Parameters
outputFolder

the path to the new results folder

8.9.2.5 enableLogging

Enables logging.

void com.freescale.sa.sc.scripting.api.ScSimAnalysisConfig.enableLogging (boolean enablelLog)
Parameters

enableLog

Enable/disable logging.

8.9.2.6 isLoggingEnabled

Returns the current state of logging state.
boolean com.freescale.sa.sc.scripting.api.ScSimAnalysisConfig.isLoggingEnabled ()

Returns

true/false based on logging state.
8.10 com::freescale::sa::scripting::api::TracePoint
Refer below.
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8.10.1 Protected Member Functions

Lists the protected member functions of the
com::freescale::sa::scripting::api:: TracePoint class.

Following protected members are available:

* TracePoint
 getlTracepoint

Comprehensive description of each of the above listed functions is as follows:

8.10.1.1 TracePoint

com. freescale.sa.scripting.api.TracePoint.TracePoint (ITracepoint tp)

8.10.1.2 getiTracepoint

ITracepoint com.freescale.sa.scripting.api.TracePoint.getITracepoint ()

8.10.2 Public Member Functions

Lists the public member functions of the
com::freescale::sa::scripting::api::TracePoint class.

Following public members are available:

* setEnabled

» getEnabled

* getAction

e getType

» getAddress

e getFileName

» getLineNumber

Comprehensive description of each of the above listed functions is as follows:
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8.10.2.1 setEnabled

Set enable state of the tracepoint.
void com.freescale.sa.scripting.api.TracePoint.setEnabled (boolean en)

Parameters

en

Enable if true, disable if false.

8.10.2.2 getEnabled

Get enable state of the tracepoint.

boolean com.freescale.sa.scripting.api.TracePoint.getEnabled ()

Returns

True if tracepoint is enabled, false otherwise.

8.10.2.3 getAction

Action com.freescale.sa.scripting.api.TracePoint.getAction()

Returns

The Action associated with the Tracepoint.

8.10.2.4 getType

Type com.freescale.sa.scripting.api.TracePoint.getType ()

Returns

The Type of the tracepoint.
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8.10.2.5 getAddress

Get address of tracepoint.

String com.freescale.sa.scripting.api.TracePoint.getAddress ()

Returns

The address of the tracepoint.

8.10.2.6 getFileName

Get source file name of the tracepoint.
String com.freescale.sa.scripting.api.TracePoint.getFileName ()

Returns

The source file name for the tracepoint.

8.10.2.7 getLineNumber

Get line number of tracepoint.

int com.freescale.sa.scripting.api.TracePoint.getLineNumber ()

Returns

The line number of the tracepoint.

8.11 com.freescale.sa.scripting.lAnalysisConfigFactory

Refer below.

8.11.1 Public Member Functions

Lists the public member functions of the
com.freescale.sa.scripting.IAnalysisConfigFactory interface.
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Following public static member functions are available:

* createAnalysisConfigFromArchive
* createAnalysisConfigFromLaunch

8.11.1.1 createAnalysisConfigFromArchive

Creates an AnalysisConfig object from a trace config file.

AnalysisConfig
com. freescale.sa.scripting.IAnalysisConfigFactory.createAnalysisConfigFromArchive (String
configPath)

Parameters

configPath

The path of the configuration file archive.
Returns

An object. AnalysisConfig

8.11.1.2 createAnalysisConfigFromLaunch

Creates an AnalysisConfig object for a launch config name. May create a trace config file
in the process (if needed).

AnalysisConfig
com.freescale.sa.scripting.IAnalysisConfigFactory.createAnalysisConfigFromLaunch (String
launchConfigName)

Parameters

launchConfigName

The launch configuration name.
Returns

An object. AnalysisConfig
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